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RESUMEN 

El estudio realizado corresponde a una investigación de carácter cuantitativo cuyo problema 

investigado fue: ¿Cómo realizar una red de telecomunicación inalámbrica con servicio de 

intemet de banda ancha para las instituciones educativas de nivel primario en la micro red del 

distrito de Colcabamba? Su objetivo: Determinar la red de telecomunicaciones inalámbrico 

con servicio de intemet de banda ancha para las instituciones educativas de nivel primario en 

la micro red del distrito de Colcabamba e hipótesis: Una red de telecomunicación inalámbrica 

provee servicio de internet de banda ancha a las instituciones educativas de nivel primario en 

la micro red del distrito de Colcabamba. 

El tipo de investigación es aplicada, nivel explicativo y el diseño de investigación es cuasi 

experimental de un grupo. El método de investigación utilizado fue el experimental. Para la 

medición de las velocidades de subida y bajada utilizamos el software Nettraffic el cual se 

contrastó con el aplicativo que está a disposición del público de la empresa de 

telecomunicaciones Movistar, el estudio tiene una población de 49 instituciones educativas 

de nivel primario y la recolección de datos se hizo en la l. E. W 31296 del Centro Poblado de 

Pilcos en el Distrito de Colcabamba, con una población estudiantil de 56 niños, antes de la 

investigación la velocidad de bajada del servicio de internet con la tecnología VSAT alcanzó 

un máximo de 60.7934 kbps y un mínimo de 0.3796 kbps, al implementarse la red con la 

tecnología WiFi 802.11 n y con los equipos de Ubiquiti se alcanzó tasas de transferencia 

mayor a 256 kbps, con lo que se puede asegurar que el servicio de internet es de banda 

ancha, tal como lo define la ITU, cuando fija los niveles mínimos de transferencia de datos 

para bajada en servicios de internet de banda ancha. 

Palabras claves: 

Banda ancha, Estándar 802.11 n, WiFi, tasa de transferencia. 
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INTRODUCCIÓN 

La red de telecomunicación inalámbrica con servicio de intemet de banda ancha es un 

servicio que muchas instituciones educativas necesitan en el territorio nacional, ya que debido 

a la geografía de la sierra y selva es inviable el tendido de fibra o cable a todos los puntos del 

país. 

La red de telecomunicación inalámbrica con servicio de intemet de banda ancha, surge como 

una alternativa de solución al problema de tener un servicio de internet de banda ancha a 

nivel nacional, que va junto con la política de inclusión del estado en cuanto a tener internet 

de alta velocidad. 

El Capítulo 1, que trata sobre el problema de investigación; en donde se visualiza el planteamiento y 

formulación del problema, la justificación, los respectivos objetivos de investigación, seguido de la 

justificación e importancia. 

El Capítulo 11, del marco teórico conceptual de la investigación; donde se aprecia primero los 

antecedentes y luego la información teórica relevante sobre las variables de estudio, sustentado en 

teorías y bibliografía actualizada y finalmente los definición de términos básicos utilizados en la 

investigación, seguido de la hipótesis y el sistema de variables. 

El Capítulo 111, del marco metodológico, en el cual se detalla el tipo, nivel método y diseño de 

investigación, además de las técnicas de recolección de datos y el procesamiento de información. 

El Capítulo IV, de los resultados; donde se detalla los pormenores del análisis y procesamiento de la 

información tanto del pre test como del post test, seguido de la prueba de hipótesis. 

Al final se complementa con las conclusiones, recomendaciones, referencias bibliográficas 

según el estilo Vancouver, y los respectivos anexos del presente trabajo de investigación. 

Los autores. 
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1.1. Planteamiento del Problema 

CAPÍTULO 1 

PROBLEMA 

El distrito de Colcabamba cuenta con una población de 21593 habitantes tal como se 

muestra en la Tabla W 1.1, de los cuales solo el18.94% que representa a 4090 niños 

y adolescentes acceden a la educación primaria tal como se muestra en la Tabla No 

1.2, los mismos que desconocen o muy poco saben del uso del tecnologías de 

información debido a que en sus instituciones educativas carecen de los equipos de 

cómputo y de una conexión a internet. 

Tabla N° 1.1: Población urbana y rural distrito de Colcabamba 

POBLACION URBANA RURAL 
Total Homb. Mujeres Total Homb. Mujeres Total Hombres Mujeres 

21 593 10 889 10 704 1671 828 843 19 922 10,170 9 752 

100% 50.43% 49.57% 7.74% 49.55% 50.45% 92.26% 51.05% 48.95% 

Fuente: IN El censo 2007 

Tabla No 1.2: Colcabamba: Matrícula EBR por tipo de gestión, área geográfica y 

sexo, según nivel educativo y estrategia o forma de atención, 2011 

Fuente: Mejoramiento de los niveles de rendimiento en lectura y matemáticas de los niveles 

de E.B.R. en el distrito de Colcabamba, T ayacaja-Huancavelica. 

Así mismo según el INEI, los hogares con acceso a tecnología de la información y 

comunicación al2009 es de solo 0.7%. 

13 



En el sector rural del distrito de Colcabamba el acceso a Internet es nulo debido a 

algunos factores limitantes como ubicación geográfica, infraestructura tecnológica y 

altos costos con baja rentabilidad que supone proveer el servicio de última milla por 

parte de las empresas de comunicación. 

De acuerdo a datos obtenidos por el programa NetTraffic 1.1.4005 en un día de labores 

en la I.E. No 30943, que tiene acceso a intemet VSAT, se obtuvo los siguientes datos 

para las velocidades de acceso en subida y bajada: 

Tabla No 1.3: Velocidades de acceso en la l. E. No 30943 en kbps 

Máximo Mínimo 

Download (kbps) 60.7934 0.3796 

Upload (kbps) 13.4643 5.3286 

Fuente: Elaboración propia 

Como consecuencia el nivel académico de instituciones educativas rurales es inferior 

limitando a sus alumnos a la educación tradicional, aumentando de esta manera el 

índice de deserción del estudio superior ya que encuentran grandes dificultades y 

prefieren cambiar los estudios por actividades laborales provocando un bajo número 

de profesionales en el Colcabamba. 

1.2. Formulación del Problema 

1.2.1. Problema General 

¿Cómo realizar una red de telecomunicación inalámbrica con servicio de 

internet de banda ancha para las instituciones educativas de nivel primario en 

la micro red del distrito de Colcabamba? 

1.2.2. Problemas Específicos 

a) ¿Qué tecnología se utiliza para proveer internet inalámbrico de banda 

ancha a las instituciones educativas de nivel primario de educación básica 

regular en la micro red Colcabamba? 

b) ¿Qué equipos se utilizan para proveer internet inalámbrico de banda ancha 

a las instituciones educativas de nivel primario de educación básica regular 

en la micro red Colcabamba? 
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1.3. Objetivos 

1.3.1. Objetivo General 

Determinar la red de telecomunicaciones inalámbrico con servicio de intemet 

de banda ancha para las instituciones educativas de nivel primario en la micro 

red del distrito de Colcabamba. 

1.3.2. Objetivos Específicos 

a) Identificar la tecnología a utilizar para proveer intemet inalámbrico de 

banda ancha a las instituciones educativas de nivel primario de educación 

básica regular en la micro red Colcabamba. 

b) Identificar los equipos a utilizar para proveer internet inalámbrico de banda 

ancha a las instituciones educativas de nivel primario de educación básica 

regular en la micro red Colcabamba. 

1.4. Justificación 

El soporte informático permite la incorporación de otras estrategias novedosas para 

favorecer la comprensión en tanto permite utilizar variadas formas perceptivas, 

figurativas y no figurativas, textuales y musicales, animaciones, etc., sin perder de vista 

la estructura del campo de conocimiento de que se trata. 

La computadora puede concebirse como un dispositivo amplificador de las facultades 

del hombre, una extensión de la mente humana. Como en el caso de otras 

herramientas, los usuarios difieren en el grado de aprovechamiento de sus 

potencialidades. 

La educación blended es una combinación o mezcla de la enseñanza presencial con 

la tecnología para la enseñanza en modalidad a distancia. Combina el cara a cara con 

la enseñanza virtual. 

Por lo tanto con la incorporación de las TIC's en la educación vemos que hay 

modalidades educativas como el ~<blended learning" (blended en inglés significa " 

mezcla" y leaming "aprender"). 

Un esquema "blended learning" integral suministra un modelo para el aprendizaje que 

incluye: 
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• Enseñanza en todos los contextos (sincronías, asincronías, clases tutoriales, 

clases in situ, estudio a distancia, comunidades de aprendizaje ad hoc); 

• Entornos digitales que facilitan a los usuarios la realización de determinados 

trabajos, brindándoles información y/o conocimiento cuando se detecta esa 

necesidad. 

• Procesos en la gestión de conocimiento: generación, codificación, organización, 

almacenamiento, acceso y transferencia. 

Los recursos para este tipo de educación son variados: texto, sonido, música, imagen 

fija y en movimiento, vídeos, etc. 

La banda ancha da la capacitad técnica para tener acceso a una amplia gama de 

recursos, servicios y productos que mejoran nuestra vida en diversas formas. Estos 

recursos, servicios y productos incluyen en: 

• Educación, cultura y entretenimiento 

../ La banda ancha puede superar las barreras geográficas y financieras para 

dar acceso a una extensa gama de oportunidades y recursos en el área 

educativa, cultural y recreativa. 

• Telesalud y telemedicina 

../ La banda ancha puede facilitar la prestación de servicios médicos a 

poblaciones que carecen o tienen deficiencia en dichos servicios a través de 

diagnósticos, tratamiento, vigilancia y consultas con especialistas a distancia. 

• Desarrollo económico/Comercio electrónico 

../ La banda ancha puede promover el desarrollo y revitalización económicos a 

través del comercio electrónico (e-commerce): 

;.. Creando empleos nuevos y atrayendo nuevas industrias. 

;.. Proporcionando acceso a los mercados regionales, nacionales y 

mundiales. 

• Gobierno electrónico (E-Government) 

../ El gobierno electrónico puede ayudar a agilizar la interacción de las personas 

con las agencias gubernamentales y proporcionar información sobre las 

políticas, procedimientos, beneficios y programas del gobierno. 

• Seguridad pública y seguridad nacional 
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./ La banda ancha puede ayudar a proteger al público al facilitar y promover la 

información y procedimientos de seguridad pública, incluyendo: 

> Sistemas tempranos de alerta/advertencia al público y programas de 

preparación para desastres. 

> Vigilancia remota de la seguridad y verificación de antecedentes en 

tiempo real. 

> Sistemas de respaldo para las redes de comunicación de seguridad 

pública. 

• Servicios de comunicación de banda ancha 

./ La banda ancha permite el acceso a las tecnologías nuevas de 

telecomunicación tales como Voz sobre Protocolo de Internet (VoiP, por sus 

siglas en inglés) permitiendo la comunicación por voz usando el Internet. 

• Servicios de comunicación para personas discapacitadas 

La banda ancha permite que los usuarios de los Servicios de Retransmisión de 

Telecomunicaciones (TRS, por sus siglas en inglés) usen los Servicios de 

Transmisión de Vídeo (VRS, por sus siglas en inglés) para comunicarse más fácil, 

rápida y expresivamente con los usuarios del teléfono de voz. 
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2.1. Antecedentes 

CAPÍTULO 11 

MARCO TEÓRICO 

Sanaguano D.; Zabala M. Estudio, Análisis e implementación de una red 

inalámbrica comunitaria orientada al sector educativo rural del Cantón Chambo. 

Ecuador. Escuela Superior Politécnica de Chimborazo; 2011 

El objetivo de realizar el Estudio, Análisis e Implementación de un Red Inalámbrica 

Comunitaria es para proveer de conectividad a intemet a 6 escuelas del sector rural 

del cantón Chambo ubicadas en las comunidades de Guallabamba, Llucud, Pantaño, 

Catequilla, San Francisco y Santa Rosa. El método de investigación deductivo nos 

permitió discernir todos los aspectos generales que intervienen y afectan en la 

ejecución de la red como factores climáticos y geográficos, saturación radioeléctrica y 

económica, el método inductivo en el cuál observamos parámetros específicos que 

miden el rendimiento de la red como la latencia, los paquetes perdidos y el throughput 

finalmente el método analítico nos permitirá analizar los valores con los cuales la red 

opera. Se realiza el estudio de factibilidad de los enlaces con la herramienta de 

software Radio Mobile el cual muestra los elementos del presupuesto de enlace, así 

como la línea de vista, cobertura de las repetidoras y la zona de Fresnal. 

Para la implementación se opta por la tecnología Mikrotik ya que son dispositivos 

diseñados para ambientes externos, soporta los estándares 802.11 a/b/g, además 

adaptabilidad con una variedad de antenas y ta~etas. En cada repetidora se utiliza un 

Routerboard 433 AH y distintas antenas de acuerdo a las características de cada 

enlace, para mayor cobertura antenas tipo panel que tiene una ganancia de 14 dBi y 

un ángulo de cobertura de 120 grados, las de grilla con ganancia de 24 dBi que son de 

largo alcance y se utiliza para conexiones punto a punto. 
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Una vez que la red esta operativa se midió los parámetros de rendimiento obteniendo 

los siguientes datos: latencia 63.7 ms, O% de paquetes perdidos y el throughput de 

1502 Kbps de una tasa de transmisión de 2833Kbps con los cuales la red opera, al ser 

comparados con valores establecidos como recomendados verificamos que la red 

opera al 70.02 % del rendimiento máximo.1 

Pavié G.; Moya P. Diseño e implementación de una red de acceso inalámbrica 

WLAN para proveer intemet de banda ancha a escuelas rurales de Mancera, 

Carbonero y San Juan. Chile. Universidad Austral de Chile; 2010 

El trabajo de tesis consta de una compilación de la literatura técnica concerniente al 

tema y una implementación práctica del mismo. De igual manera, la documentación de 

éste, se estructura en doce capítulos, donde siete de ellos corresponden a 

fundamentos teóricos y seis capítulos exponen los resultados obtenidos en terreno. A 

continuación se enuncia una breve reseña de lo abordado en cada uno de ellos. 

En el primer capítulo se describen los fundamentos teóricos respecto de la propagación 

de ondas electromagnéticas, conceptos de interés, necesarios para comprender 

claramente de lo que se está tratando. 

El capítulo 11 permite comprender de mejor forma los fundamentos de las redes de 

acceso inalámbricas. Este apartado introduce en las tecnologías de acceso, 

profundizando precisamente en la que utiliza el aire como medio. 

Los capítulos 111, IV y V contextualizan el nivel donde opera el protocolo 802.11 b en el 

modelo OSI, exponiendo además su arquitectura de red y diferentes topologías, y el 

equipamiento que se usa en la implementación de enlaces basados en este estándar. 

En los capítulos VI y VIl se sientan las bases sobre los parámetros más importantes en 

la teoría de enlace, entregando las herramientas necesarias para poder prever las 

variaciones provocadas por las diferentes condicionantes. 

El planteamiento de las necesidades existentes y las consideraciones generales se 

presentan en el capítulo VIII, así como también, se estudian las mejores soluciones. 

Mientras que el capítulo IX expone la normativa legal que rige el proyecto. 

1 [Fecha de acceso: 02 de junio del 2014]. URL disponible en: http://dspace.espoch.edu.ec/bitstream/ 
123456789/1729/1/98T00008.pdf. 
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En los capítulos IX y X se exponen las consideraciones sobre la planificación de la red, 

predicción del enlace a través de simulación por software y sobre el equipamiento 

elegido y usado en el proyecto.2 

Cajahuaringa A. Diseño de un sistema WIMAX para una zona rural. Perú. 

Universidad Nacional de lngenieria; 2009 

La presente tesis tiene como objetivo diseñar un sistema basado en las tecnologías 

SDH y WiMAX para la zona rural de la provincia de Huarochirí del departamento de 

Lima, que permita brindar un servicio triple play: voz (VoiP), data (Internet) y CATV y/o 

vídeo por demanda (VoD), para permitir a los pobladores de la zona el acceso a las 

tecnologías de la información. 

Considerando que las características de las zonas rurales son la baja densidad 

poblacional, geografía accidentada y poblaciones separadas entre sí; los sistemas 

cableados tradicionales (como xDSL) empleadas en zonas urbanas no son adecuadas 

para los zonas rurales, por lo que se hará uso de la tecnología WiMAX que permite el 

uso de modernas y eficientes técnicas de modulación digital, como OFDMA, control de 

la potencia, la Transformada Discreta de Fourier y su inversa, control y formación del 

ancho de haz de una antena; para implementar un sistema de comunicación en una 

zona rural que brinde los servicios de triple play de modo eficiente. 

Tomando en consideración que en el distrito de Huarochirí es inminente la 

implementación de jun centro de servicios de voz, video y data, se realizará el diseño 

de una red troncal y una red secundaria de comunicación inalámbrica, que contemplará 

la mejor ubicación geográfica de las estaciones repetidoras, de las estaciones de la red 

de acceso secundarias, cálculo de los radio enlaces y una estimación de la capacidad 

del ancho de banda de la red adecuada para brindar el servicio de triple play. 

Para los cálculos de los radioenlaces y las áreas de cobertura se usará software. Para 

el sistema WiMAX se usará bandas de frecuencias no licenciadas para las conexiones 

PmP (punto a multipunto) y bandas licenciadas para las conexiones PaP (punto a 

2 [Fecha de acceso: 02 de junio del 2014]. URL disponible en: http://cybertesis.uach.cl/tesis/uach/ 
201 O/bmfcip338d/doclbmfcip338d.pdf 
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punto) y, para el sistema troncal se usa un sistema SDH (Jerarquía Digital Síncrona). 

Finalmente, se hará una estimación económica de los costos del proyecto.3 

Muñoz V.; Soto J. Diseño de una plataforma de telecomunicaciones para un 

entorno rural. Perú. Universidad Ricardo Palma; 2008 

En la Cumbre de Lisboa de Marzo del año 2000, los Jefes de Estado y de Gobiernos 

de la Unión Europea, determinaron que: "Las empresas y los ciudadanos deben tener 

acceso a una infraestructura de Telecomunicaciones barata y de calidad, a una amplia 

gama de servicios". Además de que "cada ciudadano debe contar con las 

cualificaciones necesarias para vivir y trabajar en esta nueva sociedad de la 

información". 

En respuesta a este acuerdo, nosotros en calidad de Profesionales en las 

Telecomunicaciones, debemos brindar el acceso a las tecnologías de la información a 

los pobladores de las áreas rurales, debido a que las Telecomunicaciones hoy en día 

han asumido un papel primordial en la promoción de un desarrollo económicamente 

sostenible y en la reducción de la pobreza. 

El aporte del presente proyecto de Tesis a la Ingeniería es la propuesta del uso de una 

Plataforma de Telecomunicaciones que brinde conectividad a una determinada 

población de la serranía Peruana (Apurímac), con los servicios de Voz y Datos. Tras 

un estudio concienzudo de las posibles soluciones tecnológicas existentes en el mundo 

de las "TIC's". Podemos inferir que la solución más viable para la aplicación de dicha 

Plataforma de Telecomunicaciones fue evaluada, analizada, valorada y ponderada en 

el ámbito tecnológico, regulatorio y económico en cada una de las soluciones siendo 

la solución N o 2 la más idónea para el escenario elegido. 

El mayor beneficio de aplicar esta Plataforma de Telecomunicaciones está en el ámbito 

socio-cultural, ya que de esta manera las áreas rurales comúnmente apartadas podrán 

integrarse al desarrollo de la sociedad actual.4 

3 [Fecha de acceso: 02 de junio del 2014]. URL disponible en: http://cybertesis.uni.edu.pe/bitstream/uni/ 
999/1/cajahuaringa_ca.pdf. 

4 [Fecha de acceso: 02 de junio del 2014]. URL disponible en: http://cybertesis.urp.edu.pe/bitstream/urp/ 
59/1/munoz_vh.pdf. 
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2.2. Bases Teóricas 

2.2.1. Red inalámbrica 

El término red inalámbrica es un término que se utiliza en informática 

para designar la conexión de nodos sin necesidad de una conexión física y 

que se da por medio de ondas electromagnéticas. 

2.2.1.1. Clasificación 

Dentro de las redes inalámbricas se puede dividir en dos amplias 

categorías de redes inalámbricas como: 

./ De larga distancia.· Estas son utilizadas para transmitir la 

información en espacios que pueden variar desde una misma 

ciudad o hasta varios países circunvecinos mejor conocido 

como redes de área metropolitana; sus velocidades de 

transmisión son relativamente bajas, de 4.8 a 19.2 Kbps a 

diferencia de WIMAX que puede alcanzar una velocidad 

aproximada de 70 Mbps en un radio de varios kilómetros 

./ De corta distancia.· Estas son utilizadas principalmente en 

redes corporativas cuyas oficinas se encuentran en uno o 

varios edificios que no se encuentran muy retirados entre sí, 

con velocidades del orden de 280 Kbps hasta los 2 Mbps, 

teniendo entre estas las WLAN. 

Una WLAN es una red que cubre un área equivalente a la red de 

área local de una empresa. Existen varios tipos de tecnologías, 

pero la más popular la tecnología WIFI o IEEE 802.11 ofrece una 

velocidad máxima de 54 Mbps en una distancia de varios cientos de 

metros. 

2.2.1.2. Estándar IEEE 802.11 

El estándar IEEE 802.11 define el uso de los dos niveles inferiores 

de la arquitectura OSI especificando sus normas de funcionamiento 

en una WLAN. Los protocolos de la rama 802.x definen la 

tecnología de redes de área local y redes de área metropolitana. 
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./ 802.11 

Especifica dos velocidades de transmisión teóricas de 1 y 2 

Mbps que se transmiten por señales infrarrojas. El estándar 

original también define el protocolo CSMA/CA como método 

de acceso. Una parte importante de la velocidad de 

transmisión teórica se utiliza en las necesidades de esta 

codificación para mejorar la calidad de la transmisión bajo 

condiciones ambientales diversas, lo cual se tradujo en 

dificultades de interoperabilidad entre equipos de diferentes 

marcas. 

v' 802.11a 

El estándar 802.11 a utiliza el mismo juego de protocolos de 

base que el estándar original, opera en la banda de 5 GHz y 

utiliza 52 subportadoras OFDM con una velocidad máxima de 

54 Mbps, lo que lo hace un estándar práctico para redes 

inalámbricas con velocidades reales de aproximadamente 20 

Mbps. 

Dado que la banda de 2.4 GHz tiene gran uso, el utilizar la 

banda de 5 GHz representa una ventaja del estándar 

802.11a, dado que se presentan menos interferencias. 

Sin embargo, la utilización de esta banda también tiene sus 

desventajas, dado que restringe el uso de los equipos 802.11a 

a únicamente puntos en línea de vista, con lo que se hace 

necesario la instalación de un mayor número de puntos de 

acceso; esto significa también que los equipos que trabajan 

con este estándar no pueden penetrar tan lejos como los del 

estándar 802.11 b dado que sus ondas son más fácilmente 

absorbidas . 

./ 802.11b 

802.11 b tiene una velocidad máxima de transmisión de 11 

Mbps y utiliza el mismo método de acceso CSMA/CA definido 
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en el estándar original. El estándar 802.11 b funciona en la 

banda de 2.4 GHz, debido al espacio ocupado por la 

codificación del protocolo CSMA/CA, en la práctica, la velocidad 

máxima de transmisión con este estándar es de 

aproximadamente 5.9 Mbps sobre TCP y 7.1 Mbps sobre UDP. 

802.11 b es usualmente usada en configuraciones punto y 

multipunto como en el caso de los AP que se comunican con 

una antena omnidireccional con uno o más clientes que se 

encuentran ubicados en un área de cobertura alrededor del 

AP . 

../ 802.11g 

Este utiliza la banda de 2.4 GHz pero opera a una velocidad 

teórica máxima de 54 Mbps, o cerca de 24.7 Mbps de 

velocidad real de transferencia, similar a la del estándar 

802.11 a. Es compatible con el estándar b y utiliza las mismas 

frecuencias. Buena parte del proceso de diseño del estándar lo 

tomó el hacer compatibles los dos estándares. 

Los equipos que trabajan bajo el estándar 802.11g llegaron al 

mercado muy rápidamente, incluso antes de su ratificación. 

Esto se debió en parte a que para construir equipos bajo este 

nuevo estándar se podían adaptar los ya diseñados para el 

estándar b. 
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./ 802.11n 

Protocolo 

802.11 

802.11a 

802.11b 

802.11g 

802.11n 

En enero de 2004, la IEEE anunció la formación de un 

grupo de trabajo 

802.11 para desarrollar una nueva revisión del estándar 802.11 

la velocidad real de transmisión podría llegar a los 500 Mbps y 

debería ser hasta 10 veces más rápida que una red bajo los 

estándares 802.11 a y 802.11 g, y cerca de 40 veces más rápida 

que una red bajo el estándar 802.11 b. 

802.11 n se construye basándose en las versiones previas del 

estándar 

802.11 añadiendo MIMO. MIMO utiliza múltiples transmisores y 

antenas receptoras permitiendo incrementar el tráfico de datos. 

En el siguiente cuadro se muestra una comparación entre los 

diferentes protocolos de WLAN. 

Tabla N° 2.1: Protocolos IEEE 802.11 

Frecuencia de Velocidad de Tx Velocidad máxima de 

operación (Mbps) Tx (Mbps) 

2.4-2.5 GHz 1 2 

5.15-5.8 GHz 25 54 

2.4-2.5 GHz 65 11 

2.4-2.5 GHz 25 54 

2.4 o 5 GHz 200 540 

Fuente: Elaboración propia 

2.2.1.3. Modos de operación 

El estándar 802.11 ofrece dos posibles modos de operación de las 

redes wireless: 
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a) Modo ad-hoc o independiente 

Figura N° 2.1: Modo ad-hoc 

Es el modo de operación más simple de una red inalámbrica, 

actuando como una red punto a punto entre un conjunto de 

equipos con adaptadores wireless, no existen puntos de acceso 

ni ningún tipo de equipo que dé soporte a la red en si. 

En este modo de operación, la información viaja directamente 

entre el emisor y receptor sin pasar por ningún otro equipo. 

Este es el modo más fácil, rápido y barato de establecer una 

red inalámbrica, pero presenta la enorme desventaja de que 

los equipos deben estar dentro del área de cobertura de los 

demás para comunicarse con ellos, por lo que sólo es 

aconsejable para redes con pocos equipos y próximos entre sí. 

b) Modo infraestructura 

En este modo, cada cliente wireless envía su información a 

un punto de acceso, que la hace llegar al destino adecuado. 

La presencia de los AP eleva el coste de inversión necesario 

para instalar una red wireless, pero ofrece numerosos 

beneficios gracias a sus capacidades. 
1 1:1&1 __ , 

ro//\"~ 
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Figura N° 2.2: Modo infraestructura 

26 



Los puntos de acceso permiten aumentar la cobertura de la red 

wireless, dado que los equipos clientes se comunican con él y 

no directamente entre sí, y por su condición de equipos fijos 

ubicados en zonas estratégicas y con antenas de más calidad, 

ofrecen una mayor cobertura y mejor fiabilidad del enlace. 

Además, existe la posibilidad de instalar varios puntos de 

acceso que actúen como repetidores para cubrir áreas 

mayores permitiendo el roaming de usuarios entre ellos. 

Los puntos de acceso actúan normalmente como bridge entre 

la red cableada y la red inalámbrica, lo que permite el acceso de 

los clientes wireless a los servicios de la red, aunque también 

pueden ofrecer servicios más avanzados, como servidores 

DHCP, así como la posibilidad del empleo de herramientas de 

seguridad y control de acceso a la red wireless. 

Entre las ventajas y desventajas podemos destacar: 

Tabla N° 2.2: Ventajas y desventajas del modo 

infraestructura 

Ventajas Desventajas 
Movilidad Menor ancho de banda 

Desplazamiento SeQuridad 
Flexibilidad Interferencias 

Costo Incertidumbre tecnolóQica 
Escalabilidad 

Fuente: Elaboración propia 

Debido a que estas redes están propensas a interferencias, los 

países necesitan regulaciones que definan los rangos de 

frecuencia y la potencia de transmisión que permita a cada 

una categoría de uso. 

2.2.1.4. Tipo de redes 

a) Punto a punto 

Las redes punto a punto son aquellas que responden a un tipo 

de arquitectura de red en las que cada canal de datos se usa 

para comunicar únicamente dos nodos, en contraposición a las 
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redes multipunto, en las cuales cada canal de datos se puede 

usar para comunicarse con diversos nodos. 

Las redes punto a punto son relativamente fáciles de instalar 

y operar. A medida que las redes crecen, las relaciones punto a 

punto se vuelven más difíciles de coordinar y operar. Su 

eficiencia decrece rápidamente a medida que la cantidad de 

dispositivos en la red aumenta. 

Los enlaces que interconectan los nodos de una red punto a 

punto se pueden clasificar en tres tipos según el sentido de las 

comunicaciones que transportan: 

• Simplex. La transacción sólo se efectúa en un solo sentido. 

• Half-dúplex. La transacción se realiza en ambos sentidos, 

pero de forma alternativa, es decir solo uno puede transmitir 

en un momento dado, no pudiendo transmitir los dos al 

mismo tiempo. 

• Full-dúplex.- La transacción se puede llevar a cabo en 

ambos sentidos simultáneamente. 

b) Multipunto 

Se denominan redes multipunto a aquellas en las cuales 

cada canal de datos se puede usar para comunicarse con 

diversos nodos. En una red multipunto solo existe una línea de 

comunicación cuyo uso esta compartido por todas las 

terminales en la red. La información fluye de forma bidireccional 

y es discernible para todas las terminales de la red. En este 

tipo de redes las terminales compiten por el uso del medio de 

forma que el primero que lo encuentra disponible lo acapara, 

aunque también puede negociar su uso está más sencilla: 

esta permite la unión de varios terminales a su computadora 

compartiendo la única línea de transmisión, la ventaja consiste 

en el abaratamiento de su costo aunque pierde velocidad y 

seguridad 
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• Árbol 

Esta estructura se utiliza en aplicaciones de televisión por 

cable, sobre la cual podrían basarse las futuras estructuras 

de redes que alcancen los hogares. También se ha utilizado 

en aplicaciones de redes locales analógicas de banda 

ancha. 

• Malla 

Esta involucra o se efectúa a través de redes WAN, una red 

malla contiene múltiples caminos, si un camino falla o está 

congestionado el tráfico, un paquete puede utilizar un 

camino diferente hacia el destino. Los routers se utilizan 

para interconectar las redes separadas. 

• Interconexión total 

La solución de redes permite a cada lugar individual 

encaminar datos en forma directa a un sitio anfitrión (host) 

secundario o cualquier otro lugar de la red del cliente, en 

lugar de transmitir por medio de la casa matriz como redes 

de arquitectura de interconexión radial. 

2.2.2. Propagación de ondas electromagnéticas 

Una onda electromagnética es la forma de propagación de la radiación 

electromagnética a través del espacio. Aunque el espacio libre realmente 

implica en el vacío, con frecuencia la propagación por la atmósfera terrestre se 

llama propagación en el espacio libre. 

Las ondas electromagnéticas se propagan a través de cualquier 

material dieléctrico incluyendo el aire pero no se propagan bien a través de 

conductores con pérdidas como por ejemplo el agua de mar ya que los 

campos eléctricos hacen que fluyan corrientes en el material disipando con 

rapidez la energía de las ondas. 
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Figura N° 2.3: Propagación de ondas electromagnéticas 

2.2.2.1. Absorción 

Es la captación de luz, calor u otro tipo de energía radiante por parte 

de las moléculas. La radiación absorbida se convierte en calor; la 

radiación que no se absorbe es reflejada, y sus características 

cambian. 

Las ondas de radio, de cualquier clase, son atenuadas o debilitadas 

mediante la transferencia de energía al medio en el cual viajan 

cuando éste no es el vacio. En general, se encuentran una fuerte 

absorción en materiales conductores, sobre todo en metales. 

En redes inalámbricas al trabajar en frecuencias del rango de las 

microondas el mayor problema en absorción es el agua en todas sus 

formas (lluvia, neblina y la contenida en el cuerpo humano), por lo 

general se encuentra absorción intermedia en rocas, ladrillos y 

concreto dependiendo de la composición de los materiales, así como 

en árboles madera y otros materiales, que absorben energía 

fundamentalmente determinado por la concentración de agua. 

2.2.2.2. Atenuación 

La energía de una señal decae con la distancia como se lo puede 

apreciar en la Figura 2.4. La atenuación es la perdida de la potencia 

de una señal. Por ello para que la señal llegue con la suficiente 

energía es necesario el uso de amplificadores o repetidores. La 

atenuación se incrementa con la frecuencia, con la temperatura y 

con el tiempo. 
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Figura N° 2.4: Atenuación 

La atenuación, es expresada en decibelios por la fórmula siguiente: 

Dónde: 

a = Atenuación 

P¡ 
a::::: 10 * loB­. Pz 

P 1 = Potencia de Salida 

P2 = Potencia de Entrada 

2.2.2.3. Reflexión 

La reflexión es el cambio de dirección de un rayo o una onda 

que ocurre en la superficie de separación entre dos medios, de tal 

forma que regresa al medio inicial. 

Para la radiofrecuencia, la reflexión ocurre principalmente en el 

metal, pero también en superficies de agua y otros materiales con 

propiedades iguales. Los accidentes geográficos, naturales o 

artificiales tales como cabos, islas, entradas estrechas a bahías, o 

fenómenos marinos son los obstáculos más comunes que pueden 

oponerse o interponerse al oleaje, produciendo los fenómenos 

de reflexión. 

Se pude decir que estos son las leyes de la reflexión regular. 
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• El rayo incidente, el rayo reflejado y la recta normal, deben estar 

en el mismo plano con respecto a la superficie de reflexión en el 

punto de incidencia. 

• El ángulo formado entre el rayo incidente y la recta normal es igual 

al ángulo que existe entre el rayo reflejado y la recta normal. 

- Q 
~~}r/ 

"'· 

S 

Figura N° 2.5: Reflexión de ondas electromagnéticas 

2.2.2.4. Difracción 

En física, la difracción es un fenómeno característico de las ondas, 

éste se basa en el curvado y esparcido de las ondas cuando 

encuentran un obstáculo o al atravesar una rendija. 

La interferencia se produce cuando la longitud de onda es mayor 

que las dimensiones del objeto, por tanto, los efectos de la 

difracción disminuyen hasta hacerse indetectables a medida que el 

tamaño del objeto aumenta comparado con la longitud de onda. 

La difracción es un fenómeno basado en el hecho de que las 

ondas no se propagan en una sola dirección. Ocurre cuando las 

ondas se encuentran un obstáculo en su trayectoria. Para redes 

inalámbricas debido a que la longitud de onda es pequeña se 

requiere una línea de vista entre transmisor y receptor. 

2.2.2.5. Refracción 

La refracción es el cambio de dirección que experimenta una onda al 

pasar de un medio material a otro. Sólo se produce si la onda incide 

oblicuamente sobre la superficie de separación de los dos medios y 
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si éstos tienen índices de refracción distintos. La refracción se 

origina en el cambio de velocidad de propagación de la onda. 

Cuando un rayo se refracta al pasar de un medio a otro, el ángulo 

de refracción con el que entra es igual al ángulo en que sale al volver 

a pasar de ese medio al medio inicial. 

2.2.2.6. Interferencia 

Las ondas siguen el denominado principio de superposición, que 

afirma que cuando dos ondas se encuentran en el espacio se 

combinan en ese punto de encuentro, siguiendo posteriormente 

cada una de ellas su camino anterior sin producirse ninguna 

variación ni en su amplitud ni en su frecuencia ni en su fase. 

Se ha visto que, si dos ondas coinciden en el espacio, su interacción 

permanece mientras dura esa coincidencia. Por tanto, si tiene dos 

ondas superpuestas y viajando en la misma dirección, su interacción 

será permanente, produciendo lo que se denomina interferencia, y 

la onda resultante será de la suma de las dos ondas iniciales 

como se ve en la Figura 2.6. 

Onda re~ultllnl• 

Figura No 2.6: Interferencia 

Si las ondas tienen la misma frecuencia, y están en fase, se dice que 

su interferencia es constructiva, dando lugar a una onda resultante 

de la misma frecuencia cuya amplitud es mayor que las amplitudes 

de las ondas originales. Si las ondas están desfasadas 180 

grados, se dice que su interferencia es destructiva, ya que si 

sus amplitudes son iguales, la amplitud de la onda resultante es cero. 
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2.2.3. Antenas 

La interferencia tiene un papel importante en la difracción de las 

ondas. 

Se define antena como el dispositivo, generalmente metálico, capaz de 

irradiar y recibir ondas de radio o como la parte del sistema transmisor o 

receptor específicamente para radiar o recibir ondas electromagnéticas. En 

otras palabras, la antena es un elemento de transición entre un dispositivo de 

guía de ondas y el espacio libre, en el caso del sistema transmisor o viceversa 

en el caso del sistema receptor. 

Un principio fundamental de las antenas, llamada reciprocidad, denota que 

toda antena es un dispositivo reciproco porque las características y el 

desempeño de transmisión y de recepción son idénticas, como la 

ganancia, directividad, frecuencia de operación, ancho de banda, 

resistencia de radiación, eficiencia, entre otras. 

2.2.3.1. Diagrama de radiación o patrón de radiación 

El patrón de radiación de una antena es una representación gráfica 

de la ganancia de la antena en función del ángulo. Precisamente 

hablando, esto es un modelo de dos dimensiones, una función tanto 

de la dirección y los ángulos de elevación y azimut. El lóbulo 

principal de la antena es donde la ganancia máxima se produce. 

Figura N° 2.7: Diagrama de radiación 

Los parámetros más importantes del diagrama de radiación son: 

a) Dirección de apuntamiento.· Es la de máxima radiación. 

Directividad y Ganancia. 
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b) Lóbulo principal.- Es el margen angular en torno a la 

dirección de máxima radiación. 

e) Lóbulos secundarios.· Son el resto de máximos relativos, de 

valor inferior al principal. 

d) Ancho de haz.. Es el margen angular de direcciones en 

las que el diagrama de radiación de un haz toma un valor de 

3dB por debajo del máximo. Es decir, la dirección en la que la 

potencia radiada se reduce a la mitad. 

2.2.3.2. Ancho de banda 

Es el margen de frecuencias en el cual los parámetros de la antena 

cumplen unas determinadas características. Se puede definir un 

ancho de banda de impedancia, de polarización, de ganancia o de 

otros parámetros. 

2.2.3.3. Directividad 

La Directividad (D) de una antena se define como la relación entre la 

intensidad de radiación de una antena en la dirección del máximo y la 

intensidad de radiación de una antena isotrópica que radia con la misma 

potencia total. 

La Directividad no tiene unidades y se suele expresar en unidades 

logarítmicas (dBi) como: 

2.2.3.4. Ganancia 

Se define como la ganancia de potencia en la dirección de máxima 

radiación. La Ganancia (G) se produce por el efecto de la 

directividad al concentrarse la potencia en las zonas indicadas en 

el diagrama de radiación. 

La unidad de Ganancia (G) de una antena es el dBd o dBi, 

dependiendo si esta se define respecto a un dipolo de media onda o 

a la isotrópica. 
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2.2.3.5. Impedancia de entrada 

Es la impedancia de la antena en sus terminales. Es la relación entre 

la tensión y la corriente de entrada. 

La impedancia es un número complejo. La parte real de la 

impedancia se denomina Resistencia de Antena y la parte 

imaginaria es la Reactancia. La resistencia de antena es la suma 

de la resistencia de radiación y la resistencia de pérdidas. Las 

antenas se denominan resonantes cuando se anula su reactancía 

de entrada. 

2.2.3.6. Polarización 

Las antenas crean campos electromagnéticos radiados. Se define la 

polarización electromagnética en una determinada dirección, 

como la figura geométrica que traza el extremo del vector campo 

eléctrico a una cierta distancia de la antena, al variar el tiempo. La 

polarización puede ser lineal, circular y elíptica. 

2.2.3.7. Tipos de antenas 

a) Dipolos.- Un dipolo es una antena con alimentación central 

empleada para transmitir o recibir ondas de radiofrecuencia. 

Estas antenas son las más simples desde el punto de vista 

teórico. 

Figura N° 2.8: Antena dipolo 

b) Antenas omnidireccionales: Se les llama también antenas 

de fuste vertical. Se utilizan principalmente para emitir la señal 

en todas las direcciones. En realidad la señal que emite en esa 

forma de óvalo, y sólo emite en plano. 
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Figura N° 2.9: Antena omnidireccional 

Se suelen colocar en espacios abiertos para emisión todas las 

direcciones. También se usan en espacios cerrados. En caso 

de colocarlas en el exterior es conveniente colocarle un filtro 

de saltos de tensión, para evitar problemas con tormentas 

eléctricas. Son baratas, fáciles de instalar y duraderas. Su 

ganancia está en tomo a los 15 dBi. 

e) Antena tipo panel: Al igual que las antenas 

omnidireccionales, su uso es para conexiones punto a 

multipunto. Estas sin embargo solo emiten en una dirección 

Su radio de cobertura está entre los 60 y los 180 grados. 

Figura N° 2.10: Antena panel 

La ganancia de estas antenas es mejor que las 

omnidireccionales aproximadamente 22 dBi, y permiten 

orientarlas hacia la dirección que más interesa. 
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d) Antena de grilla o semi parabólicas: Las antenas semi 

parabólicas reflectoras de rejilla se han diseñado para 

operaciones de largo alcance y se pueden configurar para la 

polarización vertical u horizontal. Estas antenas han sido 

construidas con material de alta calidad y pueden adquirir 

alcanzar distancias de hasta varios kilómetros. Cuando el 

enlace inalámbrico se realiza entre edificios debe existir línea 

de vista entre los puntos y se hace preciso utilizar antenas 

direccionales y protectores contra rayos. Son muy utilizadas en 

enlaces inalámbricos de datos a frecuencias de 900 MHz, 2.4 

GHz, y 5.8 GHz. 

Figura N° 2.11: Antena de grilla 

2.2.4. Radioenlaces 

Se denomina radio enlace a cualquier interconexión entre los terminales de 

telecomunicaciones efectuados por ondas electromagnéticas. Se puede definir 

al radio enlace del servicio fijo, como sistemas de comunicaciones entre puntos 

fijos situados sobre la superficie terrestre, que proporcionan una capacidad de 

información, con características de calidad y disponibilidad determinadas. 

Típicamente estos enlaces se explotan entre los 800 MHz y 42 GHz 

Los radios enlaces, establecen un concepto de comunicación del tipo dúplex, 

de donde se deben transmitir dos portadoras moduladas: una para la 

Transmisión y otra para la recepción. Al par de frecuencia asignada para la 

transmisión y recepción de las señales, se lo denomina radio canal, los enlaces 
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se hacen básicamente entre puntos visibles, es decir, puntos altos de la 

topografía. 

Cualquiera que sea la magnitud del sistema de microondas, para un correcto 

funcionamiento es necesario que los recorridos entre enlaces tengan una 

altura libre adecuada para la propagación en toda época del año, tomando en 

cuenta las variaciones de las condiciones atmosféricas de la región. Para 

poder calcular las alturas libres debe conocerse la topografía del terreno, así 

como la altura y ubicación de los obstáculos que puedan existir en el trayecto. 

2.2.4.1. Presupuesto de enlaces 

Un presupuesto de potencia para un enlace punto a punto es el 

cálculo de ganancias y pérdidas desde el radio transmisor, a través 

de cables, conectores y espacio libre hacia el receptor. La estimación 

del valor de potencia en diferentes partes del radioenlace es 

necesaria para hacer el mejor diseño y elegir el equipamiento 

adecuado. 

• Elementos del presupuesto de enlace 

Los elementos pueden ser divididos en 3 partes principales: 

-/ El lado de Transmisión con potencia efectiva de transmisión. 

-/ Pérdidas en la propagación . 

./ El lado de Recepción con efectiva sensibilidad receptiva 

Un presupuesto de radio enlace completo es simplemente la 

suma de todos los aportes en el camino de las tres partes 

principales. 

Presupuesto de enlace= Potencia del transmisor [dBm] -

Pérdida en el cable TX [dB] + ganancia de antena TX [dBi] -

Pérdidas en la trayectoria en el espacio abierto [dB] +ganancia 

de antena RX [dBi] - Pérdidas en el cable del RX [dB] = Margen 

-Sensibilidad del receptor [dBm]. 
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perdida en el espacio abierto 

Figura No 2.12: Trayectoria completa de transmisión entre el transmisor y el receptor 

At Ar 

L=32,4+20 log(d!km)+20 log(ffl~hz) 

Pt 

Pérdida en el espacio libre 

<lBrn 

Rx 

·-·- PI Ma~gen 
1 

.................. "'L ..... ~ ......... 

Sensibilidad 
del receptor 

~---------------------------------- km 

Figura No 2.13: Potencia en dBm en función de la distancia para un radioenlace 

• El lado de transmisión 

,¡ Potencia de transmisión (Tx) 

La potencia de transmisión es la potencia de salida del radio. 

El límite superior depende de las regulaciones vigentes en 

cada país, dependiendo de la frecuencia de operación y 

puede cambiar al variar el marco regulatorio. En general, 

los radios con mayor potencia de salida son más costosos. 

La potencia de transmisión del radio, normalmente se 

encuentra en las especificaciones técnicas del vendedor. 

Tenga en cuenta que las especificaciones técnicas le darán 

valores ideales, los valores reales pueden variar con 

factores como la temperatura y la tensión de 

alimentación. 
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La potencia de transmisión típica en los equipos IEEE 802.11 

varía entre 15 - 26 dBm o 30 - 400 mW. 

Tabla N° 2.3: Potencia de transmisión de los estándares IEEE 802.11 a/b 

Protocolo Potencia pico [dBm] Potencia pico [mW] 

IEEE 802.11 a 18 65 

IEEE 802.11 b 20 100 

Fuente: Elaboración propia 

./ Pérdida en el cable 

Las pérdidas en la señal de radio se pueden producir en los 

cables que conectan el transmisor y el receptor a las antenas. 

Las pérdidas dependen del tipo de cable y la frecuencia de 

operación y normalmente se miden en dB/m o dB/pies. 

Independientemente de lo bueno que sea el cable, siempre 

tendrá pérdidas. Por eso, se recomienda mantener el cable 

de la antena lo más corto posible. La pérdida tipica en 

los cables está entre 0,1 dB/m y1 dB/m. En general, 

mientras más grueso y más rígido sea el cable menor 

atenuación presentará. 

Las pérdidas en los cables dependen mucho de la 

frecuencia, por eso al calcular la pérdida en el cable, se debe 

asegurar de usar los valores correctos para el rango de 

frecuencias usadas . 

./ Pérdidas en los conectores 

Estime por lo menos 0,25 dB de pérdida para cada 

conector en su cableado. Estos valores son para 

conectores bien hechos mientras que los conectores mal 

soldados pueden implicar pérdidas mayores. 

Si se usan cables largos, la suma de las pérdidas en los 

conectores está incluida en una parte de la ecuación de 

Pérdidas en los cables pero para estar seguro, siempre 
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considere un promedio de pérdidas de 0,3 a 0,5 dB por 

conector como regla general. 

Además, los protectores contra descargas eléctricas que se 

usan entre las antenas y el radio deben ser presupuestados 

hasta con 1 dB de pérdida, dependiendo del tipo . 

./ Amplificadores 

Opcionalmente, se pueden usar amplificadores para 

compensar la pérdida en los cables o cuando no haya otra 

manera de cumplir con el presupuesto de potencia. En 

general, el uso de amplificadores debe ser la última opción. 

Una escogencia inteligente de las antenas y una alta 

sensibilidad del receptor son mejores que la fuerza bruta de 

amplificación. 

Los amplificadores de alta calidad son costosos y uno 

económico empeora el espectro de frecuencia, lo que puede 

afectar los canales adyacentes. Todos los amplificadores 

añaden ruido extra a la señal, y los niveles de potencia 

resultantes pueden contravenir las normas legales. 

Técnicamente hablando, prácticamente no hay límites en la 

cantidad de potencia que puede agregar a través de un 

amplificador, pero nuevamente, tenga en cuenta que los 

amplificadores siempre elevan el ruido también . 

./ Ganancia de antena 

La ganancia de una antena típica varía entre 2 dBi 

(antena integrada simple) y 8 dBi (omnidireccional estándar) 

hasta 21 - 30 dBi (parabólica). Las pérdidas pueden ocurrir 

por muchas razones, principalmente relacionadas con una 

incorrecta instalación debido a pérdidas en la inclinación, en 

la polarización, objetos metálicos adyacentes, entre otros. 

Esto significa que sólo puede esperar una ganancia completa 

de antena, si está instalada en forma óptima. 
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• Pérdidas de propagación 

Las pérdidas de propagación están relacionadas con la 

atenuación que ocurre en la señal cuando esta sale de la antena 

de transmisión hasta que llega a la antena receptora . 

./ Pérdidas en el espacio libre (FSL) 

La mayor parte de la potencia de la señal de radio se 

perderá en el aire. Aún en el vacío, una onda de radio pierde 

energía que se irradia en direcciones diferentes a la que 

puede capturar la antena receptora. La pérdida en el espacio 

libre, mide la potencia que se pierde en el mismo sin ninguna 

clase de obstáculo, la señal de radio se debilita en al aire 

debido a la expansión dentro de una superficie esférica. 

La pérdida en el espacio libre es proporcional al cuadrado de 

la distancia y también proporcional al cuadrado de la 

frecuencia. Aplicando decibeles, resulta la siguiente ecuación: 

FSL(dB) = 92.4 + 20 log(d) + 20log(f) 

d =distancia [Km] 

f = frecuencia [GHz] 

dB - metros (2A/5.4 Ghz) 

'" -_.. 
......... _............ 

....... __. 1'.:.:. 

... - /" 
JL 
ti 
;¡ 
1 

Figura No 2.14: Distancia (m) vs. pérdida (dB) 

El gráfico muestra la pérdida en dB para 2.4 GHz y 5.4 GHz, 

se puede ver que después de 1 ,5km. Como regla general 

en una red inalámbrica a 2.4 GHz, 100 dB se pierden en el 

1 er kilómetro y la señales reducida a 6 dB cada vez que la 

distancia se duplica. Esto implica que un enlace de 2 km 
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tiene una pérdida de 106 dB y a 4km tiene una pérdida de 112 

dB, etc. 

Tabla N° 2.4: Pérdidas en el espacio libre 

Distancia [km] 915 MHz 2.4GHz 5.8GHz 

1 92dB 100 dB 108 dB 

10 112 dB 120 dB 128 dB 

100 132 dB 140 dB 148 dB 

Fuente: Elaboración propia 

Estos valores son teóricos y pueden muy bien diferir de las 

mediciones tomadas, Hay que tomar en cuenta que las 

pérdidas pueden ser muchas veces más grandes debido a 

las influencias del terreno y las condiciones climáticas. En 

particular, las reflexiones en cuerpos de agua o en objetos 

conductores pueden introducir pérdidas significativas . 

./ Zona de Fresnel 

La zona de Fresnal, es el espacio alrededor del eje que 

contribuye a la transferencia de potencia desde la fuente 

hacia el receptor. Basados en esto, podemos calcular cuál 

debería ser la máxima penetración de un obstáculo en esta 

zona para contener las pérdidas. 

Figura N° 2.15: Zona de Fresnel 

Lo ideal es que la primera zona de Fresnel no esté obstruida, 

pero normalmente es suficiente despejar el 60% del radio de 

la primera zona de Fresnel para tener un enlace satisfactorio. 

En aplicaciones críticas, habrá que hacer el cálculo también 
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para condiciones anómalas de propagación, en la cuales las 

ondas de radio se curvan hacia arriba y por lo tanto se 

requiere altura adicional en las torres. Para grandes distancias 

hay que tomar en cuenta también la curvatura terrestre que 

introduce una altura adicional que deberán despejar las 

antenas. 

La siguiente fórmula calcula la primera zona de Fresnal: 

r=17.32• M 
d1 = distancia al obstáculo desde el transmisor [km] 

d2 = distancia al obstáculo desde el receptor [km] 

d = distancia entre transmisor y receptor [km] 

f = frecuencia [GHz] 

r = radio [m] 

Si el obstáculo está situado en el medio (d1 = d2), la fórmula 

se simplifica: 

r = 17.32 * fd 
~41 

Tabla N° 2.5: Radio (m) para la primera zona de Fresnel 

Distancia [km] 915 MHz 2.4GHz 5.8GHz Curvatura terrestre 

1 9 6 4 o 
10 29 18 11 4,2 

100 90 56 36 200 

Fuente: Elaboración propia 

• Lado receptor 

Los cálculos son casi idénticos que los del lado transmisor. 

./ Ganancia de antena desde el receptor 

Mismo procedimiento visto desde el receptor. 

./ Amplificadores desde el receptor 
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Los cálculos y los principios son los mismos que el 

transmisor. Nuevamente, la amplificación no es un método 

recomendable a menos que otras opciones hayan sido 

consideradas y aun así sea necesario . 

./ Sensibilidad del receptor 

La sensibilidad de un receptor es un parámetro que 

merece especial atención ya que identifica el valor mínimo 

de potencia que necesita para poder decodificar/extraer "bits 

lógicos" y alcanzar una cierta tasa de bits. Cuanto más baja 

sea la sensibilidad, mejor será la recepción del radio. Un 

valor típico es -82 dBm en un enlace de 11 Mbps y -94 dBm 

para uno de 1 Mbps. 

Una diferencia de 10dB aquí es tan importante como 10 

dB de ganancia que pueden ser obtenidos con el uso de 

amplificadores o antenas más grandes. Nótese que la 

sensibilidad depende de la tasa de transmisión . 

./ Margen y relación S/N 

No es suficiente que la señal que llega al receptor sea mayor 

que la sensibilidad del mismo, sino que además se requiere 

que haya cierto margen para garantizar el funcionamiento 

adecuado. 

La relación entre el ruido y la señal se mide por la tasa de señal 

a ruido (S/N). Un requerimiento típico de la SNR es 16 dB 

para una conexión de 11 Mbps y 4 dB para la velocidad más 

baja de 1 Mbps. 

En situaciones donde hay muy poco ruido el enlace está 

limitado primeramente por la sensibilidad del receptor. En 

áreas urbanas donde hay muchos radioenlaces operando, es 

común encontrar altos niveles de ruido tan altos como -92 

dBm. En esos escenarios, se requiere un margen mayor: 
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. , (Potencia de la señal [W] 
RelacwnSJN[dB] = 10log p . d l 'd [W] otencw e rw o 

En condiciones normales sin ninguna otra fuente en la banda 

de 2.4 GHz y sin ruido de industrias, el nivel de ruido es 

alrededor de los -100 dBm. 

2.2.5. Tecnología MIKROTIK 

Mikrotik Ltd., conocida internacionalmente como Mikrotik, es una compañía 

letona vendedora de equipo informático y de redes. Vende principalmente 

productos de comunicación inalámbrica como routerboards o routers, 

también conocidos por el software que lo controla llamado RouterOS. 

2.2.5.1. Software routerOS 

El principal producto de Mikrotik es el sistema operativo conocido 

como Mikrotik RouterOS basado en Linux. Permite a los usuarios 

convertir un ordenador personal PC en un router, lo que permite 

funciones como firewall, VPN Servar y Cliente, Gestor de ancho de 
' 

banda, QoS, punto de acceso inalámbrico y otras características 

comúnmente utilizado para el enrutamiento y la conexión de redes. 

El sistema operativo es licenciada en la escalada de niveles 

Aunque RouterOS se puede probar gratis, el software viene con 

algunas limitaciones. Puede adquirir un nivel3, 4, 5 y 6. El nivel1 es 

la licencia de demostración. La diferencia entre los niveles de 

licencia se muestra en la Tabla W 2.6. 
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Tabla N° 2.6: Diferencias de licencias de RouterOS 

Número de nivel 1 3 (WISP) 4 (WISP) 5 (WISP) 6 (Contralor) 

Precio registrarse volumen sólo $45 $95 $250 

sin ROS 
Para actualizable ROS V6.x 

mejoras ROS V6.x v7.x ROS v7.x 

Inicial de 

configuración de - - 15 días 30 días 30 días 

Apoyo 
Punto de acceso 

inalámbrico - - sí sí sí 

Cliente inalámbrico 
- sí SÍ sí sí 

y el puente 

RIP, OSPF, BGP - sí (*) sí SÍ sí 

PPPoE túneles 1 200 200 500 ilimitado 

Túneles PPTP 1 200 200 500 ilimitado 

Interfaces VLAN 1 ilimitado ilimitado ilimitado ilimitado 

HotSpot usuarios 1 1 200 500 ilimitado 
.... ~ 

-'l!..LIVU~ 

RADIUS cliente - sí sí sí SÍ 

Colas 1 ilimitado ilimitado ilimitado ilimitado 

Web proxy - sí sí sí sí 

Interfaces 
sí sí sí - -

síncronos 
Sesiones de 

usuario 
1 10 20 50 Unlimited 

administrador de 

activos 
Fuente: Elaboración propia 
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2.2.5.2. Hardware RouterBOARD 

Figura No 2.16: RouterOS 

Es la división de hardware de la marca Mikrotik caracterizado por su 

Sistema Operativo RouterOS por ser muy potente y fácil de 

configurar. Estos dispositivos tienen la ventaja de tener una relación 

beneficio/costo muy alto. 

Los modelos generalmente empiezan con la letra RBXXX indicando 

la plataforma que usa. Se dividen en routers de media/baja gama, 

routers de alta gama, Interfaces y adaptadores, La venta de 

RouterOS, combinado con su línea de productos hardware conocida 

como Milkrotik RouterBOARD, está enfocada a los pequeños y 

medianos proveedores de acceso a Internet, que normalmente 

proporcionan acceso de banda ancha inalámbrica en áreas remotas. 

Tabla N° 2.7: Características de RouterBOARD 

Modelo Crossroads RB450 RB411/AIAH RB493/AH 

MIPS32 

CPU 4KEc basado Atheros AtherosAR7130/ Atheros 

184MHz AR7130 AR7130/AR7161 AR7130/AR7161 

RAM 32MB 32MB 32/64/64 MB 64MB/128MB 

Puertos 5x 

Ethernet 1 X 10/100 10/100 1 X 10/100 9 X 10/100 
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Modelo Crossroads RB450 RB411/AIAH RB493/AH 

Onboard 

Expansión 802.11b/g 

wireless Ninguna 1 miniPCI 3 miniPCI 

Almacenamiento 64MB 64MB 64MB 64MB 

Po E si Si Si Si 

Software 
RouterOS RouterOS Ro u terOS 

Level4 Level4 L3/L4/L4 RouterOS L4/L5 
Fuente: Elaboración propia 

Con los equipos Mikrotik es posible obtener un gran ancho de banda, 

el equipamiento ofrece diversas características incluyendo firewalls, 

NAT, VPN, gestión de ancho de banda, QoS además de 

soportar ruteo estático y una variedad de protocolos dinámicos 

como RIP v1 y v2, OSPF v2, BGP v4.en lpv4 y RIPng, OSPFv3, 

BGP en lpv6 

2.2.5.3. Caracteñsticas sobresalientes 

a) Firewall 

El Fírewall implementa el filtro de paquetes, a su vez provee 

funciones de seguridad robusta, utilizadas para manejar el flujo 

de datos hacia, desde y a través del enrutador. En conjunto 

con NAT "Network Address Translation" sirve para prevenir 

acceso no autorizado a redes directamente adjuntas y en el 

mismo enrutador como un filtro para el tráfico saliente. 

b) QoS 

El control de ancho de banda es un conjunto de mecanismos 

para controlar la repartición de tasa de datos, variabilidad de 

retraso, tiempo de entrega y confiabilidad de entrega. La calidad 

de servicio (QoS) significa que el enrutador puede priorizar y 

modelar el tráfico de la red. Algunas características del 

mecanismo de control de tráfico están listadas a continuación: 
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• Límite de tasa de datos para ciertas direcciones IP, 

subredes, protocolos, puertos. 

• Límite del trafico punto a punto "Peer to Peer". 

• Prioriza algunos flujos de paquetes sobre otros 

especificados. 

• Utiliza la ráfaga de cola "queuing" para una búsqueda por 

Web más rápida. 

• Comparte el tráfico disponible entre usuarios por igual, o 

dependiendo de la carga del canal. 

e) Software especializado 

• Winbox: Existe un software llamado Winbox que ofrece 

una sofisticada interfaz gráfica para el sistema operativo 

RouterOS. El software también permite conexiones a 

través de FTP y T elnet, SSH y acceso shell. También 

hay una API que permite crear aplicaciones 

personalizadas para la gestión y supervisión. 

• Radio Mobile: Radio Mobile es un programa de 

simulación de radio enlaces gratuito que nos sirve para 

operar dentro del rango de 20 MHz a 20 GHz, basado en 

el modelo de propagación ITS (Irregular Terrain Model). 

El programa permite dibujar la elevación en los mapas 

usando los datos SRTM descargados desde S pace Shuttle 

Radar Terrain Mapping Mission, con la posibilidad de 

agregar los mapas de rutas y autopistas simultáneamente 

a los relieves del contorno, obviamente junto a las curvas 

de nivel. 

El rendimiento de cada unidad transmisora o receptora 

puede ser especificada detallando la potencia, 

sensibilidad, parámetros de la antena, etc. los enlaces 

entre las unidades también pueden ser analizados. El 
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patrón de cobertura puede analizarse individualmente para 

cada unidad en caso de ser necesario. 

No es necesario especificar la característica básica que 

debe poseer un software para simulación de este estilo, y 

que por supuesto Radio Mobile posee, a saber: radio de 

fresnel, curvatura terrestre, horizonte visual, características 

troposféricas. 

Figura N° 2.17: Software radio mobile 

Resumiendo, Radio Mobile es un excelente software de 

simulación de radio enlaces que debería ser instalado por 

los estudiantes de Ingeniería Electrónica para corroborar 

sus cálculos y mediciones hechos en papel. 

• JPERF: Jperf es una herramienta de prueba de red de uso 

general que puede crear flujos de datos TCP y UDP y medir 

el rendimiento de una red. 

Jperf permite al usuario configurar los distintos parámetros 

que pueden ser utilizados para realizar pruebas en una red, 

alternativamente, para optimizar el ajuste o una red. Jperf 

tiene un cliente y servidor de la funcionalidad, y se puede 

medir el rendimiento entre los dos extremos, ya sea 

unidireccional o bidireccionalmente. 
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Se trata de software de código abierto y funciona 

en varias plataformas, incluyendo Linux, Unix y Windows. 

Es apoyada por el Laboratorio Nacional de la Red de 

Investigación Aplicada. 

Jperf es significativo, ya que es una herramienta 

multiplataforma que puede ejecutarse en cualquier red y 

las medidas de salida estándar de rendimiento. Por lo 

tanto, puede ser utilizado para la comparación de equipos 

de redes cableadas e inalámbricas y tecnologías de una 

manera imparcial. 

• EDRAW: Edraw Max es un software de diagrama de todo 

en uno que hace que sea sencillo para crear diagramas de 

flujo de aspecto profesional, organigramas, diagramas de 

red, presentaciones de negocios, planes de construcción, 

diagramas de ingeniería eléctrica, mapas direccionales, 

diagramas de bases de datos y mucho más, con más de 

4600 símbolos vectoriales incluidos, y una extensa 

biblioteca de pre- dibujadas ilustraciones, si está 

familiarizado con el entorno de Microsoft Office, que va 

a retomar Edraw Max. El uso de plantillas, formas y 

herramientas de dibujo, es posible construir intuitivamente 

gráficos y diagramas que transmiten la información con 

más eficacia que nunca. Usando una técnica de diseño de 

arrastrar y soltar, junto con la alineación automática y su 

elección de colores, fuentes y estilos, la construcción de 

los diagramas en Edraw Max es rápida y fácil. 

2.2.6. Internet y Banda Ancha 

Internet es un conjunto descentralizado de redes de comunicación y 

computadores, los cuales se encuentran interconectados entre sí mediante un 

mismo protocolo de comunicación (IP, de la arquitectura TCP/IP), formando 
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una red internacional de alcance mundial públicamente accesible, a través de 

la cual se proporcionan servicios de información y comunicación de 

diversa índole, como son los servicios de contenido, el correo electrónico, la 

voz sobre IP, las redes sociales, entre otros. 

En los inicios del Internet, una de las tecnologías de transmisión de datos 

predominante fue X.25, cuya velocidad oscilaba entre 1200 bps y 56 Kbps. En 

el transcurso del tiempo, estas tecnologías fueron evolucionando, siendo que 

a la fecha, las velocidades que se observan en el núcleo de las redes de los 

ISP están en el orden de los Gbps. 

Con respecto al uso del Internet, dados los altos costos de los enlaces de 

comunicaciones, su uso inicialmente estaba restringido a redes 

gubernamentales, académicas, de investigación y del sector empresarial. Es 

posible señalar que uno de los pilares para la masificación del acceso a 

Internet, fue la utilización de la tecnología "Diai-Up", la cual permite que a 

través del uso de modems, los computadores puedan efectuar llamadas 

telefónicas (utilizando las redes y servicios de telefonía fija) y establecer 

comunicaciones de datos, siendo que de esta forma es posible conectarse a 

Internet a bajas velocidades (la máxima velocidad que se puede alcanzar es 

de 56 Kbps). 

A las tecnologías de acceso, con velocidades comparables al "Diai-Up" 

también se les denomina de Banda Angosta. Posteriormente, se desarrollaron 

nuevas tecnologías de acceso denominadas de Banda Ancha, las cuales 

permiten mayores velocidades de transmisión de datos, sin necesidad de 

utilizar el servicio de telefonía fija. 

Las empresas de telecomunicaciones que prestan el servicio de acceso a 

Internet, son denominadas Proveedores de Servicios de Internet o ISP (por sus 

siglas en Inglés, Internet Service Providers). Con la finalidad de brindar el 

acceso a Internet, los ISPs necesitan desplegar sus redes de 

telecomunicaciones hasta lograr conectividad con los equipos terminales de 

los usuarios (computadoras personales, portátiles, teléfonos, etc.), para lo cual 

se diseñan las redes con diversas topologías y tecnologías. 
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Las conexiones de Banda Ancha, permiten acceder a conocimientos, 

comunicaciones y servicios de diversa índole como educación, salud, trabajo, 

entre otros, por lo cual incrementa la productividad y contribuye al crecimiento 

económico y social de un país. En esa medida, merece un rol central en las 

estrategias de desarrollo del Estado. s 

2.2.7. Definiciones de Banda Ancha 

La banda ancha puede ser entendida como una conexión a Internet en forma 

permanente, permitiendo al usuario estar siempre "en línea", a velocidades que 

le permite obtener y proporcionar información multimedia interactivamente y 

acceder a diversas aplicaciones y servicios. 

En el país no se ha definido expresamente el concepto de banda ancha; sin 

embargo para las estadísticas con que se cuenta a la fecha, se han 

considerado como accesos de banda ancha, aquellas conexiones cuyas 

velocidades de transmisión de datos son superiores a las velocidades que 

alcanzan las comunicaciones vía dial-up, tanto de forma alámbrica como 

inalámbrica. 

A nivel internacional, no existe consenso en una definición exacta sobre Banda 

Ancha, así, la Unión Internacional de Telecomunicaciones (U ID se ha referido 

a este concepto desde diversas perspectivas, conforme se observa a 

continuación: 

- "( ... )el término banda ancha no se ha definido con claridad.( ... ) Si bien ha 

habido muchos intentos de asociar el término a una velocidad o a un 

conjunto de servicios en particular, la banda ancha es en realidad un 

concepto cambiante". 

- "( ... )se considerará como Banda Ancha aquellos, accesos inalámbricos o 

no, que en sentido descendente (es decir hacia el cliente) provean 

velocidades permanentes de datos iguales o mayores a 256 Kbps sin límite 

de tiempo ni volumen de información transmitida". 

5 [Fecha de acceso: 5 de junio del2014]. URL disponible en: https://www.mtc.gob.pe/portal/proyecto_banda 
_ancha/Pian%20Bandíf/o20Ancha%20vf.pdf 
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- "( ... ) Más allá de estos límites precisos de la velocidad de transmisión de 

datos, una manera más útil de definir la banda ancha tal vez sea la de 

examinar qué se puede hacer con esta". 

- "Puesto que las tecnologías de banda ancha cambian continuamente, su 

definición va evolucionando a la par. Hoy en día el término banda ancha 

normalmente describe a las conexiones Internet recientes que funcionan 

entre 5 y 2 000 veces más rápido que las anteriores tecnologías de 

marcación por Internet. Sin embargo, el término banda ancha no se refiere 

a una velocidad determinada ni a un servicio específico. El concepto de 

banda ancha combina la capacidad de conexión (anchura de banda) y la 

velocidad". 

- "banda ancha: Califica a un servicio o sistema que requiere de canales de 

transmisión capaces de soportar velocidades superiores a la velocidad 

primaria".s 

- Para efectos de la Ley, entiéndese por Banda Ancha a la conectividad de 

transmisión de datos principalmente a Internet, en forma permanente y de 

alta velocidad, que le permite al usuario estar siempre en línea, a 

velocidades apropiadas para la obtención y emisión interactiva de 

información multimedia, y para el acceso y utilización adecuada de diversos 

servicios y aplicaciones de voz, datos y contenidos audiovisuales. 

El Ministerio de Transportes y Comunicaciones determina y actualiza 

periódicamente la velocidad mínima para que una conexión sea considerada 

como acceso a Internet de Banda Ancha, que será aplicable con 

independencia de la ubicación geográfica de los usuarios. 

La revisión de la velocidad mínima para el acceso a Internet de Banda Ancha 

se realizará cada dos (2) años; sin pe8uicio de lo cual, atendiendo a la 

evolución tecnológica y de mercado, el Ministerio de Transportes y 

Comunicaciones podrá efectuar la actualización en períodos menores al antes 

indicado. 

6 [Fecha de acceso: 5 de junio del 2014]. URL disponible en: https://www.mtc.gob.pe/portal/proyecto_banda 
_ancha/Pian%20Banda%20Ancha%20vf.pdf 
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El OSIPTEL determinará y actualizará periódicamente indicadores de calidad 

que permitan a los Usuarios conocer, evaluar y comparar las condiciones bajo 

las que se presta el servicio de acceso a internet de Banda Ancha Fija, 

alámbrica e inalámbrica, y Banda Ancha Móvil. 

Asimismo, en el marco de sus competencias, el OSIPTEL podrá establecer en 

base a dichos indicadores, requisitos mínimos de calidad de obligatorio 

cumplimiento para los Operadores de Telecomunicaciones y Proveedores de 

Acceso a Internet. 

La presente regulación sobre indicadores de calidad en Banda Ancha, no 

enerva las atribuciones que ya detenta el referido organismo regulador en 

materia de calidad del servicio de acceso a Internet. 

El OSIPTEL implementará herramientas de medición de velocidad tanto para 

accesos alámbricos como inalámbricos, compatibles con los equipos 

terminales fijos y móviles existentes en el mercado, que permitan a cada 

usuario evaluar bajo parámetros uniformes y de forma inmediata la velocidad 

efectiva de subida y de bajada de su conexión, y acumular un registro histórico 

de sus mediciones, entre otras características que defina el OSIPTEL. 

Asimismo, el OSIPTEL podrá definir mecanismos para realizar mediciones que 

puedan ser utilizadas por los usuarios como sustento para eventuales 

procesos de reclamos en materia de calidad del servicio en función a la 

disponibilidad de herramientas idóneas para dichos fines.7 

2.2.8. Redes de Telecomunicaciones de Banda Ancha 

Técnicamente es posible dar servicio de Banda Ancha a través de múltiples 

tecnologías o plataformas. Existen dos grandes categorías, las tecnologías 

alámbricas -donde existe una conexión física a través de algún tipo de cable 

desde las instalaciones del operador hasta el inmueble del cliente- y las 

inalámbricas -donde el acceso al equipo o equipos del cliente se realiza por 

7 Decreto Supremo N° 014-2013-MTC. Reglamento de la Ley de Promoción de la Banda Ancha y Construcción 
de la Red Dorsal Nacional de Rbra Óptica. 
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medio de ondas electromagnéticas que se propagan usando el espectro 

radioeléctrico y no implican una conexión física entre el proveedor y el cliente. 

Entre las tecnologías alámbricas están el Cable-Modem que opera a través del 

cable de televisión pagada, DSL que opera a través del par de cobre de la 

telefonía fija, Red Eléctrica (PLC) que opera a través de la red eléctrica y la 

Fibra óptica (FTTH) que requiere la instalación especial de este cable. Con 

excepción de esta última tecnología, las otras tres utilizan la red de algún otro 

servicio (televisión pagada, telefonía fija o suministro eléctrico), requiriendo de 

inversiones adicionales en equipamientos y/o mejoramiento de redes para 

otorgar también el servicio de Banda Ancha. En cuanto a las tecnologías 

inalámbricas existen las que dan acceso vía satélite, los sistemas inalámbricos 

fijos (WLL y WiMax) y los servicios móviles (2,5G y 3G). 

El DSL y el Cable-Modem son las plataformas de mayor penetración, 

ocupando en conjunto entre el 83% y el 100% del mercado de Banda Ancha. 

Dentro del resto de las tecnologías, las más relevantes son las de Fibra óptica 

(FTTH), WLL y Satélite. 

El desarrollo desigual entre las tecnologías se explica por diversas razones. 

En primer lugar, la Banda Ancha por Cable-Modem y DSL se masifican debido 

a que se ofrecen a través de la infraestructura ya desplegada de los productos 

básicos de cada red; la televisión pagada y la telefonía fija. En segundo lugar, 

desde el punto de vista de los costos, las tecnologías alámbricas pueden 

explotar mejor las economías de densidad respecto a las inalámbricas, siendo 

estas últimas más competitivas en zonas rurales o de baja densidad 

habitacional (por ejemplo el Satélite). La evolución más temprana del Cable y 

DSL asimismo ha permitido que el costo de sus equipamientos específicos de 

transmisión sea menor al del resto de las tecnologías. 

Finalmente existen diferencias desde el punto de vista de la calidad del 

servicio. Actualmente, las tecnologías inalámbricas no son capaces de replicar 

las velocidades máximas ofrecidas por las alámbricas. Estas últimas también 

presentan mayor fidelidad en la transmisión de señales dado que están menos 

sujetas a interferencias del medio. Algunas de las inalámbricas (4G) poseen la 
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ventaja de la movilidad y son un factor de diferenciación respecto a las 

alámbricas. 

En definitiva, el grado desigual de evolución y competitividad de las tecnologías 

implica que actualmente no todas ellas son comercialmente competitivas con 

las tecnologías mayoritarias (Cable y DSL) en todos los segmentos del 

mercado donde estas últimas dan servicio. Sin embargo, la tecnología WiMax 

tendría, según algunos analistas e inversionistas, el potencial de transformarse 

en una tercera plataforma competitiva para proveer Banda Ancha.8 

La estructura actual de las redes de telecomunicaciones de Banda Ancha para 

el acceso a Internet, está conformada en términos generales por los elementos 

que se observan en la Figura No 2.18. 

INTERNET 
RED DE TELECOMUNICACIONES 

DELISP 

NÚCLEO DE RED DE RED DE 
LA RED TRANSPORTE ACCESO 

~--------------------~ 
ENLACES DE 

SALIDA A INTERNET 

EQUIPAMIENTO 
DEL USUARIO 

. ~ 
•.. · ... ~8 

Figura N° 2.18: Estructura de las Redes de Banda Ancha para el Acceso 

a Internet 

Así, estas redes para brindar acceso a Internet a los usuarios, requieren contar 

con una serie de elementos, entre ellos: 

a) Enlaces de Salida a Internet 

Son enlaces de comunicaciones de alta velocidad que permiten 

interconectar la red de telecomunicaciones del ISP con Internet. En 

términos generales, existen dos tipos de enlaces: 

a.1) Enlaces Internacionales 

Dichos enlaces unen los países y continentes a través de cables 

submarinos de fibra óptica. 

8 [Fecha de acceso: 5 de junio del 2014]. URL disponible en: http://www.econ.uchile.cl/uploads/publicacion/ 
d5a78bdd-3e1 f-4f03-b167 -f613876a3f33.pdf 
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a.2) Enlaces Locales 

Son enlaces de comunicaciones con los puntos de intercambio de 

tráfico local, también conocidos como puntos de acceso a la red o 

NAP, por sus siglas en inglés (Network Access Points). Usualmente 

dichos enlaces son de fibra óptica. 

b) Red de telecomunicaciones deiiSP 

Tiene los siguientes componentes: 

b.1) Núcleo de la Red 

Está compuesto principalmente por redes y equipos de 

conmutación de paquetes de alta capacidad y velocidad, que 

permiten concentrar el tráfico de todos los usuarios de la red y 

encaminar los datos desde y hacia Internet, a través de los enlaces 

internacionales. 

b.2) Red de Transporte 

Tipo de 
Medio 

Alámbrico 

Inalámbrico 

Consiste en la infraestructura, medios de transmisión y equipos 

necesarios para transportar las señales de telecomunicaciones. Esta 

red está constituida por enlaces que unen distintas zonas de una 

misma ciudad, así como las diversas regiones y provincias del país, 

y utiliza principalmente tres clases de medios de transporte: fibra 

óptica, enlaces microondas y enlaces satelitales (ver Tabla W 2.8). 

Tabla No 2.8: Medios de Transporte- Banda Ancha 

Medio de Velocidad Infraestructura necesaria Transporte 
Fibra óptica Alta Duetos subterráneos, postes, 

torres eléctricas. 
Enlaces terrestres Media Torres de 

telecomunicaciones y 
antenas. 

Enlaces satelitales Baja Mínima. Únicamente obras 
civiles para instalar el Hub 
satelital 

Fuente: Plan Nacional para el Desarrollo de la Banda Ancha en el Perú 
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.Tipo de 

Medio 

Alámbrico 

Inalámbrico 

b.3) Red de Acceso 

Consiste en la infraestructura, equipos de telecomunicaciones y 

medios de acceso necesarios para conectar los terminales de los 

usuarios con la red. Esta red tiene un alcance corto, de pocos 

kilómetros, generalmente dentro de un distrito, y utiliza 

principalmente alguna de las siguientes tecnologías: ADSL, 

DOCSIS, Wimax, UMTS, HSPA, VSAT y líneas dedicadas Tabla W 

2.9. 

Tabla N° 2.9: Tecnologías Utilizadas- Banda Ancha 

Velocidades 
Medio de Tecnología más Infraestructura 

Acceso usada 
típicas en el 

necesaria 
Perú 

Duetos 

Fibra óptica Líneas dedicadas 1 Gbps subterráneos, 

postes. 

Cable de ADSL, DOCSIS 
Duetos 

cobre (par de (Cable 
5 Mbps subterráneos, 

cobre, cable Módem), Líneas 

coaxial, otros) dedicadas 
postes. 

Líneas dedicadas, Torres de 
Redes 

terrestres 
WiMax, UMTS, 2 Mbps telecomunicaciones 

HSPA. y antenas 

Redes 
VSAT 512 Kbps No requiere 

satelitales 

Fuente: Plan Nacional para el Desarrollo de la Banda Ancha en el Perú 

Cabe señalar, que actualmente las tecnologías ofrecidas por las 

empresas operadoras en el país para prestar el servicio de acceso a 

Internet móvil de banda ancha, son las tecnologías de acceso 

inalámbricas UMTS y HSPA. También las tecnologías GPRS y 

EDGE pueden brindar acceso a Internet móvil, aunque con 

velocidades bastante inferiores. 
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2.2.9. Tecnologías que permiten brindar acceso a Internet de Banda Ancha 

a) Tecnologías alámbricas 

Tecnología DSL (Digital Subscriber Line-Línea Digital de 

Abonado) 

Es una familia de tecnologías (siendo ADSL la de mayor 

implementación) que permite brindar acceso a banda ancha sobre la 

red de acceso de telefonía convencional (PSTN). Para ello, en el par 

de cobre, los datos se transmiten en un rango de frecuencia más alto 

que el utilizado para la voz, evitando la interferencia mutua. La 

implementación de la tecnología DSL requiere colocar un modem 

DSL en el hogar del cliente y un equipo (denominado DSLAM) en la 

central del operador. Una de las principales consideraciones en el 

despliegue de esta tecnología es la longitud del bucle de abonado, 

ya que el ancho de banda brindado varia inversamente proporcional 

a esta longitud. Del mismo modo, las velocidades alcanzadas varían 

con el tipo de tecnología DSL, por ejemplo ADSL2+ permite ofrecer 

tasas de hasta 24Mbps sobre distancias menores a 1.2 Km. 

Tecnología DOCSIS (Data Over Cable Service Interface 

Specification) 

La tecnología DOCSIS permite brindar acceso de banda ancha 

utilizando las redes de cable, las cuales fueron diseñadas 

originalmente para soportar solamente la transmisión de señales de 

televisión por radiodifusión. La arquitectura de las redes DOCSIS es 

conocida como HFC y se soporta en un anillo metropolitano de fibra 

óptica en el núcleo, y una red de acceso que utiliza fibra entre los 

nodos de distribución y los nodos ópticos, y entre estos y el tendido 

de cable coaxial en el tramo hasta el hogar del abonado. En su última 

versión (DOCSIS 3.0) esta tecnología permite alcanzar velocidades 

mayores a 160 y 120Mbps, para la bajada y subida respectivamente. 
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Tecnología DOCSIS 

Figura No 2.19: Tecnologías DSL y DOCSIS 

Tecnología FTTH (Fiber To The Home) 

FTTH es una arquitectura donde el camino de la comunicación es 

provisto por fibra óptica, es decir el camino desde el equipo de 

conmutación del operador hasta el domicilio del abonado. 

Al utilizar fibra óptica en la última milla, FTTH brinda grandes 

capacidades de ancho de banda, sin embargo requiere de mayor 

inversión en infraestructura, lo cual limita mayormente su despliegue 

en mercados emergentes. Existen dos tipos de tecnología FTTH: 

PON (Passive Optical Network) y EPtP (Ethernet Point to Point). 

·--- ---- -_----------:_, @·-.. · _··-· ._.··_-_· 
' ¡ . --

FJbre To Thé : . · 
Home (FTTH} : . ··. ··. 

' ' • ~ < 

-
1 Cu~ton-cr 

Figura N° 2.20: Arquitectura simplificada de FTTH 

b) Tecnologías inalámbricas 

Tecnología WiMAX (Worldwide lnteroperability for Microwave 

Access) 

Tecnología de banda ancha inalámbrica normada por el estándar 

IEEE802.16. Actualmente, en el mercado existen dos versiones; 

WiMAX Fijo (IEEE802.16d) y WiMAX Móvil (IEEE802.16e); sin 

embargo se espera próximamente la comercialización de la versión 

4G de WiMAX (IEEE802.16m). La arquitectura de esta tecnología es 

similar al de la telefonía móvil, es decir requiere centrales de 

conmutación, estaciones base y terminales de usuario móvil y fijo. 

En la versión fija se logran picos de velocidad de descarga de hasta 

6.55Mbps, mientras que en la versión móvil estos picos llegan hasta 
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46Mbps; por otro lado, la versión 802.16m pretende alcanzar picos 

de 1 OOMbps. WiMAX soporta frecuencias en el rango de 2 a 11 GHz, 

sin embargo los principales despliegues de esta tecnología han sido 

en las bandas de 3.5 y 5.8 GHz para la versión fija, y en las bandas 

2.3, 2.5 y 3.5 GHz para la versión móvil. 
BACKHAUL 

Punto a punto ¡ ·-.. _: __ ·- -~, · .:. P•:rto MuKipunto 

· . IEEE 002.16d 

Estadón Base 
WIMAK 

Usuarios WiMAX 

Figura N° 2.21: Topología simplificada de WiMAX 

Tecnología UMTS/HSPAILTE 

Se tratan de las tecnologías móviles 3G (UMTS/HSPA) y 4G (L TE) 

las cuales posibilitan brindar el acceso a banda ancha a través de las 

redes móviles. Estas tecnologías poseen una gran acogida a nivel 

mundial, teniendo a septiembre de 2009 4 billones de suscriptores 

móviles a nivel mundial, de los cuales el 80.11% hace uso de la 

tecnología GSM (2G) y el 9.35% del total accede mediante 

tecnología UMTS-HSPA (3G), y cada vez son más los usuarios que 

utilizan estos servicios de tercera generación. 

Los actuales despliegues de HSDPA especifican un pico de 

descarga teórico de 14.4 Mbps por sector de estación base. La 

versión 4G de este estándar, denominada LTE, especifica 

velocidades de 100 Mbps en ambientes de alta movilidad y hasta 

1 Gbps en baja movilidad. 
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2.3. Hipótesis 

2.3.1. Hipótesis general 

; municación inalámbrica provee servici~ de i~temet de b~nda 
Yn@.r~•tf{!~I.;.UIIt:::i t:UUI,;i::I~·Vi::l::i ut: ~\~~:.• f~·~·~~~~ 1~ ~~~~~ ~~~ ~~~ Y!!?!!.!lY ---!..-- t;:,... :--~:~ •. -:---- _ ..... ·--~·· ·-- .... _ i 
de~ba. · 

~· 

2.3.2. Hipó~ específicos 

a) La t~otogta aoz.11n provee Internet rnatamMco de Danda ancna a ras 

instituciones educativas de nivel primario de educación básica regular en la 

micro red Colcabamba a una velocidad mayor a 256 kbps. 

b) Mediante los equipos Ubíquiti se provee intemet inalámbrico de banda 

ancha a las instituciones educativas de nivel primario de educación básica 

regular en la micro red Colcabamba con un nivel de ganancia mayor a 90 

dBm. 

2.4. Vartablt::t de l!:rtudl" 

Variables 
Operacionalización de 

Indicadores Unidades 
las Variables 

lndaaandionto Conexión de nodos sin a) Torres a} Se mide en und 

a) Red de necesidad de una b) Antenas b) Se mide en und 

Telecomunicacio conexión física. e) Access Point e) Se mide en und 

nes=RT 

De~endientes Conexión cuya velocidad a) Velocidad de a) Se mide en 

a) Internet de Banda de transmisión de datos Transmisión kbps. 

Ancha=IBA son superiores a las 

velocidades que alcanzan 

las comunicaciones vía 

dial-up (mayor a 56 kbps), 

tanto de forma alámbrica 

como inalámbrica. 
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3.5. Diseño de lnvestigación[2l 

\ 
1 

~ X ~ 
Infraestructura de ~ 02 

01 telecomunicaciones 

' 

Figura N° 3.1: Diseño de investigación 

Es cuasi experimental, en la figura W 3.1 X representa la microrred de Colcabamba 

donde se va implementar la infraestructura de telecomunicaCiones inalámbrica, 01 es 

la observación que se hace a la velocidad de conexión antes de implementarse la red 

y 02 es la observación de velocidad de bajada cuando se implementa la red de 

r61ewmumcactor:tes, Hil l.t. 4'4ii ó12!t:IO, se en§e esta msmue1on debido a que se ha 

pres~ las facilidades del caso para poder realizar la investigación. 

3.6. Pobl\ión, Muestra, Muestreo 

3.6.1.\ Población 
.. \ 

Tabla N°~3.1·: Instituciones Educativas de Nivel Primario del Distrito de Colcabamba 

Jnd~Ución 
N° de 

No Centro Poblado 
alumnos Altitud Latitud Longitud 

Edul~iva nómina de 
matríoula ~01a 

01 3iiil2 Taracay 26 2709 -12.3515 -74.7125 
02 30132 Vista Alegre 59 3833 -12.3808 -74.7375 
03 30176 Chauquimarca 51 3247 -12.3863 -74.6983 
04 30341 Collpacucho 21 2637 -12.4169 -74.6507 
0!1 :ID408 M rlAM::~IIm::~ 24 2779 -12.5066 -74.7051 
u o JW4::S Colcaoamba 254 3006 -12.4109 -74.6809 
07 ·30944 Colcabamba 226 3006 -12.4109 -74.6809 
08 3] [)45 Tocas 269 3032 -12.4434 -74.654 
09 3( ~6 Carpapata 82 3833 -12.3949 -74.7522 
10 3( ~7 Independencia 113 3331 -12.4226 -74.6944 
11 31~ ,27 Quintao 96 3246 -12.2619 -74.6727 
12 31 128 Toc!lacuri 65 3549 -12.3451 -74.7951 
13 31030 Andaymarca 121 2926 -12.3155 -74.6354 
14 31031 Arhuayacu 78 3057 -12.3784 -74.7199 
15 31032 Huaranhuay 88 2437 -12.3573 -74.5816 
16 31033 Yanacocha 26 3634 -12.3041 -74.5817 
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N° de 
No Institución Centro Poblado alumnos Altitud Latitud Longitud Educativa nómina de 

matrícula 2013 
17 31034 Rundovilca 41 3263 -12.3249 -74.7814 
18 31035 Matachocco 34 3755 -12.3623 -74.7804 
19 31036 Occoro 56 2742 -12.3492 -74.7298 
20 31037 San Cristobal 49 3278 -12.4222 -74.6842 
21 31038 Llocce 40 2966 -12.3286 -74.6955 
22 31050 S. L. de Estanque 57 3086 -12.3168 -74.7779 
23 31201 Quichuas 188 2753 -12.4728 -74.7673 
24 31202 Suyllocc 75 2976 -12.2879 -74.6505 
25 31203 Poccyacc 85 3496 -12.4721 -74.6501 
26 31234 Ranra 101 3496 -12.3474 -74.7396 
27 31239 Huayllhuaypata 46 3403 -12.4685 -74.7505 
28 31276 S.J. de Chuspi 73 3743 -12.4822 -74.6176 
29 31277 Union Ccano 38 3666 -12.3595 -74.7978 
30 31279 Colea 127 3563 -12.5221 -74.6718 
31 31281 San José 110 3585 -12.4756 -74.7108 
32 31296 Pilcos 56 2498 -12.3981 -74.6564 
33 31315 S.R. de Mallma 110 3377 -12.4931 -74.6891 
34 31329 S.C. Rayan 54 3278 -12.4222 -74.6842 
35 31330 V. de Accoyanca 106 3591 -12.4589 -74.7616 
36 31367 Mutuypata 54 3803 -12.4656 -74.7275 
37 31379 S.M. Putaca 23 3841 -12.4489 -74.6831 
38 31380 San V. de Yanayacu 80 3588 -12.3711 -74.7636 
39 31448 La Florida 140 3637 -12.4778 -74.6968 
40 31473 Tal huís 60 3890 -12.4992 -74.6625 
41 31480 Ninabamba 61 2911 -12.4305 -74.6505 
42 36431 Chachas 86 3439 -12.4273 -74.6196 
43 36448 Buenos Aires 28 3638 -12.4281 -74.7727 
44 36492 Pichi u 98 2056 -12.3406 -74.6309 
45 36531 Los Nogales 48 2805 -12.3986 -74.6829 
46 36559 Salviapampa 20 3312 -12.307 -74.6278 
47 36748 Sachamarca 32 3510 -12.364 -74.737 
48 36765 Miraflores 22 4154 -12.4388 -74.7084 
49 36784 Palea Grande 26 2825 -12.3193 -74.6084 

Fuente: Elaboración propia. 

Está constituido por las 49 instituciones educativas de nivel primario de gestión 

pública como se muestra en la Tabla No 3.1. 

3.6.2. Muestra [3] 

Lo constituyen 43 instituciones educativas de nivel primario del distrito de 

Colcabamba, y se obtuvo de acuerdo a la siguiente fórmula: 
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z2* p2* N 
n=------

e2 (N - 1) + Z 2 * P2 

n =Tamaño de la muestra. 

N= Tamaño de la población (49). 

Z = Nivel de confianza o coeficiente de confianza (1 ,96). 

E = Error de la muestra o error permitido (0,05). 

P= Proporción de unidades que poseen el atributo de interés en la población. 

Se conoce de antecedentes de estudios similares o de lo contrario de un 

estudio piloto (P=0.5). 

Tabla N° 3.2: Muestra los valores que toma Z y E. 

Los valores Z más utilizados y sus niveles de confianza son: 

z 1,15 1,28 1,44 1,65 1,96 2 2,58 

Nivel de 
75% 80% 85% 90% 95% 95,5% 99% 

confianza 

Error (E) 25% 20% 15% 10% 5% 4,5% 1% 

Fuente: Elaboración propia 

3.6.3. Muestreo 

El muestreo será aleatorio simple porque las Instituciones Educativas serán 

seleccionados de tal manera que cada uno tenga igual probabilidad de ser 

seleccionada de la población. Específicamente el muestreo aleatorio es 

sistemático porque las muestras las vamos a tomar de una manera directa y 

ordenada 

3. 7. Técnicas e instrumentos de Recolección de datos 

• Análisis documental de libros y artículos científicos sobre temas relacionados con 

redes de telecomunicación inalámbrico con servicio de internet de banda ancha. 

• Entrevistas a los directores de las Instituciones Educativas de nivel primario del 

distrito de Colcabamba. 
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3.8. Procedimiento de recolección de datos 

3.8.1. Fase de Pre-campo 

Elaboración de formatos para registro de velocidad de acceso en subida y 

bajada. 

3.8.2. Fase de campo 

Observación y registro de velocidad de acceso a Internet. 

3.8.3. Fase de Gabinete 

Procesamiento de la información de campo, análisis de la información y 

presentación de resultados. 

3.9. Técnicas de Procesamiento y Análisis de Datos 

Para procesar los datos del trabajo de investigación haremos uso de las herramientas 

tales como; Word, Excel, Visual Basic, EVIEW, SPSS, que permitirá elaborar cuadros 

estadísticos, regresiones, para probar la hipótesis se hará uso de la prueba t-Student. 

71 



4.1 Presentación de resultados 

CAPITULO IV 

RESULTADOS 

La investigación inicia el 12 de setiembre del 2014 con la toma de datos de las 

velocidades de subida y bajada utilizando el software Nettraffic, y, finaliza el1 O de julio 

de 2015. Cabe mencionar que la instalación de los equipos para la lectura de datos se 

hizo en la l. E. W 31296, cuyos datos se muestran a continuación: 

ítem Descripción 

Nombre lE 31296 

Nivel Primaria 

Dirección Plaza principal s/n 

Centro Poblado Pi leos 

Distrito Colcabamba 

Provincia Tayacaja 

Región Huancavelica 

Ubigeo 090705 

Area Rural 

Teléfono 

E-mail 

Web 

Facebook 

Categoría Escolarizado 
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Profesores Polidocente multigrado 

Género Mixto 

Turno Continuo sólo en la mañana 

Tipo Pública de gestión directa 

Promotor Pública - Sector Educación 

U gel UGEL Tayacaja 

Lengua Madre Quechua 

Estado Activo 

Número de Alumnos 56 

Número de Docentes 5 

Número de Secciones 6 

Número de computadoras 10 

Debido a que contamos con 49 instituciones educativas de nivel primario en la 

microrred de educación del distrito de Colcabamba y debido a que presupuestalmente 

es imposible cubrir las 43 instituciones educativas que pide la fórmula del número de 

muestras para la prueba de hipótesis, en la parte de recomendaciones se sugiere que 

se continúe implementando con el resto de las instituciones educativas para probar la 

hipótesis planteada, los datos obtenidos en el mes de setiembre dela año 2014 sirven 

como datos de pre test, mientras los resultados obtenidos el10 de julio de 2015, vienen 

a constituir los datos del pos test; lógicamente que es posterior a la implementación del 

Sistema de comunicación. 

El sistema de comunicación se ha implementado en la primera semana del mes de julio 

del año 2015, con la finalidad de aumentar la velocidad de conexión y superar la mínima 

requerida por la UIT que es de 256 kbps para ser considerada una conexión de banda 

ancha. 
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4.2. Prueba de hipótesis 
El proceso que permite realizar el contraste de hipótesis requiere ciertos 

procedimientos. Se ha podido verificar los planteamientos de diversos autores y cada 

uno de ellos con sus respectivas características y peculiaridades, motivo por el cual 

era necesario decidir por uno de ellos para ser aplicado en la investigación. 

a) Planteamiento de Hipótesis: 

Hipótesis General Nula: 

Ho : Una red de telecomunicación inalámbrica no provee servicio de Internet de 

banda ancha a las instituciones educativas de nivel primario en la micro red 

del distrito de Colcabamba. 

Hipótesis General Alterna: 

H1 : Una red de telecomunicación inalámbrica provee servicio de Internet de 

banda ancha a las instituciones educativas de nivel primario en la micro red 

del distrito de Colcabamba. 

Hipótesis Específicas Nulas: 

Ho(aJ : La tecnología 802.11 n no provee internet inalámbrico de banda ancha a las 

instituciones educativas de nivel primario de educación básica regular en la 

micro red Colcabamba a una velocidad mayor a 256 kbps. 

Ho(bJ : Mediante los equipos Ubíquiti no se provee internet inalámbrico de banda 

ancha a las instituciones educativas de nivel primario de educación básica 

regular en la micro red Colcabamba con un nivel de ganancia mayor a 90 

dBm. 

Hipótesis Específicas Alternas: 

H1(aJ : La tecnología 802.11 n provee Internet inalámbrico de banda ancha a las 

instituciones educativas de nivel primario de educación básica regular en la 

micro red Colcabamba a una velocidad mayor a 256 kbps. 

H1(bJ: Mediante los equipos Ubíquiti se provee Internet inalámbrico de banda ancha 

a las instituciones educativas de nivel primario de educación básica regular 

en la micro red Colcabamba con un nivel de ganancia mayor a 90 dBm. 
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b) Nivel de significancia o riesgo: 

a=0,05 

gl = n-1; gl = 60-1; gl=59 

En la tabla de distribución t-Student no podemos encontrar el valor crítico para un 

valor de probabilidad de 0.95 y 59 grados de libertad por lo que hacemos uso de 

Excel para obtener este valor a partir de la fórmula INV.T(0.95,59) obtenemos 

entonces el valor crítico de 1.67109303. 

Valor crítico = 1.67109303 

·1.6711 1.6711 

Aceptar Ho si ·1.6711 <te< 1.6711 

Rechazar Ho si te :S ·1.6711 o 1.6711 :S te 

Figura N° 4.1: Prueba de t-Student 

e) Cálculo del estadístico de prueba: 

Prueba de la Hipótesis Específica Nula Ho(a) 

Utilizando el software Microsoft Excel realizamos la prueba t para dos muestras 

suponiendo varianzas desiguales, cuyos resultados se muestran a continuación. 

Comparación de medias de velocidades de bajada a horas 09:00 a.m. 

12/09/2014 10/07/2015 

Media 29.1085333 258.948663 
Varianza 905.179237 6006.56753 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 76 
Estadístico t -21.414482 
P(T <=t) una cola 3.1469E-34 
Valor crítico de t (una cola) 1.66515135 
P(T <=t) dos colas 6.2939E-34 
Valor crítico de t (dos colas) 1.99167261 
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Comparación de medias de velocidades de bajada a horas 10:00 a.m. 

12/09/2014 10/07/2015 

Media 15.8461333 258.76064 
Varianza 1065.63768 2570.46426 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 101 
Estadístico t -31.2040562 
P(T <=t). una cola 5.7152E-54 
Valor crítico de t (una cola) 1.66008063 
P(T <=t) dos colas 1.143E-53 
Valor crítico de t (dos colas) 1.983731 

Comparación de medias de velocidades de bajada a horas 10:30 a.m. 

12/09/2014 10/07/2015 

Media 1.0996 258.502715 
Varianza 8.67951387 5539.39441 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 59 
Estadístico t -26.7681467 
P(T <=t) una cola 5.3353E-35 
Valor crítico de t (una cola)_ 1.67109303 
P(T <=t) dos colas 1.0671E-34 
Valor crítico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 11:00 a.m. 

12/09/2014 10/07/2015 

Media 0.5996 257.754063 
Varianza 0.78474289 5091.74415 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 59 
Estadístico t -27.9127702 
P(T <=t) una cola 5.3891E-36 
Valor crítico de t (una cola) 1.67109303 
P(T <=t) dos colas 1.0778E-35 
Valor crítico de t (dos colas) 2.00099538 
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Comparación de medias de velocidades de bajada a horas 11 :30 a.m. 

12/09/2014 10/07/2015 

Media 0.3796 256.216887 
Varianza 0.08855957 4086.09088 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 59 
Estadístico t -31.0013601 
P(T <=t) una cola 1.6275E-38 
Valor crítico de t (una cola) 1.67109303 
P(T <=t) dos colas 3.255E-38 
Valor crítico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 12:00 m. 

12/09/2014 10/07/2015 

Media 0.6124 256.711333 
Varianza 0.56877868 2000.27609 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 59 
Estadístico t -44.3482703 
P(T <=t) una cola 2.6036E-47 
Valor crítico de t (una cola) 1.67109303 
P(T <=t) dos colas 5.2073E-47 
Valor crítico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 03:00 p.m. 

12/09/2014 10/07/2015 

Media 60.7934267 296.947355 
Varianza 1936.53645 2689.54596 
Observaciones 60 60 
Diferencia hipotética de las medias o 
Grados de libertad 115 
Estadístico t -26.8945398 
P_(T <=t) una cola 9.891E-52 
Valor crítico de t (una cola) 1.65821183 
P(T <=t) dos colas 1.9782E-51 
Valor crítico de t (dos colas) 1.98080754 
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En los siete casos se observa que el estadístico t se encuentra fuera de la región 

de aceptación de la hipótesis nula, por lo que aceptamos como consecuencia la 

hipótesis alterna. 

Prueba de la Hipótesis Específica Nula Ho(b) 

Se puede observar en el radio mobile que los niveles de recepción en las 

instituciones educativas de la microrred de educación de Colcabamba se encuentra 

alrededor de -78.8 dBm, por lo que de manera descriptiva se estaría rechazando la 

hipótesis estadística nula y se aceptaría la hipótesis estadística alternativa. 

Figura No 4.2: Nivel de recepción en radio mobile 

d) Decisión Estadística: 

Como se está rechazando en ambos casos las hipótesis nulas, entonces aceptamos las 

hipótesis alternas. 

e) Conclusión Estadística: 

Se ha demostrado con un nivel de significancia del 5% y la prueba t de Student que la 

implementación de la Red de Telecomunicación Inalámbrico provee servicio de internet de 

banda ancha en las instituciones educativas de nivel primario en la micro red del Distrito de 

Colcabamba a una velocidad mayor a 256 kbps en bajada. 
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DISEÑO DE LA RED DE BANDA ANCHA CON SERVICIO DE INTERNET EN LA MICRO 

RED DE EDUCACIÓN DEL DISTRITO DE COLCABAMBA 

Como primer paso necesitamos conocer el tamaño del mapa donde se va a diseñar la red de 

telecomunicaciones, por lo que según la tabla W 3.1, se puede obseNar que uno de los 

puntos de referencia más alejados estará en la Institución Educativa W 31027 de Quintao y 

corresponde a la coordenada -12.2619 latitud sur y -74.5816 longitud oeste. El otro punto 

corresponde a la Institución Educativa W 31279 de Colea y corresponde a la coordenada-

12.52211atitud sur y -74.79781ongitud oeste, en base a estas coordenadas tomamos el punto 

medio ubicado en las coordenadas -12.392 latitud sur y -74.6897 longitud oeste, se puede 

obseNar que el tamaño del mapa estaría alrededor de 30 Km, en base a estos datos 

configuramos la ventana de propiedades del mapa. 
Propiedades de ~\nuevo.map 

Figura N° 4.3: Configuración del tamaño de mapa 

Haciendo click en extraer obtenemos como resultado el mapa que se muestra a continuación. 
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Seguidamente creamos la red lógica Red_Movi_Muni, con una frecuencia mínima de 

funcionamiento de 4900 MHz y una máxima de 5900 MHz, ya que el rango de frecuencias 

para esta frecuencia libre se encuentra entre 4.940 - 5.875 GHz, los parámetros deben 

configurarse para una conexión punto a punto crítico, así seleccionamos en modo estadístico 

difusión y en el recuadro % de tiempo 99,9, significando esto que estamos asegurando una 

conexión (no se puede caer), en el recuadro de porcentaje de ubicaciones 70, significando .. 
esto que como no es multipunto no queremos que llegue a muchos sitios, y, por último 

porcentaje de situaciones 90, significando esto las situaciones de inclemencias 

climatológicas, por lo que quedaría como se muestra a continuación. 

~~-~:..~ ·:i=':j"'"~:r l ;-JJ .'.' 11 
~~~:~:'..~m :. Pa~h~ 1_ To~ra j -~~0'_ L _"'~~ __ 1 ___ Eotllo __ 1: 

1 

~~ ~ , , ~~==-~~~ Ret,acrrviDM~e ~~=lpo1 ; 

1 E,t ~~(MHz)j>ISOO _ Conduclividaddelsuela(Slm}Jñ0c5 : 

~~n '?::~~:,~~-~~::·:·=m~.: 
~~~~ 1 :: r. Vertical r H~C" Ecuat01ial t ; 
~:m 1 ¡ """'"".d'~rn ____ -~ r Conlinen!aiwb-l•ooicoi 
Red18 1 
~: ~ , /'" lrienla ';de tiempo {99:9 ~ , ("" Mruítimo .ttdYtfopi.:al 1 ¡ 
Red 21 • J : r Accidental %. de ub~Cacic:l~ rro-- , , r Desiefto 
Aed22 r M6Yd 

1 
: 
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Figura No 4.4: Configuración para una conexión punto a punto 

El uso de forma legal en Perú de las frecuencias dentro de las bandas ISM, queda regulado 

por el Ministerio de Transportes y Telecomunicaciones plasmada en la Resolución Ministerial 

W 777-2005-MTC/03, que en la parte de anexos Artículo 3° sobre características técnicas 

de operación inciso a.1) dice "Para las bandas de 902-928 MHz, 2400-2483.5 MHz y 5725-

5850 MHz, la PIRE máxima utilizada no deberá exceder de 36 dBm (4W)". Además en esta 

misma resolución se muestra los parámetros máximos a tener en cuenta para la instalación 

de equipos. 

Tabla No 4.1: Parámetros máximos para la instalación de equipos 

Banda de Potencia de salida del Ganancia máxima PIRE máxima 
frecuencias transmisor de la antena (dBm) 

(M Hz) (W) (mW) (dBm) (dBi) 
902-928 1 1000 30 6 36 

2400-2483.5 0.5 500 27 9 36 
5725-5850 0.25 250 24 12 36 
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5250-5350 0.25 250 24 6 30 
5470-5725 0.125 125 21 9 30 

Fuente: Elaboración propia 

El artículo 1 O hace referencia al ámbito rural y a lugares de preferente interés social, 

autorizando el uso de antenas de mayor ganancia que las previamente establecidas y por lo 

tanto se puede sobrepasar la PIRE de 36 dBm, siempre y cuando se obtenga previamente la 

autorízación correspondiente por parte del Ministerío de Transportes y Telecomunicaciones, 

lo que finalmente nos permite fijar el tipo de sistemas que va a tener la red lógica en este caso 

tenemos tres sistemas: Sistema Transmisor 1W, Repetidor_ Colea y Clientes. 

Par el sistema Transmisor 1 W, elegimos el tipo de antena vigilancia con una ganancia de 30 

dBi porque es la que se ajusta a las características técnicas de la antena que mostramos a 

continuación: 

Antenna Patterns . 
\.'ertical Po ant¡ Hot1Zon1al Polanty 

f~l<!.lle i-l'..Jt¡tl! 1;.'\o.Jtte -'-~· 

Figura N° 4.5: Sistema Transmisor 1W 

Para seleccionar el tipo de antena a utilizarse en este sistema hacemos una comparación de 

los patrones de radiación y el que se asemeja es el de la antena vigilancia, el que se puede 

observar la semejanza de los patrones de radiación de ésta y la antena parabólica ARC­

DA5830SD1. 
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Figura N° 4.6: Patrón de radiación de la antena. 

Los parámetros del sistema Tx_Muni_1W se muestran a continuación, los parámetros 

ingresados son en base a las características que tiene la Municipalidad Distrital de 

Colcabamba, como su Access Point. 

Figura No 4.7: Parámetros del sistema Tx_Muni_1W. 

Para los sistemas Repeti_con_Operad, Clientes y Repeti_sin_Operad, seleccionamos los 

equipos que desempeñarán el rol de repetidor y clientes, tomamos como criterio de selección 

la distancia de puntos de obstrucción, frecuencia de trabajo la que debe permitar trabajar en 

bancha ancha, que de acuerdo a la bibliografía revisada el estándar 803.11 n se ajusta a las 

características solicitadas, la que trabaja en la banda de SGHz, finalmente la fuente de 

alimentación también es importante por lo que de preferencia se elige un equipo que permita 
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trabajar con energía OC directa si es posible para casos críticos en donde no se pueda tener 

acceso a energía AC. 

Tabla N° 4.2: Lista de equipos que desempeñaran rol de repetidor y cliente 

Model Operating Frequency Ethernet Ports 

NanoStation M2 2403-2475 MHz 2 

NanoStation M5 5170-5875 MHz 2 

NanoStation Loco M2 2402-2482 MHz 1 

NanoStation Loco M5 5170-5875 MHz 1 

NanoStation Loco M900 904-926 MHz 1 

Fuente: Elaboración propia 

El modelo NanoStation M5, que trabaja en el rango de frecuencias de 5170-5875 MHz con 

dos puertos Ethernet el mismo que se observa en la figura W 4.8 

1 
/~ 

Jl 
1 

í 

/ 
¡ 1 

;; 1 

Secondary /1 ·-, 1 
Ethernet Port* ----'-----1~ ~-"';¡¡--;,''--; - Maín 

( Ethernet Port 

"Secondary Ethernet , 
Port ínc/uded on Jy on 
NanoStatíon M2 & MS 

Figura N° 4.8: Modelo NanoStation MS 

La estación NS-M5 tiene las siguientes características: 

• Frecuencia de Operación: 4.9-5.8 GHz. 

• Tasa de transferencia: 300 Mbps. 

• Potencia de Transmisión: 500 mW. 

• Ganancia de antena: 16 dBi Integrada. 

• Alcance: Hasta 12 Km con antena integrada. 

• Modos de operación: access point, station y repeater (WDS). 

• Señalización propietaria: AirMAX (MIMO TOMA). 
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• Canal ajustable: 5 a 40 M Hz. 

• Seguridad: WEP, WPA, WPA2 y MAC ACL. 

• Alineación de antenas: visual y audible (software). 

• Temperatura: -30 a 75 oc. 
• Alimentación: 24 Ved, 0.5 A (incluye PoE convencional). 

Clientes 
Repeti_sin_Operad 
Sistema 5 
S~tema 6 
Sistema 7 
Ststemo 8 
Sistema 9 
Sistema 10 
Sistema 11 
Sistema 12 
Sistema i3 
Sistema 14 
S!Slerna 15 
Sistema 15 
SL.."tema 17 
Szs.tema lS 
Sistema 19 
Sistem3 20 
Sistema 21 
Sittema 22 
Sistema 23 
S~·tema 24 
Sistema 25 

~ jseleccíonardesdeVHF ... UHF... iJ 
Nombrede1sm~,--------

PotenciadeiTranS1nOO(W&t~ [dBm) ¡v---
Umb<aldelrecep!OI[pV) ~ [dB~ 1 

Péré!da de~ 11nea {dB} ~ t Ceble+cavidade:.+coneclOfel! } 

Tipodeanten~ ---:3 ~ 
GI!I1;!11Ciadeantena[dB~ [dBd) ~ , 

AiltBadeantena(~(Sobreeltuelo) ----¡ , 
PeJdidaadicionalcable(dB/~(Siloalluradelaanlenadif~ere) _j ; : 

Ag¡e¡¡ar a R.OO.vs dat 1 Remove1 dat Radiosys.dat j , 

Figura N° 4.9: Configuración en el sistema Repetir_con_Operad 

Para el sistema Clientes optamos por elegir los mismos equipos que se van a utilizar en el 

sistema Repetir_con_Operad, por lo que los parámetros quedan configurados como se 

muestra a continuación. 

R~ti_m_Operad 
Sistema 5 
Sistema 6 
Sistema 7 
Ststema 8 
Sistema 9 
Sistema 10 
Sfutema11 
Sistema 12 
Si~erno 13 
Sistema 14 
Sistema 15 
S~temo16 

•' S!!!:tema 17 
Sistema 18 
Sistema 19 
Sistema 20 
Sistema 21 
Sistema 22 
Sistema 23 
Smema 24 
Smema 25 

l' 
1 

1 
j: 

Terpofogia ( Miembro:; J Sistemas { E:tilo 

~ JSeieccíonarde•deVHF .. UHF... _::j '· 

Norubredatsistern~;-------

PO(errciadeiTr~m(Wall~ 
Umb<al del receptot (I'V) 17 0795 

(dBrn)¡v­

(dllrn~ 
Pé1dido do la linea (d!l) ¡o:s--- { Cable•caVJdade••conectore' 1 

TipOdearlen~ iJ ~ , , 
Gonanct.deantena(dB~ (dBd) ~ 

Allura deantena(m~ (Sobre el suelo) -¡ : : 
Pérdida adicional cable (d!l/m~ (Si la <tllura de la antena dil~ae) _j : : 

Ag¡ej¡OJ a Radiosy~dal _ __j Remover del Radio<ys dal _j : 

Figura N° 4.10: Configuración en el sistema Cliente 
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Para el sistema Repeti_sin_Operad optamos también por elegir los mismos equipos que se 

van a utilizar en el sistema Repetir_con_Operad, por lo que los parámetros quedan 

configurados como se muestra a continuación. 

•i 
r-~-· -----P-arám_el_¡os-po-1 .. --~-p;a-tR:;r--. -. -.. -~-ear:,elat ¡¡==O!:=."'I'tl 
1 L~!a de todos los siste"""' defecto . . . -

Tx_Muni_lw ---c:-:--Jj .Eslil ... o -~-~~ 
Repeti_con_Ope1ad Porómet1os 1 T op;¡logía 1 Miembios 1 Sistemas j 
Clientes . ::__! . 
'. :~:íf1i;•f.~v-;•:•?i?i&l · 1 
Sislema 5 r.:::;:---::'l 1 

Sistema 6 ¡00 ..!..! /SeleOOonol desdeVHF ... UHF ... .::] ·•·. ¡· 
Si~ema 7 

/ Sistema S Nombie del sistema /Repet~_<in_Opeiad 

~ ~::::: 1~ : ¡ 
Sistema 11 Poten<:iadeiT!ammisoll\'/alt) ~ (dBm) w- ·.·; ¡· 

1 
Sistema 12 
S1stema 13 UmbiaJdel¡eceptor(~v) 17.079'5 (dBm) ~ 

1
• 

1 Sistema 14 
Sistema 15 ~ 1 Sistema 16 PéuJidadelalinea(dB) ¡0.5 (Cable+C<Mdadeo+conedoles) , , ' 
Sistem<l 17 
Sistema 18 
Siilema 19 
Sistema 20 
Sistema 21 
Si~tema 22 
Sistema 23 
Sistema 24 

Tipo de antena 1 comer.ant 

' Ststema 25 

(dBd)~ '.j 
' 1 

Alura de antena (m) ¡s---- (Sobre el ouelo J ~ ¡· 

, Példidaadicionalcable(dB/m) ¡o-- (Stlaal!uradelaardenaclf~e~e) _j 

Ganancia de Oli!ena (dBi) ¡;-¡¡---

, : _ Agr~aR~ys.dat _l -:_ . Re""":"'_deiRadiosysdat. J ' ¡1 

L ___ ________________ :: -- -~ ... - -- ~..:.._....:.. ___ .:.. ... : _______ ------ --------- ·-:......:...:.. ... :-'] 

Figura N° 4.11 Configuración en el sistema Repetir_sin_Operad 

A continuación ubicamos las unidades de acuerdo a la tabla W 3.1 en el mapa. 

Figura N° 4.12: Ubicación de las unidades en el mapa 

Diseñamos las troncales de acuerdo a la distribución de los puntos de red y la mejor opción 

se muestra en la figura W 4.13 en la que se puede observar la existencia de 04 troncales a 

las que llamaremos troncal NE, troncal NO, troncal SE y troncal SO. 
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Figura N° 4.13: Diseño de las 04 troncales 

Podemos observar que en la troncal NE existe la mayor distancia de separación entre los 

nodos 31296 y 36492, por lo que este criterio nos servirá para elegir las características de los 

equipos que se utilizarán en la etapa de implementación, con el software de simulación 

radiomobile obtenemos la distancia entre los nodos de 6.96 Km. 
-------·--·· 

H 
----~------------~""" 

~$~4 

Figura N° 4.14: Simulación con el software radiomobile 

Podemos observar que existe un punto de obstrucción a 3.81 Km lo que nos obliga a colocar 

una repetidora. Para hacer un estudio más detallado del sector NE seleccionamos la parte 

comprometida tomando como referencias las coordenadas 12°25'45"8 y 74°42'12"0 y 
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12°15'27"8 y 74°33'15"0, como en el caso anterior para determinar el punto medio 

calculamos la media de los puntos extremos, dándonos como resultado la coordenada 

12°20'36"8 y 74°37'43.5"0. 

Figura No 4.15: Ubicación de una repetidora 

Para el tamaño tomamos como referencia las distancia en X=15.57 4 Km y Y=18.430 Km, con 

el que seleccionamos el alto del mapa como 18 Km, con esta información obtenemos el mapa 

y la red del sector NE, como se muestra en la figura W 4.16 

Figura N° 4.16: Mapa y la red del sector NE 

Para establecer la comunicación entre la Municipalidad y la I.E. W 31296 tendremos que 

hacer uso de una repetidora (Repetidor_Colca) que estará ubicado en uno de los cerros en 
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el que está instalado una torre autosoportada de telefónica, la cual cuenta con energía 

eléctrica, los parámetros que se ingresaron se muestra en la figura. 

f 1'1 ·. E~e de R¡¡(jid · ·· _ 
11 Ed<t.r Ver lnwt~ 
11 A...... • AX~- ..... AnQ. oo e~evaci&í-19 5G$;_])Jí;íí0i;,..m.... <1~91 ~·•qjt;lOW 
11 ó<d!da~::.!Jl~ .. !.ÍJ:2...f.""'P'E.s17dBpVImC:7 ,N<veiR""-448Jllli> Nivol >• 5.5WJ __ 

~ 1 

1 -------~:-:~==-~~1 , •........•..... 

1

1
1 Tr~:;or - .... - - ; Aecept01 - - · : 

f ¡;::;¿;¡ ..._, ........ ¡;:;;¿;t:=~~ ~ ~- S9+20 ;;¡.........,¡;:;:;:;¡l:ó<.oollm~;:o;:;::;'"'""""z:;:;;;~.__,.¡-- S9f.l0: 

1 ' jMunicqlaidad ::J ¡: jAep_Colca ::J 
¡: Rol Master i , Rol E sclovo : 

1
: Nombre deildema h jr'""'""'"' 1W ::J i' tlombre del•ístema A• jRepebdor_Colca iJ ' 

l
·. Polenaa T • 1 W 30 dBm :. ~ Campo E requerido 61.36 dBpV/m 

1 
Péráidadelínea 0.5dB J Ganaodadeanleno 15dBi 13.BdBd ..:J 
Ganandadeantene 30dBi 27.Bd8d .. :J 11 Pérdida delinea 0.5á8 
Palencia radiada PIAEcll9125 W PRE•543.45W 1 Senililidad R• 39.8107~V ·75 dBm 

r Altura de antena {m) ¡g---- _j ..:J ·-~ i : Altura de antena (m) 115- -:-:J ..:J -.-·· _· _· J : 
j: R~d · ·:. · ... . • . ~ Fre~ ~~Hz!· 
1· línter_colca_ba_NE ------:=¡ i i Minino '""'j4900::;:--

l: .. ' . 
=== 

Máximo \5900 

Figura N° 4.17: Parámetros de enlace de radio 

Ejecutando la conexión entre los puntos observamos que se establece la conexión con un 

nivel de recepción de -44.6 dBm, la cual es bastante aceptable ya que el nivel de 

sensibilización en recepción esta alrededor de -75 dBm, la primera zona de Fresnel de 

1 0.4F1, lo que nos indica que estamos asegurando la comunicación ya que el mínimo debe 

ser de 0.8F1. El cálculo de pérdida básica de transmisión en espacio libre de acuerdo a la 

recomendación UIT-R P.525-2 se realiza con la siguiente fórmula: 

Lbr(dB) = 32.4 + 20 log(f(MHz)) + 20log(d(Km)) 

Lbr(dB) = 32.4 + 20 log(5745) + 20log(0.61) 

Lbf(dB) = 103.29 

La cual coincide con la pérdida en espacio libre estimado por el software Radiomobile, 

además que se muestra la pérdida de propagación total como se muestra a continuación 
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----------
T•T Enlace de Radio 

fd•t:ar LF.r lrr:-e-'1!! 
La á<t""""··--ontre-:-:-M;-~..,-. T'· ..,._..,..v"l1.-ep-_'Cotca,--.,--,o"'.s""k-m=¡o.¡•-mm.,-,•J-----
Azimu! rote verdadero • 275 43'. Alirrú Norte Mo~ • 279.36'. í>ng.ic de elev.ociOO ·19.56Sif 
Vo<iaciOO de ol1iudde213.em 
El modo de propo¡¡oción es línea de v"rst!!.,mírimo ¡Je,peje 10.4F1 aO.SI<m 
Lo frecue · 
Espoclo TR, Urbooo • Q.Odll. 6o>Q<Ae •O.Odll. Et!a<li•nco< •15.5dll 
Lapé¡di:la 
G"""""adelsotomade M • Coleo .,.de 1500 dlll vigilanciaont a 27M' gonancia•ll.Odlll 
~. deltis!emo de Re¡¡_Cclca o Mtri:¡poida<! .. de 1620 dll [ CO!T\OI.OI'ltoSS.4· ~•·16.0 dll) 
P""' recepción es 30.4 dfl :obre el seMI req>erid.> e onconlra< 
99.500~ de liefflllO. 70,(1))1;: de ubio~. SO~ de.<uacione• 
Adveltencia 4 

Transmisor·- "ReceptO! 
~----- --------- so ,' , ____________ so 

: r-¡M-:-"""-ipalid...,.,-ad-------------,3: jRep_Colca 

, Rol Master Rol Es.clavo 

Nombre del ~i;tema h 1 T rati:~mf¡or 1\V iJ ; Nombre del fistema RlC (Repetidor_ Colea 

61 3Sdll~V/m 
16 dBi 

::J. 
Potencia TK 
Pérdida de línea 

~ Ganencia de antena 
Potencia radiada 

1 'W 30 dBm Campo E re<¡Uerido 
0.5 d8 Ganancia de antena 
30 d6i 27.8 dBd _:j : Pérdida de línea 
PIAEoll91.25'W PREo54345W 5et'ISibiü!adRx 

13.BdBd _:j 
0.5 dB 
39B107~V ·75 dBm 

· Altura de afllena (m) ¡g- _j •_1 ____ -'''-. _J,: ~ltAadeantena(m) ~- ..J _;_] ___::::__· _¡ ' 
-Red ., rFreruencia(MHz)· 

, linte~_colca_ba_NE 3 :! Mínimo J4soo 

Figura No 4.18: Perdida en espacio libre 

Seguidamente establecemos la comunicación entre Repetidor_Colca 

Repetidor_Colca_31296, la ventana de simulación se muestra a continuación. 

T11 Enlace de Radio 

Ttansmisol - -- , Receptor . rm-....w:T._ __ .... ________ ~ 52 r--=-_......, ... ,...... _ _. .. ¡,¡¡¡¡¡¡¡-~.,¡;¡¡¡.-¡¡¡¡¡-¡¡¡¡¡¡¡--_.- S2 

jRep_Colca ~ :, jRep_Colca_312$ •:J' 
Rol M astes Rol Esclavo 

! Hombre del sistema T x jReo"l!dOI_Colca ~ Nombre del si>lema Rx jRepetidor_Colca 
Potet\Cla Tx 0.5W 2699dllm , Campo E <equerido 61.36 dB~V/m 

' Pérdida de línea 0.5dB 
.,!.]: 

Ganancia de antena 16 dBi 13.8dBd 
Ganancs~ do antena 16 dilo 13.Sdfld Példrla de línea 0.5dll 
Po!eooa r,adiada PIRE:17.74 'W PRE•10.82W Sensibilidad Rx 39.8107~V ·75dBm 

' Altura de antena (m) ~_j_;j 1 : : Altura~ antena (m) [15--- ..J _;_] 
Red- - Freruencio (M Hz)-

· 1 rnter_colca_ba_NE 3 t-1ínimo j4900 MáMirno j5SOO 

Figura N° 4.19: Enlace de radio 

y 

Ahora establecemos la conexión entre Repetidor_Colca_31296 y la I.E.W 31296, la misma 

que se muestra a continuación. 
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lit: ' . ; ' ' t!ltae~ tle lGdiO ,; ,. "' 
~~~ 1 
Azirout•84. • Ang. de e~Jactón•-2110 3'' espe¡e a . m Pec< Fre:Ml·1l5fl Dt;tancia-1.4 .m 1 

Pérdidas=1253d8 ___ ~ E•B90@~~-~~.!?-.. _t:i'.~"'J:'.~.':.~Y---~e!...~?"~--~ 

·Transmisor"" - ··· ~ · ----· -·· · ~-- · -- ------- · ~ . .., :·Receptot 
¡1.-.a.-r __________ 54 !:"'_...,..., ............. ¡¡;¡¡-;;_¡;;;¡;;_;¡¡¡¡¡-;_;;¡;¡" __ ...., ....... ____ 54 ' 

i jRep_Colca_312S6 3): ~'"J!II!M ' p · 3: 
: Rol Ma<ter , : Rol Esct.ovo ! 
: Nomb!e del sistema h jRepetidor_Colca 3 \ , Nombre del<i>lema A• J Cientes iJ : 
:Potenciar. 0.5W 26.99d8m ·Campo E requerido 61.36dB~V/m 
'Pérdida de línea 05dB 1, Ganancia de antena 16dBi 13.8dBd ..!J _:j 
! Ganaociadeantena lSdBi 11BdBd ~ 1: Pérdidadelíoea O.SdB 
: Potencia radiado PIRE•17.74 W PRE=10.82W : : Sensibifidad A• 39.8107~V ·75 dBm r 

;Akutadeante~;a{m) ~ _j~ ¡,, .. ¡;;Aituradeantena(m) ~ _:j~ ·,_;,'Ji! 
L ·- -· ---·-·-· --- ___ _.. __ - --- -- - - •- -. -~ -- -- • -· . --··-· - -- .. -· - -- •• ~ -· ·-

--~ :· Frecuencia(MHz)------------

: linter_colca_ba_NE 3·: 
\ ~ 

Mfnimo [4900 __ _ 
Máximo j5900 

.. ·-' t_ 

============~=~~=-============-~=-============~ 

Figura No 4.20: Conexión de enlace de radio 

Al establecer las conexiones en toda la zona NE la red WIFI queda como se muestra a 

continuación. 

Figura N° 4.21: Conexión de la zona NE 
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La velocidad por si sola no refleja la calidad de la conexión. De poco sirve que de forma 

puntual la conexión alcance valores de transferencia muy altos si el resto del tiempo la 

velocidad es inferior. 

Una vez conocida la mejor velocidad que es capaz de alcanzar la conexión, la gráfica de 

velocidad es un elemento indispensable para entender el rendimiento real de la conexión. 

Grandes fluctuaciones y saltos reflejan una conexión de mala calidad con una baja velocidad 

absoluta, mientras que variaciones suaves indican una conexión estable y una velocidad 

media más cerca a la máxima sostenible. 

A continuación se muestra las gráficas de velocidad de bajada registradas el día 11 de julio 

de 2015 a diferentes horas. 

Gráfica de velocidad de bajada 
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Seguidamente mostramos las gráficas de velocidad de subida el mismo día 11 de julio de 

2015 a las mismas horas que se registró la velocidad de subida. 
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Tabla N° 4.3: Datos registrados por el software Nettraffic 

09:30a.m. 10:00 a.m. 10:30 a.m. 11:00 a.m. 11:30 a.m. 12:00 m 03:00p.m. 
t 

Down Up Down Up Down Up Down Up Down Up Down Up Down Up 
(s) 

(kbps) (kbps) (kbps) (kbps} (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps} (kbps) 
' 1 140.2560 13.0325 175.4580 17.3265 80.3650 2.3650 100.3250 15.3260 120.3260 13.3250 160.3265 31.2600 180.2659 2.3260 

2 260.1400 13.0147 177.7200 28.3265 68.3265 6.3250 130.2540 12.3265 100.2658 50.2650 254.3650 2.3260 180.2540 50.2600 

3 600.2510 15.0325 180.7650 33.1255 110.3250 4.2550 160.3250 16.3250 135.3650 2.3260 248.3650 3.3250 198.3650 2.3260 

4 210.0000 12.0214 192.4064 10.3650 126.3250 26.3250 150.2600 49.3265 100.2650 10.3600 123.2540 49.2550 210.2658 3.3265 

5 220.5100 13.0214 180.5140 5.3265 168.3250 36.3250 200.3650 12.2650 210.3650 2.3260 196.3250 16.2500 192.2658 1.3250 

6 140.5240 16.0214 210.6800 26.3254 179.3258 50.2540 150.3260 14.2500 260.3250 6.3254 240.3650 15.2540 200.3650 3.3254 

7 340.2560 12.0214 225.0646 29.3250 215.3000 26.3250 160.3250 26.3250 256.2140 10.3250 190.3250 13.2400 220.3658 4.3265 

8 210.6100 13.0214 210.9246 11.3260 260.3250 36.2540 180.2500 10.0320 254.5870 10.3250 189.3250 3.3260 250.3659 50.2600 

9 260.2100 14.0215 230.8710 47.3265 210.2140 15.3250 200.3200 9.3260 260.3258 6.3250 210.3250 5.3250 280.3260 6.3254 

10 420.5100 16.0214 220.7640 50.3600 190.3250 26.3250 176.3250 2.3650 216.3250 10.2470 222.3650 0.0000 240.2500 4.3254 

11 160.2540 13.0214 231.0800 46.3250 264.3250 19.3250 189.1480 15.3250 210.3658 5.3260 265.3250 13.2500 200.3620 6.3254 

12 148.5100 13.2000 218.8720 20.3250 270.1580 2.3250 199.1470 6.3250 209.6587 4.2514 210.1480 34.3650 260.3250 2.3254 

13 156.2540 26.3250 274.4740 26.3250 190.3250 3.3250 200.1460 47.2650 300.2580 6.3250 249.3650 49.3250 290.3250 4.3658 

14 116.5240 14.0215 220.4560 10.0325 250.3690 0.0000 240.1680 26.3250 210.3650 1.2500 250.3260 26.2540 300.1570 6.3254 

15 180.6580 16.3254 275.9280 8.3260 278.1540 15.3250 275.1480 12.3250 210.2540 26.3250 288.3650 17.2540 290.3650 50.2600 

16 159.2400 13.2140 270.5460 26.3250 210.0210 19.3250 298.7590 10.2510 210.6987 13.3250 297.1570 11.0210 320.3650 3.3255 

17 142.6580 10.0215 225.7460 13.2500 190.3250 41.2540 310.4870 7.3265 220.4890 2.0214 246.9850 6.2140 330.2140 2.3260 

18 210.2540 16.3250 271.2540 10.2360 187.3650 12.3250 199.4760 9.3650 230.9870 14.3260 297.7700 1.3250 340.3620 4.3265 

19 198.2730 14.0215 225.6980 11.0320 190.2540 51.3500 245.1570 8.3250 230.4150 10.2500 196.3640 2.3250 290.2540 6.3254 

20 210.5418 19.3650 271.6580 19.0214 248.3680 55.3600 368.1540 9.4800 180.6580 3.3260 265.3980 7.3250 300.2690 3.3250 

21 240.6580 21.3650 225.9600 18.0365 268.3680 12.3250 341.2680 9.4800 315.2540 5.3480 278.8800 9.3250 350.2610 4.3265 

22 220.1400 27.3652 175.9280 6.3254 279.2540 9.6280 368.1250 10.3250 216.2547 2.1547 296.1450 2.3250 360.2540 6.3250 
__ L_ -------- ____ L_ --- --- -~-- ----- --- --- -------- ------- ------·-----
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t 
09:30a.m. 10:00 a.m. 10:30 a.m. 11:00 a.m. 11:30 a.m. 12:00 m 03:00p.m. 

(s) 
Down Up Down Up Down Up Down Up Down Up Down Up Down Up 

(kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) 
i 23 260.2410 26.3240 200.2450 19.3254 300.1547 4.3260 287.2500 6.3250 300.5900 6.3250 300.6987 1.3250 310.0250 4.2540 

1 24 210.6584 24.0215 225.6000 24.2650 310.2680 3.3250 291.2540 9.6580 248.3600 4.3250 349.6870 48.3650 300.4870 50.2600 
. 25 180.2540 26.0321 250.7440 29.3650 320.3250 0.0000 359.1540 4.3250 236.5214 2.3260 379.6590 2.3260 290.3658 6.3254 
i 

! 26 230.6980 21.3650 275.4250 38.0214 310.6900 19.2600 248.6580 39.3250 200.1478 48.3652 249.2500 2.3650 360.1540 8.3254 

27 260.1470 20.3650 300.0166 12.0325 330.3658 45.3260 379.5400 25.0000 190.6587 10.0320 220.1400 3.3250 350.2545 1.3250 

28 280.1490 27.3650 325.8642 4.2365 290.1470 12.3260 199.6580 12.3250 200.5400 2.3650 211.0100 4.3268 310.2650 0.0000 

29 280.1400 29.3265 350.7680 2.3265 268.3650 8.3260 246.9860 8.3265 210.2650 6.3265 263.0254 23.3250 370.2650 6.3254 

30 290.2410 16.3250 375.7820 19.3260 27.1547 0.0000 298.4850 6.3250 210.2580 26.3250 278.3650 16.3240 340.2640 4.3254 

31 300.1470 15.3240 233.8100 30.3240 290.3250 16.3250 246.5980 2.3250 240.3600 14.3260 248.3650 49.3250 365.2140 6.3254 

32 270.1500 16.3250 245.6090 49.3265 300.1400 48.3260 310.2540 0.0000 260.9800 26.3250 298.6800 53.3240 300.2140 4.3254 

33 250.3680 14.2650 234.5200 46.1470 310.0254 2.3650 300.5960 2.3650 210.5980 2.3250 269.3260 2.3650 300.1570 0.0000 

34 290.2540 18.3260 243.9680 24.1580 268.2654 15.3260 326.2140 48.3250 210.6580 4.3260 278.3650 14.2500 300.2600 3.3265 

35 300.2140 17.3650 200.4600 36.1480 260.2540 19.2650 389.6580 14.2500 290.6580 6.3250 248.3680 10.0210 310.3260 1.3250 

36 310.2541 16.3240 240.6500 15.1400 240.3650 26.3240 278.6590 6.3250 300.1480 16.3254 279.3640 2.3250 290.2140 4.3265 

37 330.2680 19.3240 235.4860 16.3250 290.3254 34.3268 379.1540 4.3250 310.5698 26.3254 249.3260 8.3250 280.3369 50.2600 

38 320.2000 13.3250 241.8450 10.0210 300.1540 26.3250 168.6598 3.3250 386.1500 49.3265 279.3680 1.3250 300.4870 6.3254 

39 330.2140 26.3250 242.6500 45.3025 340.2360 13.3280 266.2680 4.3658 250.3690 47.2640 246.3210 1.4870 360.2540 8.3265 

40 310.2540 27.3650 248.5200 13.3250 362.3250 2.3290 300.1480 38.3250 290.6580 4.3265 279.3240 0.0000 310.2547 4.3265 

41 300.2550 29.3254 246.2500 2.3650 210.2140 0.0000 301.2650 2.3650 285.3265 6.3260 249.3250 43.3250 360.1480 10.3265 

42 310.2541 21.2360 240.5100 49.3658 260.3250 16.3250 298.6590 0.0000 300.2547 1.3254 218.3650 51.3250 330.1470 12.3250 

43 290.2410 22.2365 245.8400 46.3250 235.1540 0.3000 299.3690 1.2540 310.3658 8.3265 310.2500 12.3650 310.2658 8.3265 

44 380.2540 31.3650 235.6800 23.3254 258.3690 16.3250 300.1480 3.3250 316.2540 14.3658 320.3500 10.3600 300.1470 4.3265 

45 270.2541 34.3690 295.6900 48.6590 270.3625 16.3258 248.3650 49.2540 346.2150 16.3254 248.2650 3.3250 290.5980 9.3254 

46 290.0254 37.3265 310.5100 46.3250 296.3250 19.3258 256.1470 3.3250 389.6580 19.3254 346.3250 1.2500 340.1570 10.3254 

47 300.0000 34.2158 270.5000 11.0214 289.2140 46.3250 260.6580 5.3260 268.6500 11.3254 310.3600 16.2500 310.3600 6.3254 
---- ---- - - --- -- --- ------ --· ------ -- -- --
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09:30a.m. 10:00 a.m. 10:30 a.m. 11:00 a.m. 11:30 a.m. 12:00 m 03:00p.m. 
t 

(s) 
Down Up Down Up Down Up Down Up Down Up Down Up Down Up 
(kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) (kbps) 

48 310.2140 36.1780 320.1400 1.3260 300.2148 19.3250 246.3250 7.6500 290.3600 16.3254 298.3250 42.3250 298.4700 4.3265 

49 290.2541 37.2160 290.5200 36.2540 350.3250 26.3250 247.6580 1.2550 250.3690 19.3254 268.3210 32.3250 274.3650 6.3254 

50 310.0215 36.1580 285.6800 45.3264 310.3254 2.3260 240.3600 9.3250 300.2150 16.3254 249.3299 35.2410 300.1570 4.2540 

51 220.1452 34.2540 270.5040 49.3268 341.3650 4.3260 195.3680 2.3650 312.2650 48.3247 248.3200 16.3250 360.1547 2.3654 

52 210.2543 21.0355 300.4510 12.3260 368.3260 16.3250 149.3250 4.3250 348.0100 50.3650 241.3260 2.3650 340.1580 50.2600 

53 230.2547 26.3250 350.4180 16.3254 348.2540 16.2540 147.3250 9.3250 360.6580 12.3260 220.3250 4.3250 341.3650 3.3260 

54 210.5200 20.0214 320.4100 17.3250 210.0325 12.5800 265.3690 2.3200 340.2690 5.3265 246.3260 2.3258 383.1540 4.3650 

55 220.6520 19.3254 350.1000 16.3251 290.3250 1.3250 298.6580 4.3250 310.2000 4.3250 278.2540 4.3250 364.2147 6.3240 

56 260.2540 15.3254 300.5120 48.3260 269.3250 0.0000 300.1480 7.0250 320.3250 6.3254 240.3650 9.3250 311.2640 1.3254 

57 290.2541 36.3254 330.6040 49.3654 365.3250 2.3250 326.5900 49.3250 350.1570 29.3254 278.3250 19.3250 314.3690 3.3265 

58 300.2540 39.2480 300.6100 19.3265 300.3650 0.0000 336.5900 2.4000 259.3200 15.3240 199.3260 43.2500 210.3580 4.3254 

59 310.0000 18.3254 370.5290 14.3600 310.3650 16.2500 369.3250 1.2500 257.2650 16.3250 245.3600 14.2500 260.3250 6.3254 

60 280.4750 30.3254 325.4500 16.3254 369.3240 19.2540 256.1400 6.3250 248.3650 46.3254 279.3265 2.3250 280.2640 2.3254 

X 258.9487 21.6222 258.7606 24.6572 258.5027 17.0103 257.7541 12.4598 256.2169 14.7258 256.7113 15.5088 296.9474 9.3079 
-- -- --- -- --------- - -- ---- --- -- ··- ~- ~ ~- - ~- --

Fuente: Elaboración propia 

En la tabla N°4.3 podemos observar que la máxima velocidad de bajada 296.9474 kbps se da a las 03:00p.m. estando relacionado a que en este horario no se realizan 

labores académicas en la institución educativa. 

Por el contrario la mínima velocidad de subida 256.2169 kbps se da a las 11:30 a.m. dándonos a entender que a esta hora se hace uso de todos los recursos con que 

cuenta el centro de cómputo de la institución educativa. 
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CONCLUSIONES 

1. En la presente investigación se ha demostrado con un nivel de significancia del 5% y la 

prueba t de Student que la implementación de la red de telecomunicación inalámbrico 

con servicio de intemet de banda ancha para las instituciones educativas de nivel 

primario en la micro red del distrito de Colcabamba, eleva significativamente la tasa de 

transferencia de bajada hasta 296.9474 kbps y en subida hasta 24.6572 kbps. 

2. El nivel de ganancia en recepción en la red de telecomunicación inalámbrico con servicio 

de intemet de banda ancha para las instituciones educativas de nivel primario en la micro 

red del distrito de Colcabamba, es superior a 90 dBm. 

3. La polarización vertical es más adecuada para la geografía que presenta el distrito de 

Colcabamba, por ser esta un poco más inmune a las precipitaciones pluviales que se 

presentan durante el año. 
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RECOMENDACIONES 

1. Se recomienda seguir implementando la red de telecomunicación inalámbrico, con 

servicio de Internet de banda ancha para el resto de las instituciones educativas en la 

provincia de Tayacaja, ya que es una buena alternativa para poder llevar Internet a 

puntos alejados de nuestra región. 

2. Usar este modelo como referencia para alcanzar los objetivos del Estado a través del 

proyecto de banda ancha y la troncal de fibra óptica, ya que la tecnología 802.11 n 

supera por mucho la velocidad mínima de 256 kbps de una conexión banda ancha. 
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COLCABAMBA" 

"TELECOMMUNICATIONS NETWORK WIRELESS WITH INTERNET SERVICE OF WIDE 
BAND FOR THE EDUCATIONAL INSTITUTIONS OF PRIMARY LEVEL IN THE MICRO 

NETWORK OF THE DISTRICT OF COLCABAMBA" 

Raúl De la Cruz Hidalgo, Jhonatan Frank Leiva Rojas 

Universidad Nacional de Huancavelica Facultad de Ingeniería Electrónica- Sistemas, 
Escuela Profesional de Ingeniería Electrónica 

RESUMEN 

El estudio realizado corresponde a una investigación de carácter cuantitativo teniendo como 
problema que originó la investigación: ¿Cómo realizar una red de telecomunicación 
inalámbrica con servicio de intemet de banda ancha para las instituciones educativas de nivel 
primario en la micro red del distrito de Colcabamba?, para solucionar el problema se planteó 
el siguiente objetivo: Determinar la red de telecomunicaciones inalámbrico con servicio de 
intemet de banda ancha para las instituciones educativas de nivel primario en la micro red del 
distrito de Colcabamba. La hipótesis planteada como solución al problema fue: Una red de 
telecomunicación inalámbrica provee servicio de internet de banda ancha a las instituciones 
educativas de nivel primario en la micro red del distrito de Colcabamba. El tipo de 
investigación a la que pertenece esta investigación es aplicada, con un nivel explicativo y el 
diseño de investigación es cuasi experimental de un grupo, el método de investigación 
utilizado fue el experimental. Para la medición de las velocidades de subida y bajada 
utilizamos el software Nettrafic, para la prueba de hipótesis se ha considerado el uso de la 
estadística inferencia! de la T de Student de los datos obtenidos con la finalidad de tener 
mayor rigurosidad en la prueba de la hipótesis. Se ha demostrado con un nivel de significancia 
del 5%, el cual se contrastó con el aplicativo que está a disposición del público de la empresa 
de telecomunicaciones Movistar, el estudio tiene una población de 49 instituciones educativas 
de nivel primario y la recolección de datos se hizo en la institución educativa 31296 del Centro 
Poblado de Píleos en el Distrito de Colcabamba, con una población estudiantil de 56 niños, 
antes de la investigación la velocidad de bajada del servicio de internet con la tecnología 
VSAT alcanzó un máximo de 60.7934 kbps y un mínimo de 0.3796 kbps, al implementarse la 
red con la tecnología WiFi 802.11 n y con los equipos de Ubiquiti se alcanzó tasas de 
transferencia mayor a 256 kbps, con lo que se puede asegurar que el servicio de internet es 
de banda ancha, tal como lo define la ITU, cuando fija los niveles mínimos de transferencia 
de datos para bajada en servicios de internet de banda ancha. 

Palabras claves: 

Banda ancha, Estándar 802.11 n, WiFi, tasa de transferencia. 
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ABSTRACT 

The realizad study corresponds to an investigation of quantitative character having like 
problem that caused the investigation: How to realiza a wireless telecommunications network 
with Internet service of wide band for the educational institutions of primary level in the micro 
network ofthe district of Colcabamba?, to salve the problem the following target appeared: To 
determine the telecommunications network wireless with Internet service ofwide band for the 
educational institutions of primary level in the micro network of the district of Colcabamba. The 
hypothesis raised like solution to the problem was: A wireless telecommunications network 
provides Internet service of wide band to the educational institutions of primary level in the 
micro network of the district of Colcabamba. The type of investigation to which this 
investigation belongs is applied, atan explanatory leve! and the design of investigation it is 
quasi experimental of a group, the used investigation method was the experimental one. For 
the measurement of the speeds of increase and lowered we use the software Nettrafic, for the 
hypothesis test there has been considerad to be the use of the statistics inferencia! the T of 
Student of the information obtained for the purpose of having majar rigorousness in the test of 
the hypothesis. lt has been demonstrated at a level of significancia of 5 %, which was 
confirmad by the aplicativo that is at the disposal of the public of the company of 
telecommunications Movistar, the study has a population of 49 educational institutions of 
primary level and the information compilation did to itself in the educational institution 31296 
of the Center Filled with Píleos in the District of Colcabamba, with a student population of 56 
children, befare the investigation the speed of descent of the Internet service with the 
technology VSAT reached a maximum of 60.7934 kbps and a mínimum of 0.3796 kbps, after 
the network was implementad with the technology WiFi 802.11 n and with the teams of Ubiquiti 
there were reached valuations of transference bigger than 256 kbps, with what it is possible 
to assure that the Internet service is of wide band, as the ITU defines it, when it fixes the 
minimallevels of transference of information for descent in Internet services of wide band. 

Keywords: 

Wide, Standard band 802.11 n, WiFi, valuation of transference. 

INTRODUCCIÓN 

Con el desarrollo de la investigación, en su etapa de formulación del problema y la 
demostración de la hipótesis, se ha llegado a demostrar que al implementarse la red con la 
tecnología WiFi 802.11 n y con los equipos de Ubiquiti se alcanzó tasas de transferencia 
mayor a 256 kbps, con lo que se puede asegurar que el servicio de internet es de banda 
ancha, tal como lo define la ITU, cuando fija los niveles mínimos de transferencia de datos 
para bajada en servicios de internet de banda ancha. 

MATERIAL Y MÉTODOS 

En el desarrollo del trabajo se ha utilizado diversos materiales entre los más resaltantes 
tenemos: los equipos de Ubiquití, Se empleó el método experimental, para la medición de las 
velocidades de subida y bajada utilizamos el software Nettrafic. 
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RESULTADOS 

El sistema de comunicación se ha implementado en la primera semana del mes de julio del 
año 2015, con la finalidad de aumentar la velocidad de conexión y superar la mínima requerida 
por la UIT que es de 256 kbps para ser considerada una conexión de banda ancha. 

Los datos obtenidos en el mes de setiembre dela año 2014 sirven como datos de pre test, 
mientras los resultados obtenidos el10 de julio de 2015, vienen a constituir los datos del pos 
test; lógicamente que es posterior a la implementación del Sistema de comunicación, como 
se muestra en los siguientes cuadros: 

Comparación de medias de velocidades de bajada a horas 09:00 a.m. 

12/09/2014 10/07/2015 

Media 29.1085333 258.948663 

Varianza 905.179237 6006.56753 

Observaciones 60 60 

Diferencia hipotética de las 
medias o 

Grados de libertad 76 

Estadístico t -21.414482 

P(T <=t) una cola 3.1469E-34 

Valor crítico de t (una cola) 1.66515135 

P(T <=t) dos colas 6.2939E-34 

Valor crítico de t (dos colas) 1.99167261 

Comparación de medias de velocidades de bajada a horas 10:00 a.m. 

12/09/2014 10/07/2015 

Media 15.8461333 258.76064 

Varianza 1065.63768 2570.46426 

Observaciones 60 60 

Diferencia hipotética de las 
medias o 

Grados de libertad 101 
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Estadístico t -31.2040562 

P(T <=t) una cola 5.7152E-54 

Valor crítico de t (una cola) 1.66008063 

P(T <=t) dos colas 1.143E-53 

Valor crítico de t (dos colas) 1.983731 

Comparación de medias de velocidades de bajada a horas 10:30 a.m. 

12/09/2014 10/07/2015 

Media 1.0996 258.502715 

Varianza 8.67951387 5539.39441 

Observaciones 60 60 

Diferencia hipotética de las 
medias o 

Grados de libertad 59 

Estadístico t -26.7681467 

P(T <=t) una cola 5.3353E-35 

Valor crítico de t (una cola) 1.67109303 

P(T <=t} dos colas 1.0671E-34 

Valor crítico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 11:00 a.m. 

12/09/2014 10/07/2015 

Media 0.5996 257.754063 

Varianza 0.78474289 5091.74415 

Observaciones 60 60 

Diferencia hipotética de las 
medias o 
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Grados de libertad 59 

Estadístico t -27.9127702 

P(T <=t) una cola 5.3891E-36 

Valor crítico de t (una cola) 1.67109303 

P(T <=t) dos colas 1.0778E-35 

Valor crítico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 11:30 a.m. 

12/09/2014 10/07/2015 

Media 0.3796 256.216887 

Varianza 0.08855957 4086.09088 

Observaciones 60 60 

Diferencia hipotética de las 
medias o 
Grados de libertad 59 

Estadístico t -31.0013601 

P(T <=t) una cola 1.6275E-38 

Valor crítico de t (una cola) 1.67109303 

P(T <=t) dos colas 3.255E-38 

Valor critico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 12:00 m. 

12/09/2014 10/07/2015 

Media 0.6124 256.711333 

Varianza 0.56877868 2000.27609 

Observaciones 60 60 
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Diferencia hipotética de las 
medias o 

Grados de libertad 59 

Estadístico t -44.3482703 

P(T <=t) una cola 2.6036E-47 

Valor crítico de t (una cola) 1.67109303 

P(T <=t) dos colas 5.2073E-47 

Valor crítico de t (dos colas) 2.00099538 

Comparación de medias de velocidades de bajada a horas 03:00 p.m. 

12/09/2014 10/07/2015 

Media 60.7934267 296.947355 

Varianza 1936.53645 2689.54596 

Observaciones 60 60 

Diferencia hipotética de las 
medias o 

Grados de libertad 115 

Estadístico t -26.8945398 

P(T <=t) una cola 9.891E-52 

Valor crítico de t (una cola) 1.65821183 

P(T <=t) dos colas 1.9782E-51 

Valor crítico de t (dos colas) 1.98080754 
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CONCLUSIÓN: 

• En la presente investigación se ha demostrado con un nivel de significancia del 5o/o y la prueba 

t de Student que la implementación de la red de telecomunicación inalámbrico con servicio 

de intemet de banda ancha para las instituciones educativas de nivel primario en la micro red 

del distrito de Colcabamba, eleva significativamente la tasa de transferencia de bajada hasta 

296.9474 kbps y en subida hasta 24.6572 kbps. 

• El nivel de ganancia en recepción en la red de telecomunicación inalámbrico con servicio de 

intemet de banda ancha para las instituciones educativas de nivel primario en la micro red del 

distrito de Colcabamba, es superior a 90 dBm. 

• La polarización vertical es más adecuada para la geografía que presenta el distrito de 

Colcabamba, por ser esta un poco más inmune a las precipitaciones pluviales que se 

presentan durante el año. 
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a) 

b) 

TITULO: "RED DE TELECOMUNICACIÓN INALÁMBRICO CON SERVICIO DE INTERNET DE BANDA ANCHA PARA LAS INSTITUCIONES EDUCATIVAS DE NIVEL 

PRIMARIO EN LA MICRO RED DEL DISTRITO DE COLCABAMBA" 

PROBLEMA 

PG: ¿Cómo realizar una red de 

telecomunicación inalámbrica con servicio 

de interne! de banda ancha para las 

instituciones educativas de nivel primario en 

la micro red del distrito de Colcabamba? 

PE: 

¿Qué tecnología se utiliza para proveer 

interne! inalámbrico de banda ancha a las 

instituciones educativas de nivel primario 

de educación básica regular en la micro 

red Colcabamba? 

¿Qué equipos se utilizan para proveer 

interne! inalámbrico de banda ancha a las 

Instituciones educativas de nivel primario 

de educación básica regular en la micro 

red Colcabamba? 

OBJETIVOS 

OG: Determinar la red de 

telecomunicaciones inalámbrico con 

servicio de interne! de banda ancha para 

las instituciones educativas de nivel 

primario en la micro red del distrito de 

Colcabamba. 

OE: 

a) Identificar la tecnología a utilizar para 

proveer interne! inalámbrico de banda 

ancha a las instituciones educativas de 

nivel primario de educación básica 

regular en la micro red Colcabamba. 

b) Identificar los equipos a utilizar para 

proveer interne! inalámbrico de banda 

ancha a las instituciones educativas de 

nivel primario de educación básica 

regular en la micro red Colcabamba. 

MATRIZ DE CONSISTENCIA 

HIPÓTESIS 

HG: Una red de telecomunicación 

inalámbrica provee servicio de interne! 

de banda ancha a·las instituciones 

educativas de nivel primario en la micro 

red del distrito de Colcabamba. 

HE: 

VARIABLES 

INDEPENDIENTE 

Red de 

Telecomunlcaciones=RT 

DEPENDIENTE 

a) La tecnología 802.11 n provee interne! 1 Internet de Banda Ancha=IBA 

inalámbrico de banda ancha a las 

instituciones educativas de nivel 

primario de educación básica regular 

en la micro red Colcabamba a una 

velocidad mayor a 256 kbps. 

b) Mediante los equipos Ubiquiti se 

provee interne! inalámbrico de banda 

ancha a las instituciones educativas 

de nivel primario de educación básica 

regular en la micro red Colcabamba 

con un nivel de ganancia mayor a 90 

dBm. 

INDICADORES 

a) Torres 

b) Antenas 

e) Access Point 

Velocidad de Transmisión 
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Gráfico No 01: Registro de longitud y Latitud en las I.E. del distrito de Colcabamba el GPS 

frex 

Gráfico W 02: Almacenando localización de las I.E. del distrito de Colcabamba 
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Gráfico No 03: Torre autosoportada de movistar punto de repetición del sector NE 

-·-------------1 
i 
' 

Gráfico W 04: Antena directica instalada en la Municipalidad Distrital dé Colcabamba 
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Gráfico No 05: Comprobando la velocidad de conexión de la red implementada. 

Gráfico No 06: Torre ventada donde se instaló el equipo de recepción. 
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Gráfico N° 07: Medición de la resistencia del pozo de tierra en la I.E. 31296 en Pilcos 

Gráfico N° 08: Vista de la I.E. N° 31296, asesor y encargados del Centro de cómputo 
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presentar un informe al Despacho Minlstérlal, con copia 
a la Oficina General de Administración del Ministerio de 
Transportes y Comunicaciones, describiendo las 
acciones· realizadas y los resultados obtemdos durante 
el viaje autorizado. · · 

· Articulo 42,-. La presente Resolución Ministerial no 
dará·cterecho a exoneración o_liberación.de impuestas o 

·derechos aduaneros, cualquiera fuera su clase o 
denominación. 

Regístre~e. comuníquese y publfquese. 

JOSÉ JAVIER ORTIZ RIVERA 
Ministro de Transportes y Comunicaciones 

18681 

propuesto, durante los días a, g· y 1 o de noviembre de 
2005; . 

Que, conforme ·se desprende de .los Recibos de 
Acotación Ns 29109 y 29'110, la solicitante ha cumplido 
con el pago del derecho de tramitación correspondiente 
al Procedimiento a que se refiere el considerando 
anterior, ante la Dirección de Tesorería del Ministerio de 
Transpor.tes ·y Co(liunicaciones; 

Que, en tal sentido, las costos del respectivo viaje de 
inspección, estári íntegramente cubiertos· por la empresa 
solicitante qel servicio, incluyendo el pago de lbs viáticos 
y la Tarifa Unica de Uso de Aeropuerto; . 

Que, la Dirección de Segundad Aérea de la Dirección 
General de Aeronáutica Civil, ha emitido la Orden de 
Inspección NQ 2030·2005-MTC/12.04-SDO designando al 
Inspector Ricardo Rafael Pazos Raygada, para realizar los 
chequeos técnicos en simulador de vuelo del equipo Fokker 
1 00, en el Centro de Entrenamiento American Airlínes, al 
personal aeronáutico propuesto por la empresa Wayra Perú 
S.A.C., en la ciudad de Fort Wonh, Texas, Estados Unidos de 

Autorizan viaje de Inspector de la 
Dirección General de Aeronáutica Civil 
a EE.UU., en comisión de servicios 

' América, durante los días 07 al 1 O de noviembre de 2005; 

RESOLUCIÓN MINISTERIAL 
NB 773-2005-MTC/02 

Lima, 31 de octubre de 2005 

CONSIDERANDO: 

Que, la Ley N9 27619 que regula la autorización de 
viajes al exterior de servidores y funcionarios públicos, 
en concordancia con sus normas reglamentarias 
aprobadas por Decreto Supremo N2 047-2002-PCM, 
establece que para el caso de los servidores y 
funcionarios públicos de los Ministerios, entre otras 
entidades, la autorización de viaje se otorgará por 
Resolución Ministerial del respectivo Sector, la que deberá 
ser publicada en el Diario Oficial El Peruano con 
anterioridad al viaje, con excepción de las autorizaciones 
de viajes que no irroguen gastas al Estado; 

Que, el Decreto de Urgencia N9 015-2004 dispone 
que los viajes al exterior que irroguen gasto al Tesoro 
Público. de funcionarios, servidores públicos o 
representantes del Poder Ejecutivo, a que se refieren el ' 
primer y segundo párrafo del artículo 19 de la Ley 
Ng 27619, quedan prohibidos por el ejercicio fiscal 2005, 
prohibición que no es aplicable a los sectores Relaciones 
Exteriores y Coml;!rclo Exterior y Turismo, así como la 
Dirección de Aeronáutica Civil del Ministerio de 
Transportes y Comunicaciones; en cuyos casos los 
viajes serán autorizados a través de resolución del Titular 
del Pliego respectivo, la misma que deberá ser publicada 
en el Diario Oficial El Peruano antes del inicio de la 
comisión de servicios; 

Que, la Ley N° 27261 • Ley de Aeronáutica Civil del 
Perú, establece que la Autoridad Aeronáutica Civil es 
ejercida por la Dirección General de Aeronáutica Civil 
como dependencia especializada del Ministerio· de 
Transportes y Comunicaciones; 

Que, la Dirección General de Aeronáutica Civil, a fin 
de cumplir con los estándares aeronáuticos 
internacionales establecidos en el Convenio de Chicago 
sobre Aviación Civil y poder mantener la calificación de 
Categoría · 1 otorgada al Perú por la Organización de 
Aviación Civil Internacional, debe mantener un programa 
anual de vigilancia sobre la seguridad operacional a través 
de la ejecución de inspecciones técnicas a los 
explotadores aéreos en el país, basado en las 
disposiciones establecidas en el citado Convenio y en 
los estándares de la Organización de Aviación Civil 
Internacional; 

Que, la empresa Wayra Perú S.A.C., con Carta 
Cert057.05.0ps, del12 de octubre de 2005, en el marco 
del Procedimiento N2 5 de la sección correspondiente a 
la Direcctón General de Aeronáutica Civil (Eila,luación de 
Personal), establecido en el Texto .Unico de 
Procedimientos Administrativos del Ministerio de 
Transportes y Comunicaciones, aprobado por Decreto 
Supremo N" 008-2002-MTC, solicita a la Dirección 
General de Aeronáutica Civil, efectuar los chequeos 
técnicos en simulador de vuelo del equipo Fakker 100, 
en el Centro de Entrenamiento American. Airlines de la 
ciudad_ de Fort Worth, a su personal aeronáutico 

Que., por lo expuesto. resulta necesario autorizar el 
viaje del referido Inspector de la Dirección General de 
Aeronáutica Civil para que, en cumplimiento de las 
funciones que le asigna la Ley_ Ng 27261 .y su Reglamento, 
pueda realizar los chequeos técnicos a que se contrae 
la Orden de Inspección Nº 2030-2005-MTC/12.04-SDO; 

De conformidad con la Ley Nº 27261, Ley NQ 27619, 
el Decreto de Urgencia N" 015-2004 y el Decreto 
Supremo N2 047-2002-PCM; 

SE RESUELVE: 

Artículo 1e .• Autorizar el viaje del señor Ricardo 
Rafael Pazos Raygada, Inspector de la Dirección General 
de Aeronáutica Civfl del Ministerio de Transportes y 
Comunicaciones, a la ciudad de Fort Worth, Texas, 
Estados Unidos de América, durante los días 7 al 10 de 
noviembre de 2005, para los fines a que se contrae la 
parte considerativa de la presente Resolución. 

Artículo 22•• El gasto que demande el viaje autorizado 
precedentemente, ha sido íntegramente cubierto por la 
empresa Wayra Perú S.A.C. a través de los Recibos de 
Acotación N2 29109 y 2911 o, abonados a la Dirección 
ce Tesorería del Ministerio de Transportes y 
Comunicaciones .. incluyendo las asignaciones por 
concepto de viáticos y tarifa por uso de aeropuerto, de 
acuerdo al siguiente detalle: 

Viáticos US$. 880.00 
Tarifa por Uso de Aeropuerto US$ 28.24 

Artículo 3º.· Conforme a lo dispuesto por el Artículo 
109 del Decreto Supremo N9 047-2002-PCM, el Inspector 
mencionado en el Artículo 19 de la presente Resolución 
Ministerial, dentro de los quince (15) días calendario 
siguientes de efectuado el viaje, deberá presentar un 
informe al Despacho Ministerial, con copia a la Oficina 
General de Administración del Ministerio de Transportes 
y Comunicaciones, describiendo las acciones realizadas 
y los resultados obtenidos durante el viaje autorizado. 

Artículo 49.. La presente Resolución Ministerial no 
dará derecho a exoneración o liberación de impuestos o 
derechos aduaneros, cualquiera fuera su clase o 
denominación. 

Regístrese, comuníquese ·y publiquese. 

JOSÉ JAVIER ORTIZ RIVERA 
Ministro de Transportes y Comunicaciones 

18678 

Establecen co:ndi.c:il!m.es técn:icas ciie 
servicios de telecom~Unh::adones y 
modifican e! Plan Nadonei de 
Atribución die Frecuencias 

RESOLUCIÓN MINISTERIAL 
N2 777·2005-MTC/03 

Lima. 31 de ociubre de ?005 
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CONSIDERANDO: 

Que, mediante Resolución Ministerial Ng 626-2004-
MTC/15.03, de fecha í 9 de agosto de 2004, se aprobó 
las condiciones de operación de los servicios cuyos 
equipos utilizan las bandas 902 • 928 M Hz, 2 400- 2 483,5 
MH4 y 5 725 • 5·850 MHz; . . 

Que, ·e! artículo 28Q del Texto Unico Ordenado del 
Reglamento General de la Ley de Te"Jecomunicaciones, 

· Lirna. sábado 5 de no1·iembre de 2005 

928 MHZ, 2 400 • 2 483,5 MHz. 5 150 • 5 250 MHz, 5 250 
• 5 350 MHz, 5 470 - 5 725 M Hz y 5 725 - 5 850 MHz, de 
acuerdo al anexo que forma parte iniegrante de la 
presente resolución. 

Artículo 2!!.- Modificar la Nota P83 del Plan Nacional 
de Atribución de Frecuencias, aprobado mediante 
Resolución Min.isterial Ng 1 87·2005-MTC/03, con el 
siguiente. texto: 

aprobado por Decreto Supremo Ne 027·2004-MTC, . . "Nota P83: Las bandas 5 250- 5 350 MHz v 5 470 • 
establece que están exceptuados de la clasificación de :5 725 MHz están atribuidas a titulo secundano" para los 
servicios de la Ley, del Reglamento y de los Reglamentos sistemas de acceso inalámbrica para la prestación de 
Especfficos que se dicten, de contar con concesión, servicios públicos de telecomunicaciones fijos y/o 
asignación del espectro radioeléctrico, autorización, móviles. Aquellos que hagan uso c;te las frecuencias antes 
permiso o licencia, las telecomunicaciones instaladas Indicadas deberán sujetarse a la normativa establecida 
dentro de un mismo inmueble que no utilizan espectro o que establezca el Ministerio." 
radioeléctrico y no tienen conexión con redes exteriores 
y aquellos servicios cuyos equipos utilizando las bandas 
902 - 928 MHz, 2 400 • 2 483,5 MHz, 5 150 - 5 250 MHz, 
5 250 • 5 350 MHz y 5 725 - 5 850 MHz, entre otras 
bandas, transmiten en una potencia no. superior a la 
señalada en dicho artículo; 

Que, asimismo. el citado articulo establece que 
aquellas que hagan· uso de las frecuencias Indicadas 
deberán respetar las normas técnicas emitidas o que 
emita ei Ministerio: 

Que, la Nota P23 del Plan Nacional de Atribución de 
Frecuencias, aprobado mediante Resolución Mini$terial 
Nº 187-2005-MTC/03 establece que las bandas 902 -
928 MHz, 2 400 • 2 483,5 MHz y 5 725 • 5 850 MHz, 
están atribuidas a título secundario para los servicios fijo 
y/o móvil, público y/o privado. Aquellos que hagan uso 
de las frecuencias antes ·indicadas deberán sujetarse a 
la normativa establecida o que establezca el Ministerio; ¡ 

Que, las Notas-P82 y P83 del referido Plan establecen 
que la banda 5 150 - 5 250 MHz está atribuida a título ¡ 
secundario para servicios fijo y/o móvil públicas y/o 
privados de telecomunicaciones para su usa en interiores 
y que la banda 5 250 - 5 350 MHz está atribuida a titulo 1 

secundario para los sistemas de acceso inalámbrico para 
la prestación de servicios públicos de teleco­
municaciones fijos y/o móviles. Aquellos que hagan uso 
de las frecuencias antes indicadas deberán sujetarse a 
la normativa establecida o que establezca el Ministerio; 

Que, con fecha 16 de agosto de 2005, se publicó en 
el Diaria Oficial El Peruano, el proyecto de norma que 
otorga mayor flexibilidad para la operación de los equipos 
en las bandas 902 - 928 MHZ, 2 400 - 2 483,5 MHZ, 
5150 • 5 250 MHZ, 5 250 - 5 350 MHZ, 5 470- 5 725 
MHZ y 5 725 - 5 850 MHZ, habiéndose recibido y 
evaluado los comentarlos de los interesados; 

Que, el Comité Consultivo del Plan Nacional de 
Atribución de Frecuencias, mediante el Informe N2 012-
2005-MTC-CCPNAF, recomienda modificar la Nota P83 
del Plan Nacional de Atribución de Frecuencias y 
agregarla a los cuadros de atribución de frecuencias de 
las bandas 5 470 - 5 570 MHz, 5 570 - 5 65.0 MHz y 
5 650 - ·s 725 M Hz;. . 

Que, con la finalidad de promover el· desarrollo de los 
servicios de telecomunicaciones y permitir la 
coexistencia de los servicios en determinadas bandas 
de frecuencias resulta necesario atribuir la banda 5 470 
· 5 725 MHz a lftulo secundario para los sistemas de 
acceso inalámbrico para la prestación de servicios 
públicos de telecomunicaciones fijos y/o móviles, otorgar 
mayor flexibilidad para la operación de los equipos en las 
bandas 902 • 928 MHz, 2 400 - 2 483,5 MHZ y 5 725 -
5 850 MHz y establecer las condiciones técnicas para la 
operación en las bandas 5 150 ' 5 250 MHz, 5 250 -
5'350 y 5 470 - 5 725 MHz: 

Que. en tal sentido resulta necesario emitir las nuevas 
condiciones técnicas aplicables para los servicios cuyos 
equipos utilizan las bandas 902 - 928 M Hz, 2 400- 2 483,5 
MHz, 5 150 - 5 250 MHz, 5 250 - 5 350 MHz. 5 470 -
5 725 MHz y 5 725 - 5 850 MHz y modificar el Plan 
Nacional de Atribución de Frecuencias - PNAF; 

Ds conformidad con lo dispuesto en la Ley N9 27791 
y los Decretos Supremos f\J 9s. 013·93-TCC y 027-2004-
~JlTC~ · . 

SE RESUELVE: 

Artículo 12 .• · Aprobar las condiciones de operación 
de ios seJV!Clos cuyos equipos utilizan las bandas 902 -

Articulo 3º.- Agregar la Nota P83 a lbs cuadros de 
atribución de frecuencias de las ··tandas 5 470 • 5 570 
MHz, 5 570 - 5 650 MHz y 5 650 - 5 725 MHz: 

Articulo 42 .• Dejar sin efecto la Resolución Ministerial 
N2 626-2004-MTC/15.03 que aprobó las condiciones de 
operación de los servicios cuyos equipos utilizan las 
bandas 902 • 928 M Hz, 2 400 - 2 483.5 MHz y 5 725 -
5 850 MHz. 

Regístrese, comuníquese y publiquese. 

JOSÉ JAVIER ORTIZ RIVERA 
Ministro de Transportes y Comunicaciones 

ANEXO 

CONDICIONES DE OPERACIÓN DE LOS 
SERVICIOS CUYOS EQUIPOS UTILIZAN LAS 

BANDAS 902 - 926 MHz, 2 400 - 2 483,5 MHz, 5 150 -
5 250 M Hz, 5 250 - 5 350 M Hz, 5 470 - 5 725 MHz y 

5 725 • 5 850 MHz 

Artículo :le .• ALCANCES 
La presente norma técnica se aplica a los servicios 

cuyos equipos utilizan las siguientes bandas de 
frecuencias para servicios flíos y/o móviles: 

al Banda de 902 - 928 MHz. 
b) Banda de 2 400 - 2 483,5 MHz. 
C) Banda de 5 150 - 5 250 MHz. 
d) Banda de 5 250 - 5 350 MHz. 
e) Banda de 5 470 - 5 725 MHz. 
f) Banda de 5 725 - 5 850 M Hz. 

. Artfculo 2!!.- TÉCNICAS DE TRANSMISIÓN O 
MODULACIÓN DIGITAL 

Los equipos que operen en las bandas mencionadas 
en el articulo anterior deberán emplear técnicas de 
transmisión o modulación digital que permitan la mutua 
coexistencia. 

Articulo 3e •• CARACTERÍSTICAS TÉCNICAS DE 
OPERACIÓN 

Las servicios deberán cumplir con las siguientes 
características, de acuerdo a la banda de operación: 

a) La potencia isotrópica radiada equivalente (PIRE) 
máxima deberá sujetarse a las siguientes 
características: 

a.1) Para las bandas 902 - 928 M Hz, 2 400 - 2 483,5 
IVlHz y 5 725 • 5 850 MHz. la PIRE máxima utilizada no 
deberá exceder de 36 dBm (4 W). 

a.2) Para la banda 5 150-5 250 MHz, la PIRE maxima 
utilizada no deberá exceder de 23 dBm (200 mW) en 
espacio cerrado'. 

a.3) Para ia banda 5 250 - 5 350 M Hz y 5 470 - 5 725 
MHz, la PIRE maxima utilizada no deberá exceder de 30 
dBm (1 W). . 

b) La potencia pico máxima de salida da un 
transmisor: 

Espacio cerrado.·Espacio íísico dentro d9 una estruchlm con paredes y techo. 



· · :¡j;1} No. élebe exceder 'Cié ·30. d8m (1 W/ pa;a las 
bandas 902 - 928 MHz, 2 400 ~ 2 483.5 MHz v 5 725 -
5 850 MHz. - ' 

b.2) No debe exceder .de 24 dSm (250 mW) para ias 
bandas 5-250 - 5 350.MHz y 5 4'70 • 5 725 IVlHz. 

Parámetros ·máximos a tener en cuente. para la 
instalación de ·equipos:· 

e) Está prohibido el uso de amplificadores 1 
transmisores o cualquier otro dispositivo similar que altere 
las condiciones de PIRE máxima establecidas en el literal l 
a) del presenta artículo. · 

d) Para las aplicaciones en espacio abierto 2 , el ¡ 
transmisor deberá estar instálado en un ambiente de 
fácil acceso a fin de facilitar la labor de supervisión por 
parte del Ministerio. 

Artículo 72.- HOMOLOGACIÓH e) Los equipos que operen en las bandas 5 250 • 
5 350 M Hz y 5 470 - 5 725 MHz deberán emplear un 
mecanismo de control de transmisión de potencia, 
debiendo ·tener capacidad para operar al menos a 6 dB 
por debajo del valor medio de PIRE. 

f.) Los equipos que operen en las bandas 5 250 -
5 350 MHz y 5 470 - 5 725 MHz deberán emolear un 
mecanismo de detección de radar de selección dinámica 
de frecuencia. El umbral de detección para equipos con 
una PIRE entre 200 mW a 1W es -64 dBm. 

g) Para enlaces punto a multipunto, las antenas 
podrán ser: 

. • En zonas urbanas (no permitido para el servicio 
pnva~o _en la provincia de Lima y la Provincia 
ConstituCional del Callao): sectoriales con un ancho de 
lóbulo de hasta oo·. 

- En zonas rurales y en los lugares considerados de 
preferente interés social no hay restricciones de antenas. 

h) Para: aplicaciones de espacio cerrado, no hay 
restricciones de antenas 

Artículo 4!!,- MODALIDADES DE OPERACIÓN 
Las personas naturales o jurídicas podrán utilizar 

equipos que operen bajo tos alcances de la presente 
norma técnica, en las modalidades punto a punto y punto 
a multipunto, para servicios públicos y privados de 
telecomunicaciones, excepto para el caso del servicio 
privado punto a multipunto que no podrá ser utilizado' en 
las zonas urbanas de la provincia de Lima y la Provincia 
Constitucional del Callao. 

Artículo 5~.- CONDICIONES DE OPERACIÓN 
Las personas naturales o jurídicas que utilicen 

equipos que operen bajo los alcances de la oresente 
norma técnica deben: · 

a) Aceptar la interferencia perjudicial resultante de 
las aplicaciones industriales, científicas y médicas en 
las bandas 902·928 M Hz, 2 400-2 483,5 MHz y 5 725 • 
5 850 MHz, ·y en ningún caso podrán causar 
interferencias a éstas. 

b) No causar intelierencia períudlcial a ias estaciones 
de un servicio primario, permitido o secundario. 

c) Para el caso de los servicios privados, no reclamar 
protección contra interferencias perjudiciales causadas 
PO\ estaciones de un servicio primario, oermitido o 
secundario. · 

d) Aceptar la supervisión técnica dei lviinist'i<rio. con 
el ñn de verificar la operación ele sus slstema.s conforme 
a lo establecido en la presente norma. 

e) Adoptar las medidas pertinentes para prevenir, 
reducir y eliminar cualquier interferencia perjudicial 
atribuible a su sistema que afecte a otros sfs¡emas o 
servicios de tolecomunicaciones. 

P~ra el internamiento, comercialización y operación, 
los equipos que operen bajo los alcancas de la presente 
norma técnica, deberán contar con el respectivo 
Certificado de Homoloaación. 

Para su comercialización, los equipos que utilicen el 
espectro radioeléctrico y que transmitan en una potencia 
igual o infelior a 10 milivatios (mW) en antena (potencia 
efectiva irradiada), no requerirán ser homologados. 

Artículo 82.- INFRACCIONES Y SANCIONES 
Serán de aplicación l~s infracciones y sanciones 

establecidas en el Texto Unico Ordenado de la Ley de 
Telecomunicaciones y en su Reglamento General. 

Artículo 9!!.- INFORMACIÓN 
Las empresas que comercializan equipos y apare.tos 

de telecomunicaciones que se encuentren dentro de los 
alcances de la presente norma técnica deberán difundirla 
a sus clientes. 

Artículo 102.- AUTORIZACIÓN 
Están exceptuados de contar con concesión 

asignación del espectro radioeléctrico, autorización: 
permi~o o licencia, los servicios cuyos equipos 
~ransm1ten con una potencia en antena (potencia efectiva 
1rradlada) ,no superior a la establecida en el Articulo 289 

del Tex-to Unico Ordenado de! Reglamento General de la 
Ley de Telecomunicaciones. 

Asimismo. sólo para le.. prestación y/o instalación de 
1 servicios en áreas rurales y en lugares considerados de 

1 
preferente interés social, y previa obtención de !a 

1 
COf'!Ce~iór:, autort~acién. asignación del espectro 

1 
rad¡oelecmco, perrmsc o licencia correspondiente, está 
permitido operar equipos en las bandas 902 - 928 MHz, 

1 2 400 • 2 483,5 MHz, 5 250 - 5 350 MHz, 5 470 - 5 725 
1 MHz y 5 725 • 5 850 iv1Hz, utilizando antenas de mayor 
.

1 

ganancia que permitan superar los resoectívos valores 
de la PIRE señalado en el artículo 32' de la presente 
norma técnica. 

1 DISPOSICIÓf-J TRANSITORIA 

1 Primera.- PRESENTACIÓN DE FORMATO 
i Las personas naturales y jurídicas que vienen 
j operando equipos que se encuemren· bajo los alcances 
: de la p;esente norma técnica deberán cumplir con 
l . presentar ei formato a aue.se refiere el literal ai del artículo 
' 6~ en un plazo máxime de un ( 1 ¡ mes de publica de 1a 

presente norma. 

Espacio abierto.-Espadotis!ooai eiref.o:?. :u::ra as ~!fla.estiuctura cJn paredes 
ytecOO. 



Lima. sábado 5 de noviembre--de ·2005 

.ANEXO 

INFORMACIÓN TÉCNICA PARA LA OPERACIÓN EN LAS BANDAS 
902- 928 MHz, 2 400 • 2 483,5-MHz, 5150 • 5 250 MHz, 5 250 • 5 350 MHz, 

5 470 • S 725 MHz y 5 725 - 5 850 MHz 

DATOS DEL. USUARIO/OPERADOR: 
Apellidos y nombres 1 Razón Social 
Domicilio Legal 

) (}D.N.!. () R.U.C. 1 Nº 

! DATOS DE LA ESTACIÓN: 

1 Distrito 

1 BANDA DE OPERACIÓN (MHz): 

1 
() 902-928 
()5250-5350 

TRANSMISOR: 

1 
i 

l 
\ Teléfono: 

Ubicación (Jr., Calle, Av., etc.) 

-Provincia 

( ) 2 400 - 2 463,5 
( ) 5 470 - 5 725 

Marca Modelo Código de 
Homologación 

¡· 

SISTEMA RADIANTE (ANTENA): 

1 

Departamento 

( ) 5150. 5 250 
( ) 5 725 - 5 850 

Potencia de 
Transmisión (dBm) 

! 

1 
! Marca Modelo 

1 

Código de 
Homologación l Ganancia 

(dBi) ·¡ 

J 

ENLACE: 1 
Ubicación de la(s) estación(es) a enlazar (Jr., Calle, Av., etc.) Distancia (Km) 

1. 
2. 

1 3. 

REPRESENTANTE LEGAL: 
Apellidos y Nombres: 
Documento de identidad: 

' () DNI 
()C. l. 
( ) Pasaporte 
{) c. E. 

N2 

18669 

Firma 

Reconocen a Radio Integridad S.A.C. CONSIDERANDO: 

como titular de la autorización del Que, con·Resolucíón Ministerial N9 560-95-MTC/15.17 
servicio de radiodifusión sonora del 28 de diciembre de 1995 se autorizó a la empresa 

JESÚS FERNANDO DUEÑAS IPARRAGUIRRE E.I.R.L., 
comeJrcial em FM, e:n el departamento la operación de una estación del servicio de radiodifusión 
de JLa Libertad · i sonora comercial en Frecuencia Modulada (FM), en el 

1 distrito y provincia de Trujillo, departamento de La 
RESOLUCIÓN VICEMINISTERIAL 

N2 514·2005-MTC/03 

Urna, 28 de octubre del 2005 

· il Libertad, por el plazo de diez (10) años. con fecha de 
.vencimiento al 24 oe julio de 2001; 

Que, mediante Resolución D1rectora1 N9 029-2000· 

1 

MTC/15.19 del 8 de marzo de 2000 se autorizó el cambio 
de ubicación de los Estudios y Planta, y el cambio de tipo 
de emisión de la estación en Frecuencia Modulada {FM}, 
en el distrito y provincia de Trujillo, dep~rtamento de La. 

VISTAS. las Solicitudes reg1stros ~2s. 2001-000317, 
2001-001303, 2001·001817, 2002-001496 y 2002· 
002715 de· la empresa RADIO INTEGRIDAD S.A.C., 
sobre reconocimiento de titularidad de autorización, 
renovación y modificación de características técnicas 
de una estación del servicio ele radiodiiusión sonora en 
Frecuencia Modulada (FM), en el distñto y provincta de 
1rujillo, departamento de La Libertad; · 

Libert51-d, autorizada a la empresa JESUS_ FERNANDO 
DUENAS IPARRAGUIRRE E.I.R.L., por Resolución 
Ministerial Nº 560·95-MTC/15.17; 

Q:;e, por Resolución Viceministerial N2 .. 268·2~01-
MTC/15.03. del 16 de abril de 2001, se· aprobo .la 
transferencia de la autorización del servicio de 

' 
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lntroductlon 

1 ntrod uction 

Thankyou for purchasing a Nanostation M series product. This is 
a point-to-point CPE wireless device. This QuickStart Guide is for 
use with the following models: 

Model Operating Frequency Ethernet Ports 

NanoStation M2 2403-2475 MHz 2 

NanoStatlon M5 5170-5875 MHz* 2 

NanoStation Loco M2 2402-2482 MHz 1 

NanoStation Loco M5 5170-5875 MHz* 1 

NanoStation Loco M900 904-926 MHz 1 

* Only 5745-5850 MHz ls supported in the USA and Canada 

Package Contents 

NanoStation 24vPoE 
Adapter 

PowerCord Mounting Ties 

* Products may be different from pictures and are subject to change without notice. 

lnstallation Requirements 

• 1 O mm wrench 

• Shielded Category 5 (or above) cabling should be used for all 
wired Ethernet connections and should be grounded through 
the AC ground ofthe PoE. 

We recommend that you protect your networks from the 
most brutal environments and devastating ESD attacks 
with industrial-grade shielded Ethernet cable from Ubiquiti 
Networks. For more details, visit www.ubnt.com/toughcable 



Qulck Start Guide 

Hardware Overview 

Secondary 
Ethernet Port* --,:-'---!!111~ 

• Secondary Ethernet \ 
Portincluded onlyon 
NanoStation M2 & M5 

~¡ 

j Main 

~ EthernetPort 

1 Note: Secondary Ethernet Port is capable of 24V Power over 
Ethernet output which can provide power to a secondary 
device. lt can be ena bled using the AirO S interface. 

LEDs 

LAN1 

LAN2 

e 

2 

-ooo• 
u I..AN1 LAN2 

Power The Power LED will light steady green when 
properly connected toa power source. 

WAN/Main Ethernet The LAN1 Ethernet LED 
will lightsteadygreen when an active Ethernet 
connection is made to the Primary Ethernet Port and 
flash when there is activity. 

LAN/Secondary Ethernet The LAN2 Ethernet LED 
(on NanoStation M2/M5 only) willlight steady green 
when an active Ethernet connection is made to the 
Secondary Ethernet Port. 

Signal These LEDs display the signal strength. 



Typical Deployment 

Typical Deployment 

1 

Connect !he Power Cord to !he 
PoE Adapterand a power outlet 

LAN or Computer to 
Ethernet Port /abeled 
LAN on PoE Mapter 

Ethernet Port on Ubiquiti 
Device to Ethernet Port labeled 

POE on PoE Adapter 

Note: Shielded Category 5 (or above) cabling should be 
used for all wired Ethernet connections and should be 
grounded through the AC ground of the PoE. 

3 



Quick Start Guide 

Accessi ng Ai rOS 
1. Make su re that your host machine is connected via Ethernet to 

the Ubiquiti Networks device (as shown on previous page). 

2. Configure the Ethernet adapter on your host system with a 
static IP address on the 192.168.1.x subnet (e.g. 192.168.1.100). 

3. La un eh your Web browser and type http:/1192.168.1.20 in the 
address field and press enter (PC) or return (Mac). 

1 ! ... 1 .. ) ~ + 1 ~ http:/1~92.168.1.20 
4. Enter ubnt in the Username and Password fields. Select your 

country from the Select YourCountry drop-down. To use the 
product you must agree to the terms of use. Todo so, click 
1 agree to these terms of use. Click Login. 

-, .. ,OS ··-.,~ 

, ...... ~ 
'" ' ;' '"' "t~' ' e¡;,<' '\i ,\~; ll'i·~,· !¡¡;\~". ~''f' ;:j>~;: ;>~~~ _., ,.-~, ,,, l'i'' 

.,.-~~~,,,__, .. ..,.""' ..... -'Ir....._ r._,.,.,.,..-... 
--"-""''""'....,.""'"'"""""""'....-~·~-·-­... '""~--·"-~ .. - ....... ~__.,._..,>!._ 
:::'2:f!::::==.::-::=:~:::~~~~~ 

S. The AirOS Interface will appear allowing you to customize your 
settings as needed. 
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~C!!.SS 
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Ubiqulti Networks Wikl and Forum 

Ubiquiti Networks Wiki and Forum 

Ubiquiti Networks has an online Wiki with Manuals, Guides, and 
lnformation. lt is located at www.ubnt.com/wiki . 

....,. .. "'........__. .. ,.,__""""""' 
~"'c .......... - ............... _ ....... "'""' ... ""',.,.__,_ ................ _ 
-~ .............. _...._.._ . .,..,. ... _.~ ... 
_ ... q ......... ~ ...... : 

--~---­..... -.~ .. ~ ... .,..._,,.. ... ~--
. -·-"""'·"""~"'-~-..... ~ ..... ... _,. .... ,..,... •.. .,. ............. ,. 
#4J,,,..,.,._,u•·.,_ 
".,.¡~_ ....... :¡_,.,= 

·~·w;.......,.,,,...,... ....... ,,._, ___ .... .....,.._ .................... .-,.,. .. __ 
r...,,.........,....,...,.~ .......... t """"""' 

c.--.-,...._ ....... ~ ,,._.,..,.,.,.. __ ... __ 

Another great resource is the Ubiquiti Networks Forum. You can 
post and view comments, questions, and answers with other 
forum members and Ubiquiti staff at www.ubnt.com/forum . 

,. ..... ~, ... ,. .. 
---- --.. ~·· 

. . - -··-· ..... -~ ....... .. .... 
!;;:;'..!;" .. ":::.:.;;:::-"".__ ....... _ 1;~"';..':"""'"·,... ...... ,,,,.,, 

u ;¿;;:.~ .... -===- ~:-~-...,~-.:... 
o ~;;;~:::;.:;;;,~ ~ ;:;~~~·~-..,,~-: 

,....._., ____ "Q ....... -~.-. 

o ::~::~-"":"'-~- ;~>::~--t"oo>•:::: 
,,.,...-~.~ ...... ""!11:.·<'"~-,..--¡ 

U5::..'..:::~~~':'"' 
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Quick Start Guide 

lnstaller Compliance Responsibility 

Devices must be professionally installed and it is the professional 
installer's responsibility to make su re the device is operated within 
local country regulatory requirements . 

. -
, .. OS ··-···~ 

·-~ 
~ ~ 1<~ "i.<l.\~ ~1.:/.;\V~,,~M'j!.<,~j: h :"'! j"'~J't<'~ }lf" "'{4¡¡;; '~p' e¡,~:"¡;,\., ¡l" f' 

rrrckcl M> Mil QS' 
~ . ' ·"' ~ •· ~mm 

~~-----.]t!Oil$tl 

Ctu"t)r!o='~~ ;1 

a-ra~~.:r.~.!.,. 

CM<'nl~:["''~Ol .. b!cd __!.. 

llr'UT.IO:at!:6o (!! 

,.------+----1~-... -====Cl ~n ~., 

*-TXRQ.~~~-S!--

!"~"i.!:_:.!_~-~-----------~----~-------------·--·-·---------

Since Ubiquiti Networks equipment can be paired with a variety 
of a ntennas and cables, the Antenna Gain, Cable Loss, a nd Output 
Powerfields are provided to the professional installer to assist in 
meeting regulatory requirements. 

1 Note: This product is locked to the US Country Code to 
ensure compliance with FCC regulations. 
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S pecificatio ns 

NanoStation M 

Enclosure Size 

Weight 

Max Power Consumption 

Power Supply 

Power Method 

Operating Temperature 

Operating Frequency 

M2 

M5 

Networking Interface 

NanoStation Loco M 

Enclosure Size 

Weight 

Max Power Consumption 

Power Supply 

Power Method 

Operating Temperature 

Operating Frequency 

LocoM900 

LocoM2 

LocoM5 

Networking Interface 

Specifications 

29.4x8x3cm 

0.5kg 

8 Watts 

24V, 1 A PoE Supply lncluded 

Passive PoE (Pairs 4, 5+; 7,8 return) 

-3o•to 75•c 

2403 MHz- 2475 MHz 

5470 M Hz- 5825 M Hz 

2 10/1 OOBASE-TX Ethernet Ports 

163x31 x80mm 

0.18kg 

5.5 Watts 

24V, O.SA PoE Supply lncluded 

Passive PoE (Pairs 4, 5+; 7,8 return) 

-3o· to so• e 

904-926 MHz 

2412 MHZ- 2462 M Hz 

5470 M Hz- 5825 M Hz 

1 10/100BASE-TX Ethernet Ports 

7 



Quick Start Guide 

Safety Notices 
1. Read, follow, and keep these instructions. 

2. Heed all warnings. 

3. Only use attachments/accessories specified by the 
manufacturer. 

WARNING: Do not use this product in location that can be 
submerged by water. 

WARNING: Avoid using this product during an electrical 
storm. There may be a remote risk of electric shock from 
lightning. 

Electrical Safety lnformation 

1. Compliance is required with respect to voltage, frequency, and 
current requirements indicated on the manufacturer's label. 
Connection toa different power source than those specified 
may result in improper operation, damage to the equipment or 
pose a fire hazard if the limitations are not followed. 

2. There are no operator serviceable parts inside this equipment. 
Service should be provided only by a qualified service 
technician. 

3. This eq ulpment is provided with a detachable power cord 
which has an integral safety ground wire in tended for 
connection toa grounded safety outlet. 

8 

a. Do not substitute the power cord with one that is not the 
provided approved type. Never use an adapter plug to 
connect toa 2-wire outlet as this will defeat the continuity 
ofthe grounding wire. 

b. The equipment requires the use of the ground wire as a 
part of the safety certification, modification or misuse can 
provide a shock hazard that can result in serious injury or 
death. 

c. Contacta qualified electrician or the manufacturer ifthere 
are questions about the installation prior to connecting the 
equipment. 



General Warranty 

General Warranty 
UBIQUITI NETWORKS, lnc ¡·ueiQUITI NETWORKSi represents and warrants that the 
Products fumished hereunder shall be free from defects in material and workmanship 
for a period of one (1) year from the date of shipment by UBIQUITI NETWORKS 
under normal use and operation. UBIQUITI NETWORKS sale and exclusive obligation 
underthe foregoing warranty shall be to repair or re place, at its option, any 
defective Productthat fails during the warranty period. The expense of removal and 
reinstallation of any item is not included in this warranty. 

The foregoing warranty is exclusive and In lieu of all other warranties, express 
or implíed, including the implied warranties of merchantability and fitness for a 
particular purpose and any warranties arising from a course of dealing, usage or trade 
practice with respect to the products. Repair or replacement in the manner provided 
herein shall be the so le and exclusive remedy of Buyer for brea eh ofwarranty and 
shall constitute fulfillment of allliabilities of UBIQUITI NETWORKS with respect to 
the quality and performance ofthe Products. UBIQUITI NETWORKS reserves the 
right to inspect all defectiva Products (which must be returned by Buyer to UBIQUITI 
NETWORKS factory freight prepaid). 

No Products will be accepted for replacement or repair without obtaining a Return 
Materials Authorization (RMA) number from UBIQUITI NETWORKS. Products returned 
without an RMA number will not be processed and will be returned to Buyer freight 
collect. UBIQUITI NETWORKS shall have no obligation to make repairs or replacement 
necessitated by catastrophe, fault, neglígence, misuse, abuse, or accident by Buyer, 
Buyer's customers or any other parties. The warranty period of any repaired or 
replaced. Product shall not extend beyond its original term. 

Warranty Conditions 
The foregoing warranty shall apply only if: 

(1) The Product has not been subjected to mlsuse, neglect or unusual physical, 
electrical or electromagnetic stress, or some other type of accident. 

(11) No modification, alteration or addition has been made to the Product by 
persons other than UBIQUITI NETWORKS or UBIQUITI NETWORK'S authorized 
representatives or otherwise approved by UBIQUITI NETWORKS. 

(111) The Product has been properly installed and u sed at all times in accordance, 
and in all material respects, with the applicable Product documentation. 

(IV) All Ethernet cabling runs use CATS (or above) shielded cabling. 

Disclaimer: UBIQUITI NETWORKS does notwarrantthatthe operation ofthe products 
is error-free orthat operation will be uninterrupted. In no event shall UBIQUITI 
NETWORKS be responsible for damages or claims ofany nature or description 
relating to system performance, including coverage, buyer's selection of products 
for buyer's application and/or failure of products to meet government or regulatory 
requirements. 

Returns 
In the unlikely event a defect occurs, please work through the dealer or distributor 
from which this product was purchased. 

9 



Compliance 

Compliance 

FCC 
Changes or modifications not expressly approved by the party responsible 
for compllance could void the user's authorlty to operate the equipment 

NOTE: This equipment has been tested and found to comply wlth the 
limits for a Class A digital device, pursuantto part 15 ofthe FCC Rules. 
These llmlts are designed to provlde reasonable protection against 
harmfullnterference when the equlpment is operated In a commerclal 
envlronment. This equipment generates, uses, and can radlate radio 
frequency energy and, if not installed and used In accordance with 
the lnstruction manual, may cause harmful interference to radio 
communlcations. Operations of this equlpment In a resldential area is likely 
to cause harmful interference In whlch case the user will be required to 
correct the interference at hls own expense. 

For MPE and antenna usage details, please vlslt our webslte at 
www.ubnt.com/compliance 

lndustry Ca nada 

Under lndustry Canada regulations, thls radio transmitter may only operate 
uslng an antenna of a type and maximum (or lesser) galn approved for the 
transmitter by lndustry Ca nada. 

To reduce potential radio inteference to other users, the antenna type 
and its galn should be so chosen that the equlvalent lsotropically 
radiated power (e.i.r.p.) is not more than that permltted for successful 
communlcation. 

This devjce compiles wlth lndustry Canada licence-exempt RSS standard(s). 
Operation is subject to the following two conditions: 

1. This device m ay not cause interference, and 

2. This device must accept any interference, including lnterference that 
may cause undesired operation of the device. 

En vertu des reglements d'lndustrie Ca nada, cet émetteur radio ne peut 
fonctlonner avec une antenne d'un type et un maximum (ou moins) 
approuvés pour gagner de l'émetteur par Industrie Ca nada. 

Pour réduire le risque d'interférence aux autres utilisateurs,l'antenne 
type et son gain dolvent etre cholsles de fac;:on que l'équlvalent pulssance 
lsotrope rayonnée équivalente (pire) n'est pas plus que cela autorisé pour 
une communicatlon réussle. 

Et Cet appareil est conforme a la norme RSS Industrie Canada exempts de 
licence norme (s). Son fonctlonnement est soumls aux deux conditlons 
sulvantes: 

1. Cet apparell ne peut pas provoquer d'interférences et 

2. Cet apparell doit accepter toute lnterférence, y compris les 
interférences susceptibles de provoquer un fonctlonnement du 
dlsposltif. 
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Compllance 

RF Exposure Warning 

The transceiver descrlbed here emlts radio frequency energy. Although 
the power level is low, the concentrated energy from a directlonal antenna 
may pose a health hazard. Do not allow people to come closer than 55.53 
cm to the antenna when the transmltter ls operating. 

Additional information on RF exposure is available on the Internet at www. 
fcc.gov/oet/info/documents/bulletins 

L'émetteur-récepteur décrlt ici émet de l'énergie de fréquence radio. Bien 
que le niveau de pulssance est falble,l'énergie concentrée a partir d'une 
antenne directlonnelle peut présenter un danger pour la santé. N e pas 
permettre aux gens de se rapprocher de 55.53 cm a l'antenne lorsque 
l'émetteur est en marche. 

Des renseignements supplémentalres sur l'expositlon aux RF est 
disponible sur Internet a www.fcc.gov/oet/info/documents/bulletins 

CE Marking 

CE marking on this product represents the product ls In compliance with 
all directlves that are applicable to it. 

Alert sign! Follows CE marking 
Alert slgn must be lndlcated if a restrlction on use applled to the product 
and lt must follow the CE marklng. 

CE<D 
NB-Identification number (ifthere is any) 
Notified body number is indicated if it ls involved in the conformity 
assessment procedure. 

CE XXXX <D 
Please check the CE mark on the product label to find out whlch notified 
body was involved durlng assessment. 
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from the most brutal environments and 
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1 Introducción a Radio Mobile 

Radio Mobile es un programa de simulación de radiopropagación gratuito 
desarrollado por Roger Coudé para predecir el comportamiento de sistemas 
radio, simular radioenlaces y representar el área de cobertura de una red 
de radiocomunicaciones, entre otras funciones. 

El software trabaja en el rango de frecuencias entre 20 MHz y 20 GHz y está 
basado en el modelo de propagación ITM (Irregular Terrain Model) o modelo 
Longley-Rice. 

Radio Mobile utiliza datos de elevación del terreno que se descargan 
gratuitamente de Internet para crear mapas virtuales del área de interés, 
vistas estereoscópicas, vistas en 3-D y animaciones de vuelo. 
Los datos de elevación se pueden obtener de diversas fuentes, entre ellas 
del proyecto de la NASA Shuttle Terrain Radar Mapping Misión (SRTM) que 
provee datos de altitud con una precisión de 3 segundos de arco (100m). 

Figura 1. Mapa mundial creado con Radio Mobile utilizando datos de elevación SRTM. 
Fuente http: //www.sector14. net/ "'curt/srtm 

Figura 2. Vista en 3D generada con Radio Mobile. 
Fuente http: //www.cplus.org/rmw/rme.html 

Los mapas con información de elevaciones pueden ser superpuestos a 
imágenes con mapas topográficos, mapas de carreteras o imágenes satélite. 
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Figura 3. Mapa de Madrid y sus alrededores. Superposición de mapa de elevaciones y mapa 
topográfico. 

Figura 4. Mapa de Madrid y alrededores. Superposición de mapa de elevaciones e imagen de 
Satélite obtenida en Google Maps. 
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En la pagma principal de Radio Mobile puede descargar gratuitamente el 
programa, consultar guías de utilización, acceder al grupo Yahoo de 
discusión de Radio Mobile y consultar las especificaciones o "data sheet" del 
programa. 

2 Cómo instalar Radio Mobile 

Todos los archivos necesarios para la instalación se encuentran en la página 
de descargas de Radio Mobile http://www.cplus.org/rmw/download.html. 
El software del programa no incluye un instalador. Los siguientes pasos 
permiten completar la instalación del programa: 

l. Instale el paquete Visual Basic Runtime (Service Pack 6) de 
Microsoft. Para ello descargue el archivo vbrun60sp6.exe y 
ejecútelo. Es posible que tenga que reiniciar posteriormente su 
PC. 

2. Cree un directorio en el que instalar el programa: 
C:\Archivos de programa\Radio Mobile. 

3. Descargue los siguientes archivos comprimidos y descomprímalos 
en el directorio que ha creado, respetando este orden: 

- rmw794.zip archivos ejecutables de Radio Mobile. 
- sup.zip suplementos para Radio Mobile. 
- net.zip ejemplo de red. 

4. Para crear un acceso directo en su escritorio, abra el directorio 
C:\Archivos de programa\Radio Mobile, seleccione copiar sobre el 
icono RMWDLX, sitúese sobre el escritorio y seleccione pegar 
acceso directo. 

5. Para habilitar la descarga de mapas desde Internet, por ejemplo 
de Google Maps, es necesario abrir el archivo Map_Link.txt 
situado en la carpeta en la que ha instalado Radio Mobile y borrar 
los apóstrofes de las primeras líneas: 

'www.expedia.com 
'virtualearth.net 
'map.access.mapquest.com 
'google.com 

6. Para obtener funcionalidades extra puede descargar las 
siguientes librerías (DLL): 

- freeimage.zip permite guardar imágenes en formatos jpeg, 
tiff y png. Probablemente ya dispone de estas funciones. 
- unzip32.zip permite la descarga automática de archivos SRTM 
comprimidos. 
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- geoStarslib.zip para establecer el Azimut relativo al Norte 
Magnético. 

Es posible encontrar en Internet instaladores para Radio Mobile creados por 
otros usuarios que incluyen ejemplos de redes. La instalación es más 
sencilla, pero puede no instalar la última versión de Radio Mobile. Realice el 
paso S en cualquier caso. 

• Documentación e instalador de Radio Mobile 7.9.4. de G3TVU. 
• Documentación e instalador de Radio Mobile 7 .6.3 de Greg Burg. 

3 Cómo obtener datos de elevación y crear 
mapas 

Los datos de elevaciones se van a descargar de Internet del proyecto de la 
NASA Shuttle Terraín Radar Mapping Misión (SRTM) que provee datos de 
altitud con una precisión de 3 segundos de arco (100m). 

A partir de estos datos Radio Mobile produce mapas de elevaciones que 
pueden ser superpuestos a imágenes con mapas topográficos, fotografías 
aéreas o imágenes de satélite que se descargarán de fuentes de Internet 
como MapPoint, Virtua/Earth, MapQuest y GoogleMap. 

3.1 Configuración 

Abra el programa y observará en la pantalla un mapa de elevaciones que 
corresponde a la red por defecto ' .. \default.net'. 

Es necesario definir el directorio local en el que se van a almacenar los 
datos de elevaciones descargados y establecer el directorio ftp de Internet 
desde el que se van a descargar los datos SRTM. Este directorio varía según 
la región en la que queramos trabajar (Eurasia, África, Australia ... ). 

l. Cree tres directorios locales denominados SRTM, GoogleMap y 
VirtuaiEarth en los que se almacenarán los mapas descargados 
de Internet. 

2. Acceda a Options > Internet. 
Active la opción para descargar los datos de Internet sólo si no se 
encuentran ya en el directorio local y guardar una copia local de 
los datos descargados. 
Especifique el path del directorio local que ha creado para 
almacenar los mapas SRTM. 
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Seleccione el directorio Internet ftp según el área de interés. 
Pulse OK para guardar los cambios. 
Para las pestañas GoogleMap y Virtua/Earth active la opción 
Download from Internet if a file is not found on local path and set 
a local copy y especifique el path del directorio que ha creado 
para estos mapas. 

3. Acceda a Options > Elevation data. Seleccione Use elevation 
data in memory generated by Map Properties. 

~ .. -. Internet op1ion11 ~ 

SRTN Topor11ma Terra~~tvet __ Pr_oxy _j OK 

Virtul!IE.!!tth \1/eb updl!te 

!~ Downll).9d hom lnltmet if ~ fil<l ~ oC( fouñd on loe.:! p61h 

.r;" Downlc.ad hom lntemet i! a hle IS n~ fournl on local path and keeR e lo~! copo¡ 

r·· Use local files onl}• 

Local files path 

jC:\Documen~ ar.d Settf'l¡¡~\us,;ar!O\SRTM 

lntern& flp dilectm~· 

Figura 5. Configuradón de las Opciones de Internet para descargar mapas SRTM en la zona de 
Eurasia. 

3.2 Mapa de elevaciones 

Acceda a File > Map properties. 

l. Determine la fuente de datos de elevaciones. En este 
tutorial utilizaremos los datos SRTM de la NASA. Especifique 
el path del directorio local que ha creado para almacenar 
los datos SRTM. 

2. Seleccione la longitud y latitud del centro de la reg1on de 
trabajo. Puede encontrar las coordenadas geográficas de 
ciudades españolas en: 
http: //www.sitiosespana .com/paginas/coordenadas.htm. 
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3. Introduzca las dimensiones del mapa: resolución en la 
pantalla en número de píxeles y longitud de la zona en Km. 

4. Seleccione la opción Ignore missing files y pulse Extract. 

5. Acceda a File > Save map as y guarde los datos de 
elevaciones obtenidos en un fichero con extensión 'map '. 
Puede guardar la imagen asociada a este mapa en File > 
Save picture as. 

Es importante diferenciar el mapa (datos de elevaciones en fichero .map) y 
las imágenes que obtiene Radio Mobile representando estos datos (fichero 
.bmp, .jpg, .gif...). 

~..,,. \red.map properties l8J 
Centre------- · --- · ---- --- -----··- --, · Síze (pixel}---------- -------------· --·--·---· - -- ----------

4J)•2t~4!:l,O'tl OCI3"4D'4El.O'W j . Widlhfpixe!s) Height (pC<els) 1 
IHOODK ! , fj2S1--.- f84g-- '-· _......__..... 

Long}uda '. Lalitude 

{4ÜA3 I·3.6B -- ~ .- Size {l;ml 
! 'Nídlh(km) Heig!t!km) 

l·tei.oo 

¡ 
Cancel 

U se cucsor po~iort 

\1/orkl map 1 ----
Seled a cly nams 1 

Entet LAT LON or QRA 

~-1 'J' : 

j TopLeft 
1 40' 3G'3:S'l-l 
t 004'01 '52'\1/ 

i - E'lelfa!ion data s01.1ce - --·- --- ---------·----·----
!' ! Top Ri\tt! 

4ü'36'35'N 
003'19'44"\-'/ 

1 ; D rive or p6lh 1 op la _ver j 

i : jsATM iJ jtings\usue~io\SRTM Btow:s.c J l 
( 

1
:
1 

EloUot<l Leít 
_ 40" t 5'00"N 

l · .-¡N---~-. le 
: , ¡ one ..::J 

1 rS-el-ec_l_al.ll-it----i)""~ i: !None i] le 
----' oo.¡-'1)1 '5?:\v 

Browse 
BotiomRi-Jl'l 
4tl'15'0!l' f¡ 
00:)19':14' \•/ 

----- .... ---- -·---- ----- · __________ J > r--¡N_on_e--Oi]-, le 610wse 

r Ad¡Jst u;~~~~~~-- - --¡ : jNone 3 fe 2_:o~ _! 
r M er~ pict ... es ; ¡;; lgnOl$ mi$SÜ'Ig fil~s Boi\O(l"t !ayer. 

r !i:_91Qi\J:~i~~ ' frai.size Malt!ot WTh élóVlllion {m) ro-

Figura 6. Configuradón de las Propiedades del Mapa para extraer datos de elevaciones SRTM 
en los alrededores de Madrid. 
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Figura 7. Imagen MadidSur.jpg. Representación de los datos de elevaciones SRTM en los 
alrededores de Madrid. 

3.3 Superposición de mapas 

La función Merge picture permite superponer a la imagen del mapa de 
elevaciones mapas topográficos, mapas de carreteras o imágenes de 
satélite que se pueden descargar de distintas fuentes en Internet. También 
permite superponer a la imagen activa otra imagen abierta previamente. 
La imagen que resulta mantendrá los atributos de la matriz de elevaciones. 

Para poder descargar las imágenes de fuentes en Internet es necesario 
haber editado previamente el archivo Map_Link.txt (ver apartado 2, paso S) 
y configurar las Opciones de Internet (ver apartado 3.1). En este tutorial se 
trabaja con imágenes descargadas de Internet de las fuentes Map Point, 
Virtual Earth, Map Quest y Google Map. 

Las imágenes se pueden superponer mediante cuatro modos de operación: 

• Copy: produce una versión sin procesar de los datos descargados, es 
decir, representa únicamente el mapa descargado sin superponerlo. 
En este modo obtendríamos por ejemplo un mapa de carreteras que 
no aparecería superpuesto al mapa de elevaciones. 

• Add, Multiply y Bitwise: procesan los datos descargados con la 
imagen activa utilizando distintas funciones. Para elegir el modo de 
operación pruebe a realizar la superposición en los tres modos y 
escoja la imagen más nítida para su proyecto. 
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\ l - :: Vhrf.lwl 
,·-" ... (k¡jP~"' 

Ea-,_ . 
·'' 

Modo Multiply Modo Bitwise 

Figura 8. Imágenes obtenidas con la función Merge Picture con datos de MapPoint en los 
distintos modos de operación. 

Para obtener imágenes más claras, puede trabajar con el mapa de 
elevaciones en escala de grises. Para obtenerlo acceda a File > Map 
properties y seleccione la opción Force grey sea/e y extraiga de nuevo el 
mapa. Utilice esta nueva imagen para realizar la superposición. 

Abra Edit > Merge Pictures, seleccione la fuente de datos, el modo de 
operación y haga die en Draw. Una vez descargados los datos visualizará el 
nuevo dibujo con los mapas superpuestos y el programa le ofrecerá la 
opción de mantener la superposición en la imagen acual, guardarla en una 
nueva imagen o descartar la superposición. 
Es conveniente guardar las distintas superposiciones que obtenga en File > 
Save picture as. 
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• Fuente: Internet Map Point 

~'}Merge pictures over .. '\madridsur.bmp ~ 
¡ Source·--·--··----- ··- ------ ----·- -------- ·----- --·¡ 
i 1 

r Anothet picture 

r' Internet LANDSAT · World 

r Internet Terraserver- USA 

í lntemet Tiger ·USA 

r Internet T oporama • Canada 

r LandCo.,.er 

r ADRG • CADAG 

r. ~:~i.~.~~~IF~i!.E~!~~ 
r lnternetVvtuaiEarth 

r lnte;net MapQuest 

MapPoint selection- --- - ---·~- ~- -- · --- -- - -- -
Personnal use 

r North America 

c.· Europe 

r Brazil 

(' Asia and Pacific 

r The\.1/orld 

r Olher 

Draw 

Cancel 

Operalion · 

r Copy 

r Add 

(i" Multiply 

r Bitwise 

¡ Contrast=U 

! ~-[~~~~:2..1 
j Brightness=0.9 
1 •L __ l_ .. _ ~~ 
1- ----..1:..1, 

¡ 1 1 1 í Internet GoogleMap 
1 

j ! Reset ¡ 
--~------~----~---·------~----------..... :_ __________ ~--~---- _,_ ___________ .._ ____ j l--~----- ._ .. __ ...J 

Figura 9. Merge Picture utilizando como fuente Internet Map Point. 

Figura 10. Ejemplo de imagen obtenida utilizando Merge Picture en modo Multiply con Internet 
Map Point como fuente. 
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• Internet Virtual Earth permite descargar tres tipos de mapas: mapas 
de carreteras, fotos aéreas y mapas híbridos. 

• Internet Map Quest produce mapas topográficos y Google Map 
permite descargar imágenes de satélite. 

• Si selecciona como fuente Another picture, puede superponer a la 
imagen activa otra imagen abierta en Radio Mobile, cuyo nombre se 
especifica en el campo Source picture. 

~'} Merge pictures over .. '\Picture5. jpg ~ 
,-Source -------------~----·: 1 ·· Source pictule----------; .------. 
i 1 ¡ 1 1 Draw 
: r. ~~~-P.Efi!~ 1 ljmadridsur.jpg :::J j ._ ____ _. 
! ¡ ! 
: r lnternetlANDSAT -World ' ¡--c_ance_l~_, 

Operation ---: 
r Internet T erraserver- USA 

1 
. ! ¡ 

: ( ¡' r lntemet Tiger- USA 

r Internet T oporama- Canada 

1 LondCover 

(' ADRG -CADRG 

r Internet MapPoint 

r Interne! VirtuaiEarth 

r Internet MapQuest 

; i (" Copy 

: ¡ 1 r Add 

i ¡ i r. Multiply 
'r ¡ . 

1 : ¡' J (" B~wise ¡; 
.: : l ' 
: ¡ l ! Contrast=1 t 
! 1 ! l ~'J. -- .._¡i 
! ; í ..!J -- _ __lj ! 
1 1 J j Brighlness=1 1 
: r ¡: ~ r··-J--_lj ¡ 
¡ ! ¡ l_ ~---- ···--- 1 
1' < 1 

'' 1 1 ' r Internet GoogleMap t ¡ l t Aeset ¡ 
-·---------------------·-------·---' , _________________________ j ¡ _________ __; 

Figura 11. Utilidad Merge Picture para superponer una imagen previamente abierta a la imagen 
activa. 

Es posible obtener mapas más detallados seleccionando una cuadrícula en 
la imagen del mapa de elevaciones con el ratón y pulsando el botón 
derecho. El programa le permitirá crear una imagen ampliada de la zona. Le 
aconsejamos que para hacer la ampliación utilice el mapa de elevaciones en 
escala de grises. A partir de la ampliación del mapa de elevaciones puede 
utilizar la herramienta Merge Picture por ejemplo con Google Map como 
fuente, obteniendo un mapa más detallado de la zona que conserva la 
matriz de elevaciones. 
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Figura 12. Ejemplo de imagen ampliada del mapa de elevaciones de Madrid en escala de grises 
y superposiciones con datos de Map Point y con imágenes satélite de Google Maps. 

En el documento de la página web de GT3TVU sobre Radio Mobile 
encontrará más ejemplos de uso de la herramienta Merge Pictures. 

4 Cómo crear una red 

Para trabajar con Radio Mobile, es necesario entender la terminología 
utilizada en el programa: 

• Network: es un grupo de unidades radio (units) que operan en el 
mismo rango de frecuencias bajo las mismas condiciones 
climatológicas y condiciones de terreno (en términos de porcentaje 
de suelo urbano o rural). 

• System: especificación funcional de un sistema que incluye 
parámetros de antena (potencia de transmisión, umbral de recepción, 
pérdidas del circuito de antena, diagrama de radiación y ganancia), 
pérdidas del cable y altura de la antena sobre el suelo. A cada unidad 
radio física emplazada (unit) se le asocia una especificación funcional 
(system) entre las definidas. 

• Unit: unidad radio física con posición geográfica y especificaciones de 
un tipo de sistema entre los definidos (system). 

• Membership: definición de qué unidades radio físicas emplazadas 
pertenecen a una red (network), cuáles son sus especificaciones 
(system) y cuál es su rol en la topología de la red. 

Para ilustrar el funcionamiento de Radio Mobile se simulará una red de 
comunicaciones móviles GSM en una zona rural de la Comunidad de Madrid. 
El objetivo es ofrecer cobertura en los pueblos del Valle del Lozoya. Para ello 
se emplazará una estación base en los alrededores de Rascafría y se 
estudiará su área de cobertura con la herramienta Radio Coverage. Además 

13 



se emplazarán varios terminales móviles en la zona para estudiar los 
enlaces estación base-terminal móvil con la herramienta Radio Link. 

Figura 13. Mapa de elevaciones del Valle del Lozoya con superposición de datos topográficos 
Map Point. Se han de;tacado las zonas de Rascafría y Lozoya. 

Resumen de pasos a seguir: 

l. Cree un nuevo archivo .net en File > Create new networks. 
Acepte borrar de memoria la información almacenada de la red 
anterior. 

2. Extraiga el mapa de elevaciones de la zona de interés. 
Para generar el mapa del Valle del Lozoya se han utilizado los 
siguientes parámetros: latitud 40,90 y longitud =-3,60 con 80 
Km. de altura y anchura del mapa. 
Se ha realizado una ampliación del valle en el mapa de 
elevaciones y se han superpuesto datos topográficos de la fuente 
Map Point al mapa de elevaciones ampliado. 

3. Edite los parámetros de propagación de la red (ver apartado 4.1) 
File > Networks properties > Parameters. 

4. Defina los sistemas estación base y terminal móvil. (ver apartado 
4.2). 
File > Networks properties > Systems. 
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5. Cree y posicione las unidades radio en el mapa~ la estación "Base 
Rascafría" y varios terminales móviles emplazados en la zona 
("Móvil 1", "Móvil 2" ... ) (ver apartado 4.2). 
File > Unit properties. 

6. Asocie las unidades radio a la red. Asigne a cada unidad un tipo 
de sistema. (ver apartado 4.3). 
File > Networks properties > Membership. 

7. Utilice las herramientas de Radio Mobile para realizar 
simulaciones (ver apartado 5). 

4.1 Propiedades de la red 

Parámetros de propagación: File > Networks properties > Parameters. 
En primer lugar seleccione una red libre de la lista de redes y nómbrela. 
Los parámetros de propagación a establecer son: 

• Frecuencia máxima y mínima. El programa utiliza la frecuencia 
media como entrada al modelo de propagación. 

• Polarización vertical u horizontal (dependiendo de los equipos 
reales utilizados). 

• Refractividad de la superficie, conductividad del suelo y 
permitividad relativa del suelo. Si no tiene éstos datos, utilice los 
valores por defecto. 

• Modo de variabilidad: 
El modo Accidental se utiliza para evaluar interferencias. El modo 
Broadcast es para unidades estacionarias y Mobile para 
comunicaciones móviles. En el modo Spot el programa hace un 
único intento para enviar un mensaje en la simulación. 
El efecto de los porcentajes de tiempo, localizaciones y situaciones 
depende del modo elegido. 

• Porcentaje de suelo urbano o bosques para calcular las pérdidas 
adicionales. 

• Tipo de clima. 

La siguiente ventana muestra los parámetros para la red GSM de Rascafría: 
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if~".J Networks properties ~ 

ListofaHnets . Defaultparameter;j _ CopyNet j ".,_'·:'•·' j. _Cancel _ji OK 
r - ~ • • •, ~ • ' -·• " 

~~~oz~oya~····· : Parameter~ j , T opofogy j Membership 1 S_ystems j ~:__j 
Net 3 
Net 4 
Net 5 
Net 6 
Net 7 
Net 8 
Net 9 
Net10 
Net 11 
Net 12 
Net 13 
Net 14 
Net15 
Net 16 
Net17 
Net18 
Net 19 
Net20 
Net 21 
Net22 
Net23 
Net 24 
Net25 

' · Netname 

: . fRascafría 

: 
1 

Mínimum frequenc_y [M Hz) jaso 

~ ' Maximum frequenc_y (MHz) lr:-ss=-=o--

Surface refractivit~· {N-Units) ~ 

Ground conductivit_y (S/m) !0,005 

Relativa ground permittivit.Y ~ 

' ,- Polarization ---------------·: ~- Climate-----~----------

, · : r. Vertical \ Horizontal J 

. : .- Mode of variabilit.Y -------------, 
. 1 

r Spot 

:· ! ; e· Accídental 

r. Mobile 

· : r Broadcast 

%oftime ¡so- i 

% of locations ¡;;;---
% of situations rso-

r Equatorial 

r Continental sub-tropical 

(" Maritime sub-tropical 

(" Desert 

r. Continental temperate 

r Maril:ime temperate over land 
; ·- · - ·· · · .... ., ·- · · ---- ...... -.- .... -- --- __¡ • C Maritime temperate over sea 

1 1 , 

¡: 

' : - Additionalloss ---- --------- - ----- ' 
. ; : t.' Cít_y r Forest % ~ ~ ! . , 

¡··--···------~----- ---------- ________ ..._ ___ .,~ __ t : .•.• --~·~ ... __ ·~~-·----·~-_..-~~-----; 

Figura 14. File > Networks properties > Parameters. Parámetros de la red GSM de 
Rascafría. 

Topología de red: File > Networks properties > Topology 

• Voice net (Command/Subordinate/Redbroadcast). Utilice esta 
opción cuando sea necesario comunicar las unidades de mando 
con las unidades subordinadas pero no las unidades subordinadas 
entre sí. Se pueden establecer unidades de retransmisión para 
mejorar la comunicación. 

• Data net, star topology (Master/slave). Utilice esta opción para 
redes de datos en las que las unidades "maestro// se comunican 
con las unidades "esclavo// pero no hay enlaces entre las unidades 
"esclaV0 11

• 

• Data net, cluster. Utilice esta opción para redes de datos con 
nodos que pueden retransmitir datagramas (rebroadcast). 

La casilla Visible se utiliza para mostrar u ocultar la red en el dibujo del 
mapa. 

16 



4.2 Definición de sistemas 

El programa puede almacenar hasta 25 especificaciones de sistemas 
asociados a un archivo Networks (* .net). Estas configuraciones o systems 
se almacenan en el archivo radiosys.dat que incluye dos sistemas 
predefinidos denominados UHF y VHF. 

Seleccione File > Networks properties > Systems para visualizar la 
siguiente ventana: 

t~ Networks properties - , - . . , ~ 

List ol aH systems 

EstaciÓn Ba~e 
S}'stem 2 
System 3 
System 4 
System 5 
System 6 
System 7 
System 8 
Systero 9 
Systero 10 
Systero 11 
System 12 
Systero 13 
Systero 14 
Systero 15 
Systern 16 
Syslern 17 
Systero 18 
System 19 
System 20 
System 21 
System 22 
System 23 
System 24 
System 25 

' ' 
' 

' ' 

Detault parameters 1 Copy~ :·.: '' :•. ·: j Cancel 11 OK 

Parameters Topology 

Systero name 

Transmit power ('Watt) 

Receiver thresho!d (¡N) 

Line !oss (dB) 

Antenna type 

.6.ntenna gain ( dB i) 

Membership 1 System$ 

jselect from Radiosys.dat 

[Estación Base 

1 

{dBro) Í40 

(dBrn) !-1 04 

Style 

3 

~- ( Cable+cavities+connectors) 

lomni.ant ~ View ...:J ----t 

(dBd) j3 

Antenna height {m) 1 5 

Additional cable loss (dB/m} jo 

(Above ground 1 ~ 

( 11 antenna height dillers) _j 

Add to radiosys.dat J Reroove from radiosys.dat J 

1 

1 

Figura 15. File > Networks properties > Systems. Parámetros de la estación base para la 
red GSM. 

A partir de las hojas de especificaciones de los equipos se definen para cada 
sistema la potencia de transmisión, umbral de recepción, pérdidas del 
circuito de antena, tipo de antena según su diagrama de radiación y 
ganancia de antena respecto a la antena isótropa. Además se especifican la 
altura de la torre de antena y las pérdidas del cable. 
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t,;.~ Networks propertie$ ~ 

Lis! of al! systems 

E!ltación Base 
; ; . 

System 3 
System 4 
System 5 
S.vstem 6 
System 7 

. System 8 
System 9 
System 10 
System 11 
System 12 
System 13 
System 14 
System 15 
System 16 
System 17 
System 18 
System 19 
System 20 
System 21 
System 22 
System 23 

· System 24 
System 25 

') . : 

¡ 
í; 
', 1 
l '; 
. l 

'; 

',í 
• 1 

1 

. ! 

'' ¡: 

Defauk parameters CopyNet ;"! ~"'.; r ' ' Cancel OK . 

Parameters 1 Topo!ogy 1 Membe~ship 1 Systems 

System name 

Transmit power {Watt) 

Receiver threshold (¡N) 

Lineloss(dB) 

Antenna lype 

Antenna gain (dBi) 

j Select from Radiosys.dat 

jT erminal Móvil 

!1.78 

jo 

(dBm} j30 

(dBm) !-102 

( Cable+cavilies+connectors ) 

View J 
(dBd) 12,85--

.1\ntenna height (m) !1 .5 ( Above ground J ~ 

Additional cable loss (dB/m} ¡o---- ( 11 antenna height diflers) _j 

Add to radiosys.d~ Remove from radiosys.dat J 

Figura 16. File > Networks properties > Systems. Parámetros del terminal móvil para la 
red GSM. 

Si pincha sobre el botón View podrá observar el diagrama de radiación de 
la antena. 

4.3 Posicionamiento de unidades radio 

Las unidades radio se van a emplazar a partir de la posición del cursor en el 
mapa. No obstante, las unidades también se pueden posicionar 
introduciendo sus coordenadas geográficas. 

Resumen de pasos a seguir: 

1. Posicione el cursor en el emplazamiento de la unidad. 

Si desea buscar el punto de mayor elevación de una zona, 
seleccione dicha zona con el botón izquierdo del ratón y pinche 
sobre el icono de la barra de herramientas Find peak elevation 
o seleccione View > Find peak elevation. 

Si desea buscar el punto de menor elevación, seleccione 
View > Find lowest elevation. 
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Puede utilizar la cuadrícula de elevaciones (grid elevation) para 
seleccionar un punto más o menos elevado en el entorno 
próximo de la posición del cursor. 

Nota importante: si observa que la cuadrícula Elevation grid no muestra 
datos de elevaciones en sus casillas, está utilizando una imagen que no está 
contenida en el mapa de elevaciones abierto. Abra el mapa de elevaciones 
adecuado o extráigalo de nuevo. 

2. Una vez posicionado el cursor, abra File > Unit properties, 
nombre la unidad que va a emplazar y seleccione Place unit at 
cursor position. El programa obtendrá la altitud de la matriz de 
elevaciones aunque también puede introducir el valor 
manualmente. 
Puede elegir el icono y estilo de la etiqueta para representar la 
unidad en el mapa. La opción Enabled determina si la unidad 
está activa y visible. 

WZ Units properties ~ 
'l!~!llmm••••r;: Name Elevation (m} ~~~~i1 ~ · Á, l,-B-ase-R-asc-a-fr-ía _____ ~ 11499 OK j 

··Position--· ---- ·-- ---~-- ---------------- -------·----
\ ,., 

Unit3 
Unit4 
Unit 5 
Unit6 
Unit7 
Unit8 
Unit9 
Unit10 
Unit 11 
Unit12 
Unit13 
Unit 14 
Unit15 
Unit 16 
Unit 17 
Unit 18 
Unit19 
Unit20 
Unit21 
Unit22 
Unit23 
Unit24 
Un~ 25 
Unit26 
Unit27 
Unit2B 
Unit29 
Unít 30 
Unit31 

l i Copy ¡ 40.52'57,3"N 003'55'19,2''\A/ Paste J : 
. : • - IN8U6.V -~ 1 ------' 
, : r Locked : 

' i 
' ¡ 
' ' 
' 1 
: ¡ 

' . 
' ' 

Enter Ló.T LON or QRA __j 

Place cursor at unit position 

Add unit to cities.dat J -----
--~---G-et_un_it_ú_on_~c_it_i~_.d_a_t ____ _j 

:-:::' r Show on!y units that are members of a visible network 

Moveup 1 
Movedown 1 

Export J 
lmport ¡ 

Figura 17. File > Unit properties. Posicionamiento de parámetros del terminal móvil para la 
red GSM. 

Para repos1c1onar una unidad, sitúe el cursor en el nuevo emplazamiento. 
Pulse con el botón derecho del ratón sobre la etiqueta de la unidad. El 
programa le pedirá que confirme si desea moverla. 
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4.4 Asociación de unidades a la red 

Acceda a File> Networks properties > Membership 

Seleccione la red en la lista de redes. Utilice las casillas de la lista de 
unidades para activar aquellas que pertenecen a la red entre las definidas. 
Para cada una de ellas, determine qué tipo de sistema es y cuál es su papel 
en la red. Si la altura sobre el suelo de la unidad es distinta a la altura 
especificada para el sistema genérico, puede cambiar este parámetro para 
la unidad. 

~ Networks properties ~ 

Líst of all nels 
Lazo a 

Net 3 
Net 4 
Net 5 
Net 6 
Net 7 
Net 8 
Net 9 
Net 10 
Net 11 
Net12 
Net 13 
Net14 
Net15 
Net 16 
Net17 
Net18 
Net19 
Net20 
Net 21 
Net22 
Net23 
Net24 
Net25 

Default p~arrelers .l Copy Net j _:-_,_ ... _. •_·:J -~~ OK l 
Parameters j Topology llf~~~~~~~i~Jl Syste~ Style . 1 

. r··--:-----:---------------~:¡,¡;ni¡;~¡-,;¡Ra¿;;afría~=--====-=-~:=:-·~ 
, l•stofaRunils · R 1 fB A f' · 1 ¡ : oeo ase ascaua , 

¡ f~~ ~~:~ ~ -' _, - 4 
: fcommand iJ : 

. :, U Unit 3 : System 

l. C; Unit 4 ·, rE-st-ac-ió-n-Ba-se-----~-. \ 
: CUnit5 ...:.¡ 

• 
1 

CJ Unít6 
CUnit7 

, : ["JUnit 8 
·' CUnit9 

1 C. Unit 10 
CUnit 11 
C!Unit12 
CJUnit 13 
iJ Unit 14 
[~ Unit15 
f-:-1 Unit 16 
C1 Unit17 V 

Antenna height (m) · 

e• System 

'' e Other 
1 

15 

b·J '! 
'' 
'' 

i ' 
\ ~ 
! 

1 

···~----------- -·--·-··-- --------~ ------~ i 
-------- ------·-------~~..,-----------~- -- 1 

Figura 18. File > Networks properties > Membership. Asociación de la unidad Base 
Rascafría de tipo estación base a la red Rascafría. 
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~ . . -

it1- Nenwrks prpperties ~ 

List of all nets 

Net 4 
Net 5 
Net 6 
Net 7 
Net 8 
Net 9 
Net10 
Net 11 
Net12 
Net13 
Net14 
Net15 
Net 16 
Net 17 
Net18 
Net 19 
Net20 

21 
Net22 
Net23 
Net24 
Net25 

Default para~eters j Copy Net j ~ Cancel JI. z ... OK .. J 
..... _.,... __ ···~-~----""'"'"'"""-'"'" ·-~·-- ------ ----·------·--~ ------ ---.-....-~- ~>--·-- -·~ ....... _ ..... -----~ ........ 

Paramet.ers 1 T opology j Membership J Systems 1 Style j ' 
1 r-------------·---------::=Member of Rascaf¡¡;==-==.::::.=-:--' 

List of all uníts · j 
¡ : ii?J Base Rascafría A ; Role of Movíll ' 
i : &?.! j j Subordinate iJ ) 
! ; O Unít 3 j System 
; ; L]Unit4 ¡ ·==== 
· ' [JUnit5 ¡ 

nalMóvd 

: : [] Unit6 ! , ·Antenna height (m)·- ·-
i. 0Unit7 : i 
: ; 0Unit8 i; r· System 
\ ¡ ClUnit9 : l 

1,5 

' ! []Unit10 t ~ ~ Other 
1 i [JUnit11 ~ l __________ ··· -··-·· 

[JUnit 12 
rJ Unit 13 
0Unit14 

1 
, []Unit 15 

: j []Unit 16 
0Unit17 V 

··--·--·¡ ! 
; 1 
¡ f 

¡ ¡ 
! ' _,! 

Figura 19: Asodación de la unidad Móvil 1 de tipo terminal móvil a la red Rascafría. 

ti\S'fiU A 

'fU:ÚU 

LOZOJ/V!,..-) 
! 

----~--1 

1 

! 
. 1 
t; 

·---'~"'='---------· -----·- ···="'--. 

Figura 20. Topología de la red GSM de Rascafría formada por una estación base y varios 
terminales móviles situados en los pueblos colindantes. 
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4.5 Apuntamiento de antenas directivas 

Si utiliza una antena directiva es posible especificar su ángulo acimutal para 
controlar la dirección a la que apunta o indicar al programa que la antena 
apunte a otra unidad radio definida en la red. 

En la definición de un sistema (File > Networks properties > Systems) 
puede especificar el tipo de antena y visualizar su diagrama de radiación 
pulsando View. 

lJilD Anlenna pattern , ~ ;., ~ 
Antennafile 

Front beam azimuth rl 
1 o 

Front beam gein [dBi) 

1 52 

Scale (dB) 

1 20 

~ Drawgricl 

W Draw labels 

Draw l 
Copy to cijpboard J 

Plol color 

Grid color 

Back co!or 

Figura 21. Diagrama de radiación de la antena yagui (yagi1.ant). 

Si en el sistema selecciona un tipo de antena directiva como la antena 
yagui (yagil.ant), cuando asocie unidades de esta clase de sistemas a la 
red (File > Networks > Membership), podrá orientar sus antenas. 

La siguiente figura representa los resultados obtenidos con la herramienta 
Radio Link al analizar un radioenlace a 2,4 GHz entre dos antenas de tipo 
yagui. Como las antenas apuntan por defecto al cielo, el receptor no recibe 
potencia suficiente y el enlace aparece en rojo. 
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1, •• 

' . . 
. 
' 

t~, ~¡ft:r,:,[l.;,'l_•' 
·· 1'. rk' :ni~\~ 

Álame!U "" .11 v del VaHe .-.m a 
• . • del v,,[ln . 

--------------~--~-·--~----~·---------·f--------------------------------~----------------------------
.... ~. ·" 'Oteruelo 

! ~ ·:: ~: \1.\Jlf:- tC<~:nrmtiil 

' 

r Transmittet-------- --------lJ- Receiver--------· 
i ~-¡¡¡¡¡;;¡"'iloiiíi1iiiiiiiiílitiiiii'~So ,l r,¡;¡¡¡-¡¡¡¡¡¡¡¡"iiiiiiíiiiiil~iiilííiiiíliiiíiiií so 
1 i! . 
. j Transmisor 0<:] 1 j f Receptor ::::J 

Role Command ] ; Role Subordinate 
Tx system name Transmisor J i Rx system narne Receptor 
T~t power 1 W 30 dBm 1 ReqUÍ!ed E Field 6t26 dB¡N/m 

·4,92dBd Line loss 0,5 dB li i Antenna gain ·2.77 dBi 
Anlenna gaín ·7.87 dBi ·10,02 dBd ..:J j Líne loss 0,5 dB 
Radíated power EIRPc0.15W ERP=0,09W 1 ' AK sens~ivity 10 11V -87 dBm . 

': 1 

Ante~~~~~~{m) -~~-------·· ----~~---'-J L. An~~~ he~~~~-J~~----------------~!_ __ L_; 
Net-- ........ - · ---- --· --.. -· ----- ----------- -· ------ -------1 r Frequency (MHz) ----- ------------------- ·--··- ----- -- ---, 

1 ! Minímum Maximum j ! 
jRadioenlace iJ l ¡ ¡2400 ¡2500 Apply Í 

Figura 22. Aná6sis del radioenlace entre dos antenas yagui desapuntadas. 

Para orientar adecuadamente las antenas hay que indicar que la antena de 
la unidad Transmisor apunte a la unidad Receptor y viceversa. Para ello abra 
la pestaña Membership, seleccione la unidad Transmisor y desactive la 
casilla Fixed que fija el ángulo acimutal de la antena. Aparecerá un menú 
desplegable en el que podrá elegir a qué unidad debe apuntar la antena. 
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¡;,~ Net.works properties ~ 

list of all nets 

Radioer~ace 
Rascafría 
Net 3 
Net 4 
Net 5 
Net 6 
Net 7 
Net 8 
Net 9 

· Net10 
Net 11 
Net 12 
Net13 
Net14 
Net 15 
Net 16 
Net17 
Net18 
Net19 
Net20 
Net21 
Net22 
Net23 
Net24 
Net25 

Defauk parameters Copy Net 1 .· . ,, :-.. Cancel 1._1 _o_K ~ 

¡ ~:"':te~=-· J . T opology 1 Membership J ___:ys~ems l Style J: 
; ;-- -- -- - -· ------- ·------ ----- --- ----- --:-¡;¡e~¡;~¡-(;¡-f¡aci¡óé~i~c:.;·.:-=--~ ~--- -~ · 
: ¡ list of all uni~ 
1' ' Role ot Transmisor 

! 1 

Ll Base Rascalría 
tJMov~1 
!:JMovil2 
0Móvil4 
C!Móvil3 
CiMóvn5 

"'' . 1 Command 

'1 

; \ 

j ~l 

i 1 
; ¡ 

1' r'! 
1 
¡ 

; : 
'1 

1 

: i 
; i 

\ 
'1 
'' 

'i 
'! 

' 1 

Yl 
L..;-} Receptor 
CJ Unit 9 
UUnit10 
[1Unit11 
OUnit12 
[! Unit 13 
UUnit14 
CJ Unit 15 
[JUnit16 
OUnit 17 V, 

1 l,... ___ ------- ~ --- ___ .,.. ... -- ------------- ---

System 

: 1 Transmisor 

: 1~Antennaheight{m)--- · _,. ____ -- ., · 
; ; 

· j ¡. System 5 
'1 
'i 
1 i f' Other 
' !. ··-· -- ·-· .. 

\ 
'\ 

'; 
--- J : 

- Antenna-azimuth--- ------------- · :¡. 3;;, 
'1 '1 'l ; ' 
,¡ rFixedn 1· 
: 1 :: 
'1 
'¡ 

1 View pattern 
'1 '' 
1 --·- __________ ,_ _______ --- .,_ .. __ --

Figura 23. File > Networks properties > Membership. Orientación de la antena directiva 
de una unidad radio para que apunte a otra unidad. 

En la siguiente figura puede observar como el enlace es viable tras apuntar 
correctamente las antenas del transmisor y del receptor. 

Alameda 
del Valle 

Oteruelo 
del Vallr: 

' 1 

r~r··,, tli~ 
!'~·-nt~:'Lt,•~ .. 
!: , de;. ~t1( 1!· _ 

Pmma 
del v.ül(} 

-.-~. --
• f 

' ' 

Figura 24. Representaáón del radioenlace con las antenas apuntadas. 
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4.6 Guardar el proyecto 

Un archivo Networks (* .net) incluye: 

../ Parámetros de propagación, topología y las unidades que 
pertenecen a cada una de las 25 redes que puede 
almacenar en memoria . 

./ Datos técnicos para los 25 sistemas que puede almacenar . 

../ Propiedades de hasta 50 unidades almacenadas en 
memoria. 

V' Nombres de archivo del mapa (*.map) y las imágenes . 

./ Valores de altura de antenas para unidades cuyo valor de 
altura difiere del definido en el sistema. 

Para guardar el proyecto: 

l. Guarde la matriz de elevaciones en File > Save map as. 

2. Guarde cada imagen en File > Save picture as. 

3. Guarde los datos de redes y unidades en File> Save networks 
as. 

Para recuperarlo seleccione File > New networks para limpiar la memoria, 
seleccione Open networks y abra el archivo .net anterior y verifique que 
recupera el mapa, los datos de redes y unidades radio. 
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5 Herramientas 

5.1 Radio Link 

Abra la herramienta en Tools > Radio Link y observará la siguiente 
ventana: 

,. Transmitter·------·------·-----·------ ~- Receiver----------------------·--· 

~-¡;¡¡;;;-¡¡¡¡¡,~------- 53 r;.;;;;¡;-:;;;;:··;,¡·;~-. ~'f<iiir..'! "'~~ ~!j;,------ 56 

{BaseRascafría ~ jMoví11 :::J 
Role Command Role Subordinate 
T x system name Estación Base R x systero name Terminal Móvil 
TKpower 10W 40d8m Required E Ft.eld 29,54 dBp.V/m 

_:1 Une loss 2,5dB Antenna gain 5dBi 2.85dBd 
Antenna gain 5J5dBi 3dBd ~ Une loss OdB 
Radiated power EIRP=18A1 W ERP=11,22W Rx sensitivit_y US¡¡V -10L99dBm 
Antenna heíght (m) h5 ~ Antenna height (m) lt5 _Appf.v 

~ ... .. ·-~ ...... --- ....... - - ---- ------· -- " .. ., .... -••e ~ - - "" """ - -- . ·-
;- Net ----------'--------~------¡ :--Frequenc_y {MHz) ·---------------- 1 
, . ¡ : Mínimum Maximum j i 
: __ -~~~:~.hf·~- ________ --·-·-·"-- _ .. ______________ .. _3 ___ __j : _ !S:~-- _ ... _____ ls~~--- __ --·----- __ ~~19 _ -· _¡ 

Figura 25. Herramienta Radio Unk. Perfil del enlace entre la estación base de Rascafría y el 
terminal Móvil 1 situado en ésta pobladón. 
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Esta ventana muestra los parámetros del enlace entre las dos estaciones 
seleccionadas. La opción Swap permite visualizar el enlace en el sentido de 
transmisión inverso. Es posible modificar las alturas de las antenas para 
investigar su efecto en el radioenlace. Pinchando con el ratón sobre el perfil 
aparecerá un cursor azul que permitirá obtener el despejamiento, elevación, 
nivel de campo, pérdida básica y otros parámetros en ese punto. 

Los botones marcados como '+' junto a los valores de ganancia de antena 
permiten ver el diagrama de radiación de la antena y el ángulo acimutal 
empleado. Seleccionando View > Details obtendrá un resumen del balance 
del enlace y la opción View >Distribution muestra las estadísticas de la 
señal en el trayecto. 

Si abre View > Observe > 80° observará una vista de la estación 
receptora desde el transmisor: 

, Tronsmitter --­
¡¡;¡¡¡¡¡¡¡¡;¡¡-.,¡¡¡-iiiii"1iiiíi'"'......-¡¡¡¡¡-oiiiiil,.¡¡¡¡¡--llliíiiiiÍiil-¡¡¡¡¡¡¡- S·l 00 

- , · Aeceíver - · - - - - • 

'l ~---------•--'"iiíiiOiiiíiiniiiii'" S-100 

! 
Tx system name Estación Base : Ax system name Terminal Móvil 

1 Base Rascafría :::J 
Role Command 

1 jMovil2 

Role Subcrdinate 

Tx power 10\A/ 40 dBm j Aequired E Field 2954 dB¡N/m 
Line loss 2,5 dB ji Antenna gaín 5 dB i 
Antenna gain 5.1 5 dBi 3 dBd .;J Line loss O dB 

2,85dBd 

Radiated power EIRP=18.41 W EAP=11,22W j Rx sensitivily 1}8¡N -101.99 dBm 

Antenno height[m) j15 App!y j i \ Antenno heíght {m) JL5 Apply j : 
·-·---- ---·-- ... ---------------·-------- -·------- _________ j l-----·--· -------· ·--------------- ---- ---·-------- --- ---
,. Net -------------------------------------------------, ¡ Frequency (MHz)--- ----------------------------. 
. ! ¡ Mínimum Maximum ' 

jRascafría i] ¡; ¡890 ¡960 Appty l · 
------- - 2 1-- -·--· - -·- -·-- --- -

Figura 26. Herramienta Radio Unk. Vista del terminal Móvil 2 situado en la población Oteruelo 
del Valle desde la estación base de Rascafría. 
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5.2 Radio Coverage 

La herramienta Radio Coverage permite dibujar el área de cobertura de una 
unidad radio mediante cuatro tipos de gráficas: 

• Single Polar: calcula el área de cobertura de una estación 
transmisora fija para un terminal móvil especificado realizando un 
barrido radial. Permite especificar los intervalos permitidos para el 
radio de cobertura y el ángulo acimutal. La gráfica se puede 
representar en una escala de colores para indicar el nivel de señal 
recibida en dBm. El área de cobertura se dibujará sobre el mapa de 
elevaciones principal, no sobre ampliaciones. 
Tools > Radio coverage > Single polar . 

. -

Figura 27. Área de cobertura de la estación base de Rascafría obtenida con la herramienta 
Radio Coverage en modo Single Polar. 

• Combined Cartesian: este modo utiliza una o varias estaciones 
fijas para calcular el área de cobertura que ofrecen a un terminal 
móvil especificado, en coordenadas cartesianas. La herramienta 
permite representar los niveles de señal en una región ampliada 
del mapa principal. 
Tools > Radio coverage > Combined Cartesian 
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Figura 28. Área de cobertura de la estadón base de Rascafría obtenida con la herramienta 
Radio Coverage en modo Combined Cartesian sobre una ampliación del mapa de eevaciones. 

• Fresnel: colorea sobre el mapa de elevaciones las áreas que 
cumplen el intervalo de despejamiento de la primera zona de 
Fresnel especificado. 
Tools > Radio Coverage > Fresnel. 

• Interference: a partir de las especificaciones del mínimo nivel de 
señal requerido y margen de interferencia entre dos estaciones 
transmisoras, la herramienta representa las regiones con un nivel 
de interferencia aceptable y aquellas en las que se sobrepasa el 
margen de interferencia. 
Tools > Radio Coverage > Interference. 

• Best Sites: permite encontrar el mejor emplazamiento para una 
antena transmisora que debe ofrecer cobertura a un conjunto de 
terminales receptores. Abra Tools > Radio Coverage > Find 
best sites, seleccione la opción within a network y especifique la 
unidad que desea emplazar como "estación central" de la red. 
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Figura 29. Puntos óptimos para el emplazamiento de la estación base de Rascafría. Imagen 
obtenida con la herramienta Find Best Sites de Radio Coverage. 
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6 Enlaces de interés 

• Página oficial de Radio Mobile. 
http://www.cplus.org/rmw/english1.html 

• Grupo Yahoo de Radio Mobile: 
http://groups.yahoo.com/group/Radio Mobile Deluxe 

• Fuente de documentación de Greg Bur. Contiene una guía de Radio 
Mobile y un instalador con la versión 7 .6.3 que incluye un ejemplo de 
red. 

http: //www. pizon .org/rad io-mobile-tutoriallindex. html 

• Página G3TVU. Tutorial de Radio Mobile que explica cómo utilizar las 
herramientas y un instalador con la versión 7.9.4. 
http://www.g3tvu.co.uk/Radio Mobile.htm 

• "Outdoor Radio Simulation. An introduction to Radio Mobile". Manual 
y diapositivas que explican cómo instalar el programa, descargar 
datos de elevaciones SRTM, cómo crear una red y utilizar las 
herramientas Radio Link y Radio Coverage. Autor: Alberto Escudero. 
Diapositivas: 
http://www.itrainonline.org/itrainonline/mmtk/wireless en/10 Radio 

Simulation/10 en mmtk wireless radio-simulation slides.pdf 

Manual: 
http://www.itrainonline.org/itrainonline/mmtk/wireless en/10 Radio 
Simulation/10 en mmtk wireless radio-simulation handout.pdf 

• Guía en PDF que resume especificaciones y funcionalidades de Radio 
Mobile: www.wilac.net/descargas/documentos/Sri.pdf 
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Overview 
Leading-Edge Industrial 
Design 

Ubiquiti Networks"' set the bar for 
the world's first low-cost and efticient 
broadband Customer Premises 
Equipment (CPE) with the original 
NanoStation"'. The NanoStationM 
and NanoStationlocoM take the same 
concept to the future with sleek and 
elegant form factors, a long with 
integrated airMAX"' (MIMO TOMA 
protocol) technology. 

The low cost, high performance, and 
small form factor of NanoStationM 
and NanoStationlocoM make them 
extremely versatile and economical to 
deploy. 

Utilize airMAX Technology 

Unlike standard Wi-Fi protocol, 
Ubiquiti's Time Division Multiple 
Access (TOMA) airMAX protocol 
allows each client to send and receive 
data using pre-designated time 
slots scheduled by an intelligent AP 
controller. 

This "time slot" method eliminates 
hidden nade collisions and 
maximizes airtime efficiency.lt 
provides many magnitudes of 
performance improvements in 
latency, throughput, and scalability 
compared to all other outdoor 
systems in its class. 

lntelllgent QoS Priority is given to 
voicetvideo for seamless streaming. 

Scalablllty High capacity and 
scalability. 

Long Distance Capable of 
high-speed, carrier-class links. 

Latency Multiple features 
dramatically reduce noise. 

o On/y NanoStationM models 

PtMP Client links 

~ :· 

L.:._: ·:J? ~ ~/ v- ~:- ~ 
·-. ~;, :" 

ve':- ~ 

NanoStationM as powerfu/ c/ients in an airMAX 
PtMP (Point -to-Multi-Point) network setup. 

PtP Link 

Wireless Client 

NanoStationM as a powerfu/ 
wireless c/ient. 

Use two NanoStationM to create a PtP link. 

Dual Ethernet 
Connectivity1 

The NanoStationM provides a 
secondary Ethernet port with 
software-enabled PoE output for 
seamless IP video integration. 

'1 

IJ 

lntelligent PoE2 

Remate hardware reset circuitry of 
the NanoStationM allows the device 
to be remotely reset from the power 
supply location. 

RemoteReset ~ 
1 

... i:Jto---1[¡ --- ..... 

The NanoStationM may also be 
powered by the Ubiquiti Networks 
TOUGHSwitch PoE. In addition, any 
NanoStationM can easily become 
48V, 802.3af compliant through 
use of the Ubiquiti lnstant 802.3af 
Adapter (sold separately). 

, Remate reset is an option that is so/d separa te/y as the POE-24. The NanoStationM in eludes a 24V PoE adapter without remote reset. 

~-www.ubnt.com/airmax 
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NanoStation"'M 
Model Frequency Gain 

N 5M2 2.4GHz 11 dBi 

N 5M3 3GHz 13dBi 

NSM365 3.65 GHz 13 dBi 

NSMS SGHz 16dBi 

NanoStation'"loco M 

NanoStation'"loco M 
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Software 

a1rOS~ 
a irOS is an intuitive, versatile, 
highly developed Ubiquiti firmware 
technology. lt is exceptionally 
intuitive and was designed to require 
no training to operate. Behind 
the user interface is a powerful 
firmware architecture, which 
enables high-performance, outdoor 
multi-point networking. 

• Protocol Support 

Ubiquiti Channelization 

Spectral Width Adjustment 

ACK Auto-Timing 
AAP Technology 
Multi-Language Support 

a1rView'" 
lntegrated on all Ubiquiti M 
products, airView provides advanced 
spectrum analyzer functionality: 
waterfall, waveform, and real-time 
spectral views allow operators to 
identify noise signatures and plan 
their networks to minimize noise 
interference. 

Wateñall Aggregate energy over 
time for each frequency. 

• Waveform Aggregate energy 
collected. 

Real-time Energy is shown in real 
time as a function offrequency. 

Recordlng Automize AirView to 
record and report results. 

a1rContror 
airControl is a powerful and 
intuitive, web-based server network 
management application, which 
allows operators to centrally manage 
entire networks of Ubiquiti devices. 

NetworkMap 

Monitor Device Status 

Mass Firmware Upgrade 

Web Ul Access 

Manage Groups of Devices 
TaskScheduling 

~-www.ubnt.com/airmax 
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Specifications 
System lnformation 

Model NanoStationM locoM5/M2 locoM9 
--

Processor Specs Atheros MIPS 24KC, 400 MHz Atheros MIPS 24KC, 400 MHz Atheros MIPS 24KC, 400 MHz 

Memory 32 MB SDRAM, 8 MB Flash 32 MB SDRAM, 8 MB Flash 64 MB SDRAM, 8 MB Flash 
---------

Networking Interface (2) 10/100 Ethernet Ports (1) 1 0/100 Ethernet Port 
1 

(1) 10/100 Ethernet Port 

Regulatory/Compliance lnformation 

Model NSM5/NSM2/IocoM5/IocoM2 NSM3 NSM365 locaM9 

Wireless Approvals FCC Part 15.247, IC R521 O, CE - FCC Part 90Z FCC Part 15.247, IC R521 O 
------

RoHS Compliance Y es Y es Y es Y es 

Model NSMS NSM3/365 NSM2 locoM5 locoM2 locoM9 

294x 31 x 80 294x31 x80 294x 31 x 80 163x31x80 163 X 31 XSO 
164 x 72x 

199 
Dimensions (mm) 

Weíght 0.4kg 0.5 kg 0.4kg 0.18 kg 0.18 kg 0.9kg 

Power Supply (PoE) 24V,0.5A 24V,0.5A 24V,0.5A 24V,0.5A 24V,0.5A 24V,0.5A 

Max. Power Consumption 8W 8W 8W 5.5W 5.5W 6.5W 

Gain 16dBi 13.7 dBi 11 dBi 13 dBi 8dBi SdBí 

Externa! 
RP-SMA 

RF Connector 

Polarization Dual Linear 

Enclosure Characteristics Outdoor UV Stabilized Plastic 

Mounting Po le Mounting Kit lncluded 

Power Method Passive Power over Ethernet (pairs 4, 5+; 7, 8 return) 

Operating Temperature -30to 75"( 

Operating Humidity 5 to 95% Condensing 

Shock & Vibration ETSI300-019-1.4 

Model NSMS!IocoM5 NSM365 NSM3 NSM2/IocoM2 locoM9 

Worldwide 5170-5875 
3650-3675 3400-3700 2412-2462 902-928 

USA 5725-5850 

USA DFS 5250-5850 

~ www.ubnt.com/airmax 



NanoStation locoM9 Specifications 

Antenna lnformatioa 

Gain 7.5 dBi 

Cross-pollsolation 28 dB Mínimum 

Max. VSWR 1.3:1 

Beamwidth 60° (H-pol) /60° (V-poi) /60° (Eievation) 

Return Loss Vertical Azimuth Vertical Elevation 

Horizontal Azimuth Horizontal Elevation 

~- www.ubnt.com/airmax 



NanoStationlocoM2 Specifications 

Gain 

Cross-pollsolation 

Max. VSWR 

Beamwidth 

Return Loss 

. .. .. . - .. . , 

/~~-1 / ' . 

! i ' \\' 

1 
1 (=;:;;;1 . \ 

...... ~ \\. . . 

. . . . . ' 

Antenoa lnfortnation 

8.5 dBi 

20 dB Mínimum 

1.4:1 

60° (H-pol) /60° (V-poi) /60° (Eievation) 

Vertical Azimuth 

Horizontal Azimuth 

· .. -~~~?,~ 
; 1!!1 •••.•.••• 

'· . ' . 

. -0. 

Vertical Elevation 

Horizontal Elevation 
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NanoStationlocoMS Specifications 

Return Loss Vertical Azimuth Vertical Elevation 

. . 

··~·.·: ¿~ 
.. '·\ ~'--/: .. ,. . / 

\ / '\ '. 1 
\ 1 

\j' 
Horizontal Azimuth Horizontal Elevation 
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NanoStationM2 Specifications 

Gain 
r----

Cross-pollsolation 

Max. VSWR 

Beamwidth 

ReturnLoss 

Antenna lnformation 

10.4-11.2dBi 

23 dB Mínimum 

1.6:1 

55" (H-pol) 1 53" (V-poi) 1 27" (Eievation) 

Vertical Azimuth 

( 
·,. -----... 

. - --~~ 
- . ·("~·- __ .>~ 

,.~; _··es:.¿:::_·_:··_ -
·.-. . - t,:' . - '-_ .' 

"" -~--/-· 
. '/ 

., ... 

Horizontal Azimuth 

Vertical Elevation 

Horizontal Elevation 

; ·l~ dJ 

(--: 
'~\ 

""\ - --- , .. 
. 

-
-
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NanoStationM3/M365 Specifications 

1--~~i~---- ----------------------------------------~· __ 12.2. ::_~~2:.!~!------------------------------- __________ _; 
! Cross-pol lsolation i 28 dB Minirnum i 
r---------------------------·----------------------·-- --------+----------------------··------------------ ---·-----------¡ 
! Max. VSWR i 1.4:i ! ¡------·--------------------------------------------------------------------1 
l Beamwidth 1 60" (H-po!) 1 60" (V-poi) /20" (E!evation) 
'"----·------~---·-~----~--·------------·-···-·-··-------- ---·-·---~----L---- ---~----~---------~----·-----~-----------~---__,...1 

RetumL-os.s 1/ertica/.Azimuth Verticai-Eievation 

Horizonta!·Azinwth -Herizomalf!evatien 

~ vvww.ubnt.com/airmax 



NanoStationMS Specifications 

¡. 

--- ; ·-··-· . ., ~~-~--- .. -~· ' 
.. -~--

±2dB ··<lOdBm :t2<iB 
"' .2;' 

36Mbp;; 
~ ·-· '•·'" 

__ , ____ _.,__, __ ~ 
'~ "" .-- ... ,-<.-..,;.0.... ---. v+-"'"~~: •·>~~,.. 

! ... 4l)Mbps 23dBtn ;i; td!l 48Mbps -ndBm :;:ldB ¡ ···1 " ___ .,.....,._ T' <• --"o"•, ---: •r ~ ,._" ... .. ,. 
54Mbps Jt ldB 54Mb¡;;s -75dBm :!:2dl.-'; 

__ r,, •.•• - .. -- ~~'-- "'' ·t •... ~-- . ..,.__,,_ .. ,_M_,._,,,_. .. --¡.- --
1\1\CSO ::: 2dB MCSU -96dBm :ddB 

... --- --- ..• 

' 
t-

MCSI 27dBm i.ldB MCSl -95 dBm ±ldB 
·! ! . ... ... --·-- --r 

MCS2 ?7dBm ± 2dB MC52 -92 dBm .cldB 

MCS3 27rtBm ·i2dB MCS'l -9odBm ± ltiB 
--j-· ,¡ 

MCS4 26ctBm ±2dB MC54 -86clBrn ±ldB 
... --- -·- .. -

MCSS 24dBm ±2dB MC55 -s:-: di'lrn ±2.dB .. - - ., ..... _ ., 

X 
MCS6 2.2dBm -t 2dB 

~ 
MCS6 -77dl3m ± 2dB 

< 
~ ' 

MCS7 21dBrn ± 2dB ~ MCS7 -:t4dBm :t2dl3 

~ 
~--~-·--·-··-· -· ------ -

~ MC'..Sll 27dllm ±2dB .MC:SB ~95 dBm ±2dB 
- .. -------··- ----- ¡-

MC59 TidBm ±2dfl l!i~C$9 -':/306m ,.¿os ... --} 

MCSlO 27d8m ±2dB MCS10 -S>Oúllm :!:2 dB 
. 

' 
... -; 

MCSI1 27dBm J:2dB MCS11 -37 dflm ± 2dB 
.. ., .. - ~. -- _,_ -r -~ r .... ~.-- >- --~ -' - ~--~-- .. , 

MCSU 2f:,dBm ±2dB MC.S12 -84d13m ±ldB J ---- .... - - .. ·---
MCSB 

t 
?.4dBm ·t2dB MC.$13 -79dllm ±2dB 

:- '~-'-- - .. ... ... ' 
MCSI4 .12dBm ±2dB MCS1~ -78 dBm :\:2dB 

"". ~ . '" 
MCS15 2ldBm ± 2df! MC.Sl:> -75dBm ±2.dB 

¡__ ---·-·· .. - ---· .... -·-- '" ...... --· .. -·- --"'" ---- ----- .... 

1 Gam ¡ 14.6 ··16.1 dBt ; 
!--·-----------.. ---·----·-------·-·-·-------------¡--·-----------.. --------------·-·---...... _. _________ ! 
( Cross-pollsolation ¡ 22 dB Minimum ¡ 
¡....,.._.___-------~-~-----------------------~-------------~~-·----+----------~~- -----·------ -~--·-------------------.. ·------------~-·--- --l 
! .Max. VSWR l 1.6:1 i 
-¡..------------------'--·----------------·-----' -----~-------------------------·-·-----------------J 
) Beamwidth / 43"(H-pol)/41°(\/-pol)/i5~(Eievationi ¡ 
f~-~--------·---~-·~·------~-------------~-------~-----...... --.----w-•·----·--·----·---~·- -·-~---~-•-·-·' 

RetumLoss 

-~.~--¿--.7-~--~~~.~.~ .• --~ •.• ~<7-~-.7-~ 
~(El':i-

Vertical Azimuth 

Horizontal Azimuth 

Vertical Elevatlon 

Horizontal Elevatlon 
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OUTDOOR CARRIER CLASS SHIELDED 

Protectyour networks from the most 
brutal envíronments with Ublquiti 
Networks' industrial-grade, shielded 
Ethernet cable, TOUGHCable. 

lncrease Performance 
Oramatically improve your 
Ethernet link states, speeds, and 
overall performance with Ubiquitl 
TOUGHCables . 

..Extreme WNtbellH'oof 
Oesigned for outdoor use, 
TOUGHCables have been built to 
perform even in the harshest weather 
and environments. 

ESD Damage Protectlon 
Protect your networks from 
deva"S'ta'tirlg e1e<:tn:;s'ta1i~ tlistl'1"11't!Je 
(ESO) attacks. 

Extended Cable Support 
TOUGHCables have been developed 
to increase power handling 
performance for extended cable run 
lengths. 

Bulletproof your networks 

TOUGHCable is currently available in 
two versions: PRO Shielding Protection 
and CARRIER Shielding Protection. 

TOUGHCabta'PROts aütegory-s-e, 
outdoor, carrler-class shielded cable 
with an integrated ESO drain wlre. 

TOUGHCable CARRIER is a 
Category Se, outdoor, carrier-dass 
shielded cable that features 
an integrated ESO drain wlre, 
anti-crosstalk dhiider, and secondary 
shielding. lt is rated to províde optimal 
performance on Giga bit Ethernet 
networks. 

Addltionallnformatlon: 

24 AWG copper conductor pairs 

• 26 AWG integrated ESO drain wire 
to prevent ESO attacks and damage 

• PE outdoor-rated, weatherproof 
jacket 

• Multi-layered shielding 

• Available in lengths of 1 000 ft 
'(304:8 ·m) 

TOUGAtable t:onnecl:ors 

Specifically designed for use wlth Ubiquitl TOUGHCables and availáble In 
1 OQ-pc. bags, TOUGHCable Connectors protect against ESO attacks and Ethernet 
hardware damage, while allowing rapid field deployment without soldering. 

ESO attacks are the leading cause for 
device fallures. The diagram below 
illustrates the areas vulnerable to 
ESO attacks in a network 

ouroooft 

By using a grounded Ubiquitl Power 
over Ethernet (PoE) Adapter along with 
Ubiquiti TOUGHCable and TOUGHCable 
Connectors, you can effectlvely protect 
against ESO attacks. 

Ubiqt.úti 
TOUGNCab!e 
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